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DISKLAIMER (DISCLAIMER) 

 

Penerbit tidak menjamin kebenaran dan keakuratan isi/informasi yang tertulis di 

dalam buku tek ini. Kebenaran dan keakuratan isi/informasi merupakan tanggung 

jawab dan wewenang dari penulis. 

Penerbit tidak bertanggung jawab dan tidak melayani terhadap semua komentar 

apapun yang ada didalam buku teks ini. Setiap komentar yang tercantum untuk 

tujuan perbaikan isi adalah tanggung jawab dari masing-masing penulis. 

Setiap kutipan yang ada di dalam buku teks akan dicantumkan sumbernya dan 

penerbit tidak bertanggung jawab terhadap isi dari kutipan tersebut. Kebenaran 

keakuratan isi kutipan tetap menjadi tanggung jawab dan hak diberikan pada 

penulis dan pemilik asli. Penulis bertanggung jawab penuh terhadap setiap 

perawatan (perbaikan) dalam menyusun informasi dan bahan dalam buku teks 

ini. 

Penerbit tidak bertanggung jawab atas kerugian, kerusakan atau 

ketidaknyamanan yang disebabkan sebagai akibat dari ketidakjelasan, 

ketidaktepatan atau kesalahan didalam menyusun makna kalimat didalam buku 

teks ini. 

Kewenangan Penerbit hanya sebatas memindahkan atau menerbitkan 

mempublikasi, mencetak, memegang dan memproses data sesuai dengan 

undang-undang yang berkaitan dengan perlindungan data. 
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KATA PENGANTAR 

Penerapan kurikulum 2013 mengacu pada paradigma belajar kurikulum abad 21 

menyebabkan terjadinya perubahan, yakni dari pengajaran (teaching) menjadi 

pembelajaran (learning), dari pembelajaran yang berpusat kepada guru 

(teachers-centered) menjadi pembelajaran yang berpusat kepada peserta didik 

(student-centered), dari pembelajaran pasif (pasive learning) ke cara belajar 

peserta didik aktif (active learning-CBSA) atau Student Active Learning-SAL. 

Puji syukur kami panjatkan kepada Tuhan yang Maha Esa atas tersusunnya 

buku teks ini, dengan harapan dapat digunakan sebagai buku teks untuk siswa 

Sekolah Menengah Kejuruan (SMK) Bidang Studi Keahlian Teknologi Dan 

Rekayasa, Teknik Komputer Dan Informatika. 

Buku teks ″Jaringan Dasar ″ ini disusun berdasarkan tuntutan paradigma 

pengajaran dan pembelajaran kurikulum 2013 diselaraskan berdasarkan 

pendekatan model pembelajaran yang sesuai dengan kebutuhan belajar 

kurikulum abad 21, yaitu pendekatan model pembelajaran berbasis peningkatan 

keterampilan proses sains. 

Penyajian buku teks untuk Mata Pelajaran ″Jaringan Dasar″ ini disusun dengan 

tujuan agar supaya peserta didik dapat melakukan proses pencarian 

pengetahuan berkenaan dengan materi pelajaran melalui berbagai aktivitas 

proses sains sebagaimana dilakukan oleh para ilmuwan dalam melakukan 

penyelidikan ilmiah (penerapan saintifik), dengan demikian peserta didik 

diarahkan untuk menemukan sendiri berbagai fakta, membangun konsep, dan 

nilai-nilai baru secara mandiri. 

Kementerian Pendidikan dan Kebudayaan, Direktorat Pembinaan Sekolah 

Menengah Kejuruan, dan Direktorat Jenderal Peningkatan Mutu Pendidik dan 

Tenaga Kependidikan menyampaikan terima kasih, sekaligus saran kritik demi 

kesempurnaan buku teks ini dan penghargaan kepada semua pihak yang telah 

berperan serta dalam membantu terselesaikannya buku teks Siswa untuk Mata 

Pelajaran Jaringan Dasar X/Semester 2 Sekolah Menengah Kejuruan (SMK). 

Jakarta, 12 Desember 2013 

Menteri Pendidikan dan Kebudayaan 

  

  

Prof. Dr. Mohammad Nuh, DEA 
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GLOSARIUM 
 

 

Alamat IP Alamat IP (IP Address, Internet Protocol Address) adalah nomor yang 

digunakan untuk mengindentifikasi komputer, server atau alat lain dalam jaringan 

internal atau internet lewat TCP/IP. Terdiri dari serangkaian (empat bagian) 

angka yang dipisah dengan tanda titik (misalnya 123.123.123.1). 

 

Anonymous FTP Adalah metode penggunaan program FTP untuk masuk ke 

suatu komputer atau server dan mengambil (download) atau mengirim file 

walaupun anda tidak memiliki account pada komputer itu. Saat anda masuk, 

anda mengirimkan 'Anonymous' sebagai nama user dan alamat email sebagai 

password, kemudian anda akan diarahkan ke folder atau direktori yang bisa 

diakses secara anonim. 

 

Apache  Program/software yang kegunaanya bertugas sebagai server web, 

menyediakan file/halaman untuk bisa diakses oleh pengunjung dengan protokol 

HTTP. Apache merupakan web server yang paling banyak digunakan saat ini. 

 

Aplikasi web Adalah aplikasi atau program yang dikirimkan lewat teknologi 

internet. Aplikasi dijalankan pada server dan disajikan melalui browser, 

memungkinkan interaktivitas antara pengunjung situs. Contoh aplikasi web 

adalah CMS (content managment), weblog, forum diskusi, webmail, wiki, toko 

online, dsb. 

 

Autoresponder  Adalah program yang secara otomatis dijalankan saat 

menerima email, kemudian membalas email tersebut dengan isi email yang 

sudah disiapkan ke pengirimnya, memberi tahu pengirimnya bahwa emailnya 

sudah diterima. Saat anda mengkonfigurasikan autoresponder, maka program ini 

akan otomatis mengirim tanpa perlu campur tangan anda lagi, dan situs internet 

anda menjadi makin interaktif. 
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Bandwidth Adalah jumlah besaran data (bit) yang bisa dikirimkan 

(ditransfer/ditransmisikan), yang dihitung dengan satuan bit per detik, kilobit per 

detik, megabit per detik, dan seterusnya. 1 byte data terdiri dari 8 bit. 

 

Browser  Atau web browser (terjemahan Bahasa Indonesia: peramban), adalah 

program komputer untuk menampilkan file atau halaman dari sebuah situs 

internet. Saat anda menjelajahi (surfing) internet, anda memulainya dengan 

menjalankan program browser ini, lalu memerintahkan program ini untuk masuk 

ke sebuah situs internet. Contoh browser: Mozilla, Firefox, Safari, Opera, Internet 

Explorer, Konqueror, Lynx, Netscape, dsb. 

 

CGI  Atau Common Gateway Interface, adalah program yang menerjemahkan 

data dari web server dan menampilkannya pada situs internet atau dikirim ke 

email. Dengan CGI halaman situs internet berinteraksi dengan aplikasi program 

lain. CGI melibatkan transfer data antara server dan program CGI (disebut juga 

script), sehingga sebuah situs internet menjadi interaktif dengan input/masukan 

dari pengunjungnya. Form, buku tamu, forum diskusi, pengiriman komentar dan 

fitur lainnya bisa dibuat dengan CGI. 

 

CHMOD  Singkatan dari Change Mode, adalah perintah di Linux/Unix untuk 

mengubah mode suatu file atau direktori. Mode ini terdiri dari hak akses 

(permission) dan mode khusus. Umumnya yang sering digunakan/diubah-ubah 

adalah hak akses. 

 

Clientexec  Adalah aplikasi web yang dikembangkan oleh Newedge Services, 

Inc. Aplikasi web ini berfungsi sebagai pengelolaan konsumen, 

pembayaran/penagihan dan solusi dukungan konsumen untuk perusahaan 

webhosting. RuangWeb menyediakan lisensi Clientexec bagi kliennya. 

 

CMS  Atau content management system. Adalah aplikasi web untuk mengelola 

konten sebuah (atau lebih) situs internet. Masing-masing CMS memiliki fitur-fitur, 

diantaranya adalah pengelolaan berita, buku tamu, forum diskusi, sistem 

komentar, sistem keanggotaan, dsb. 
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CPanel  Adalah sebuah program yang mudah digunakan untuk mengkonfigurasi 

dan mengelola situs internet anda (control panel), digunakan sebagai panel 

kendali di RuangWeb.com. 

 

Data transfer  Adalah jumlah data yang ditransfer, baik transfer masuk atau 

transfer keluar, lewat suatu jenis koneksi dalam satu kurun waktu tertentu. 

Lihat juga -> Bandwidth. 

 

DirectAdmin  Adalah sebuah program yang mudah digunakan untuk 

mengkonfigurasi dan mengelola situs internet anda (control panel), berfungsi 

sama seperti CPanel, digunakan sebagai panel kendali di RuangWeb.com. 

 

Directi  Nama salah satu registrar domain. Lihat juga -> Registrar 

DNS Domain Name System (bahasa Indonesia: Sistem Penamaan Domain) 

adalah sebuah sistem yang menyimpan informasi tentang nama host maupun 

nama domain dalam bentuk basis data tersebar (distributed database) di dalam 

jaringan komputer, misalkan: Internet. DNS menyediakan alamat IP untuk setiap 

nama host dan mendata setiap server transmisi surat (mail exchange server) 

yang menerima surat elektronik (email) untuk setiap domain. Setiap nama 

host/komputer memiliki alamat IP (internet protocol) sendiri yang terdiri dari 

serangkaian angka, DNS memudahkan kita mengingat/mencari alamat 

situs/email dengan menerjemahkan angka-angka ini menjadi nama yang lebih 

mudah diingat manusia. 

 

Domain  Atau nama domain, seperti www.namakamu.com, adalah cara untuk 

memudahkan mengingat satu alamat internet. Server DNS mengasosiasikan 

alamat IP dengan nama domain. Saat anda memerintahkan browser anda 

membuka www.namakamu.com, browser ini mengarahkannya ke alamat IP yang 

dimilikinya. Ada beberapa tingkatan domain, diantaranya TLD (top level domain) 

atau domain internasional seperti .com/.net/.org atau domain negara seperti 

.or.id/.co.id/.web.id/.com.my/.com.sg/.nl/.de dan sebagainya. 

 

Download  Proses transfer data dari server/situs internet ke komputer pribadi 

(pengguna). Terjemahan Bahasa Indonesia=unduh 



 

J a r i n g a n  D a s a r  | ix 
 

Jaringan Dasar  

eNom  Nama salah satu registrar domain. Lihat juga -> Registrar 

 

Fantastico  Adalah script yang memudahkan instalasi puluhan aplikasi web 

dengan sedikit klik saja, mengurangi waktu pembelajaran terhadap aplikasi web 

itu sehingga penggunanya (anda) bisa lebih berkonsentrasi pada isi situs anda. 

Fantastico diakses lewat CPanel. 

 

Frontpage Extension  Frontpage extension bisa dianggap sebagai "program 

mini" yang memungkinkan fitur sebuah situs internet dibuat lewat Microsoft 

Frontpage untuk bisa berjalan dengan lancar. Situs yang dibuat dengan MS 

Frontpage bisa dijalankan pada server hosting yag tidak memiliki Frontpage 

extension, tapi ada beberapa fitur utama yang tidak bisa dijalankan. Untuk 

informasi lebih lanjut silakan kunjungi situs Microsoft Frontpage di 

http://www.microsoft.com/frontpage/ . Setelah anda membuat situs anda dengan 

MS Frontpage anda akan mengetahui apakah situs anda membutuhkan 

Frontpage entension atau tidak. 

 

FTP  Adalah singkatan dari File Transfer Protocol, protokol Internet yang 

merupakan standar untuk pentransferan file komputer antara mesin-mesin yang 

menjalankan sistem yang sangat berbeda, misalnya dari komputer rumahan 

dan/ke server situs anda. Karena berfungsi sebagai file sharing maka kita dapat 

mendownload dan mengupload file yang kita inginkan. Seperti halnya browsing, 

FTP juga memiliki alamat. Alamat yang digunakan untuk browsing dapat diawali 

dengan HTTP misalnya http://www.situsinternet.com sedangkan FTP diawali 

dengan ftp misalnya ftp://ruangweb.com 

 

Hits (Statistik)  Sebuah hit adalah sebuah permintaan (request) atas suatu file 

dari webserver. Misalnya sebuah halaman situs (1 html) berisi 1 file css, 1 file js 

dan 10 gambar, maka jumlah hit untuk satu halaman tersebut setiap kali 

ditampilkan adalah 13 hit. 

 

Homepage  Adalah halaman depan atau halaman utama sebuah situs internet. 

Contoh: halaman depan situs hosting RuangWeb adalah 

http://www.ruangweb.com 
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HTML  Hyper Text Markup Language. Sebuah halaman dalam situs internet 

ditulis dengan bahasa ini, yang kemudian diterjemahkan oleh web browser 

menjadi seperti tampilan yang anda lihat. 

 

HTTP  Hyper Text Transfer Protocol. Adalah protokol untuk mengirim file 

hyperteks (HTML) pada internet. Membutuhkan program klien HTTP di satu sisi, 

dan program server HTTP di sisi lainnya. HTTP adalah protokol paling penting 

yang digunakan di jagat internet (World Wide Web). Anda akan 

menggunakannya setiap kali mengunjungi sebuah situs internet. 

 

IP Private Alamat IP yang digunakan untuk jaringan internal (intranet). IP Private 

tidak bisa diakses dari jaringan internet. Rentang IP yang bisa digunakan untuk 

jaringan internal adalah: 10.0.0.0 - 10.255.255.255, 172.16.0.0 - 172.31.255.255, 

dan 192.168.0.0 - 192.168.255.255. 

 

IP Publik  Alamat IP yang bisa diakses secara publik lewat jaringan global 

(internet). Supaya nama domain, email dan web anda bisa diakses oleh 

pengunjung lain di internet, digunakan IP Publik. Lihat juga - > IP Private 

 

Linux  Adalah nama sistem operasi komputer, seperti Windows, Mac atau UNIX. 

Karena sifatnya yang opensource, Linux memiliki ratusan paket distribusi (distro, 

seperti Redhat, SuSe, Debian, Fedora, CentOS, Trustix, dll). Linux banyak 

digunakan sebagai sistem operasi untuk server karena efisiensi dan 

kehandalannya. 

 

MySQL  Adalah sistem manajemen database relational (RDBMS, relational 

database management) yang open source yang menggunakan Structured Query 

Language (SQL, yang merupakan bahasa populer untuk menambahkan, 

mengkases dan memproses data dalam database). Karena sifatnya yang open 

source, semua orang boleh mendownload dan menyesuaikan dengan 

keinginannya dengan rambu-rmbu yang ditentukan dalam lisensi. MySQL dikenal 

karena kecepatan, kemampuan dan fleksibiltasnya sehingga banyak digunakan 

sebagai sistem database pada aplikasi web. 
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Nameserver  Sebuah server yang menyimpan dan melayani sistem penamaan 

domain dengan protokol DNS, menerjemahkan nama domain ke alamat IP yang 

terkait dan sebaliknya. Setiap nama domain harus memiliki minimal 2 (dua) 

nameserver, 1 sebagai nameserver utama dan yang kedua sebagai cadangan 

jika ada masalah pada nameserver pertama, sehingga domain itu selalu bisa 

ditemukan. 

 

NetEarthOne  Nama salah satu registrar domain. Lihat juga -> Registrar 

 

Open source Adalah filosofi dalam distribusi software dimana kode sumber 

programnya ikut disertakan sehingga bisa dibaca dan dimodifikasi. Karena bisa 

dimodifikasi, software yang dirilis secara open source bisa disesuaikan dengan 

kebutuhan penggunanya. 

 

Page view (Statistik) Jumlah tampilan halaman yang diberikan webserver. Saat 

pertama kami pengunjung masuk ke situs anda, maka dalam statistik dihitung 

sebagai 1 tampilan halaman (page view), dan jika pengunjung tersebut membuka 

halaman lain, maka akan dihitung lagi. Dan seterusnya. 

 

Perl Perl (Practical Extraction and Report Language) adalah bahasa 

pemrograman dinamis yang ditulis oleh Larry Wall, 1987. Perl meminjam banyak 

fitur dari bahasa pemrograman lain yang sudah ada. Perl juga banyak digunakan 

sebagai bahasa utnuk aplikasi web. 

 

PHP Adalah bahasa pemrograman. Perintah-perintahnya atau kodenya disimpan 

bersama HTML dalam sebuah halaman internet. Perintah/kode itu dijalankan 

oleh web server sehingga bisa dibaca oleh browser apapun. Web browser 

kemudian hanya melihat HTML yang dihasilkan dari kode program PHP itu dan 

menampilkannya. 

 

phpMyAdmin Aplikasi web populer yang digunakan sebagai antar muka untuk 

mengadministrasi (mengelola) database MySQL. Ditulis dengan bahasa PHP. 

Dalam phpMyAdmin, anda bisa membuat struktur database (tabel); 
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memasukkan, mengedit dan menghapus data, mengimpor struktur dan data dari 

file lain, dan mengekspor database ke format lain (backup). 

POP  Post Office Protocol. Adalah metode untu kmengambil email dari server. 

Sebagian besar program email (disebut juga klien email) menggunakan protokol 

POP, walaupun ada juga yang mendukung penggunaan teknologi IMAP (Internet 

Message Access Protocol) yang lebih baru. Ada dua versi POP, pertama POP2, 

yang menjadi standar pada pertengahan 1980-an dan membutuhkan SMTP 

untuk mengirim emailnya; dan POP3, yang bisa digunakan dengan atau tanpa 

SMTP. Versi POP email yang terbaru dan paling banyak digunakan adalah 

POP3.  

 

Propagasi DNS  Dari DNS Propagation. Adalah masa pemberitahuan perubahan 

atas satu domain, perubahan ini bisa berarti perubahan nameserver atau 

transfer; atau jika nama domain tersebut baru pertama kali didaftarkan. Dalam 

masa ini informasi domain anda disebarluaskan ke seluruh nameserver induk di 

seluruh dunia. Proses ini tampak seperti lama, tetapi pada masing-masing server 

sebenarnya berlangsung sangat cepat, karena banyaknya nameserver yang 

harus diberi tahu proses ini bisa memakan waktu sampai 72 jam, tetapi 

umumnya berlangsung singkat (kurang dari 30 menit). Selama masa propagasi 

ini nama domain tidak bisa diakses. 

 

Registrar  Atau dalam hal ini dianggap sebagai Domain Registrar adalah 

organisasi atau perusahaan yang berwenang memberikan sebuah nama domain 

kepada yang mendaftarkannya menurut TLD (top level domain) tertentu 

(.com/.net/.org) atau domain negara (.id/.my/.sg, dsb). 

 

Reseller Hosting  Paket dalam web hosting, yang bisa memiliki sub-account 

(paket) lagi di bawahnya. Paket reseller biasanya memiliki kapasitas ruang yang 

besar sehingga kemudian bisa dipecah menjadi paket yang lebih kecil dan dijual 

kembali. 

Shared hosting Opsi hosting dimana beberapa situs klien ditempatkan bersama-

sama dengan berbagi sumber daya (resource) server yang sama. 
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SMTP Simple Mail Transfer Protocol. Protokol utama yang digunakan untuk 

mengirim surat elektronik lewat internet. Sebagian besar email dikirim dan 

diterima dengan SMTP. SMTP terdiri dari serangkaian aturan tentang bagaimana 

cara sebuah program untuk mengirim dan menerima email. 

 

SSI Server Side Includes. Perintah yang bisa disertakan dalam HTML, kemudian 

diproses oleh webserver saat diakses oleh pengunjung. Format perintahnya 

adalah <!--#include virtual="/lokasi/file"-->. SSI umumnya digunakan untuk 

memasukkan menu yang digunakan di sebuah situs yang biasanya seragam di 

seluruh halaman dalam situs tersebut, sehingga hanya diperlukan sekali 

membuat menu itu saja dalam sebuah file, tidak di keseluruhan file yang ingin 

berisi menu itu. 

 

SSL Secured Socket Layer, adalah protokol untuk mengirimkan data yang di-

enkrip (disamarkan), dengan komunikasi terotentikasi, lewat internet. Pertama 

kali dirancang oleh Netscape Communication. Kebanyakan digunakan dalam 

komunikasi antara web browser dan server. URL yang dimulai dengan "https://" 

menunjukkan bahwa halaman tersebut disajikan dengan jenis koneksi aman ini. 

SSL menyediakan 3 (tiga) hal penting: Privasi, Otentikasi dan Integritas Pesan. 

Pada jenis koneksi ini, masing-masing bagian yag berkomunikasi (misalnya 

browser dan server) harus mempunyai Sertifikat Keamanan (Security Certificate) 

dan saling mengirimkannya. Masing-masing bagian itu kemudian meng-enkrip 

(meyandikan) apa yang dikirim dengan informasi yang ada dalam sertifikat itu 

dan sertifikat pasangannya, memastikan bahwa hanya penerima yang diinginkan 

saja yang bisa membaca pesan tersandi (di-enkrip) itu, dan dikirim dari lokasi 

yang memang seharusnya dan isi pesan yang dikirim tidak diubah. Dengan 

keamanan seperti ini, SSL banyak digunakan pada situs komersial untuk 

menjalankan transaksi lewat internet atau situs yang mengirim data sensitif. 

 

TCP/IP Adalah rangkaian protokol komunikasi untuk menghubungkan komputer 

atau server pada internet. 

Upload Proses transfer data/file dari komputer pribadi (komputer pengguna) ke 

server. Terjemahan Bahasa Indonesia = unggah 
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Uptime Merujuk pada sejumlah waktu dalam periode 24 jam dimana sebuah 

sistem atau server aktif menjalankan tugas menyediakan layanan. Misalnya jika 

uptime 99.9% berarti masa aktif situs tersebut adalah 24 jam dikurang 0.1% (8 

detik), dan dalam 1 tahun ada masa tidak aktif selama 48 jam. Masa tidak aktif ini 

biasanya digunakan untuk perawatan/pemeliharaan server. 

 

URL  Kependekan dari Uniform Resource Locator, alamat sebuah sumber pada 

internet. Contoh: sebuah situs web, atau halaman dalam situs internet memiliki 

alamat URL http://www.situsinternet.com atau 

http://anggota.sebuahsitus.com/dan/halaman.html. Alamat URL untuk FTP 

ftp://alamatftp.com. Alamat URL untuk email, mailto:nama@alamatemail.com 

Visit/Sesi (Statistik)  Serangkaian permintaan (request) ke suatu website dari 

satu pengunjung unik dalam satu waktu. Sebuah kunjungan (visit) atau sesi 

kunjungan bisa terdiri dari beberapa hits dan page view. 

 

VPS Virtual Private Server (VPS) atau sering juga disebut Virtual Dedicated 

Server (VDS) atau Virtual Server, merupakan solusi untuk mendapatkan 

keleluasaan seperti server dengan sebagian harga saja. Satu server utama akan 

dibagi menjadi beberapa virtual server yang masing-masing terpisah satu sama 

lain, memiliki sistem operasi sendiri seperti memiliki dedicated server. Jika 

dianalogikan dengan gedung atau perumahan, menyewa VPS kurang lebih sama 

dengan menyewa apartemen dimana anda hanya menyewa sebagian ruang 

yang memiliki fungsi lengkap sebagai tempat tinggal, dari satu gedung penuh. 

 

Web hosting  Sebuah bisnis atau jasa layanan penyediaan tempat penyimpanan 

file secara online, konektivitas jaringan dan layanan lain yang dibutuhkan untuk 

menyajikan file ke internet. Perusahaan yang menyediakan layanan webhosting 

disebut webhost; dan detil layanannya seperti kapasitas, data transfer dan 

konektivitas disebut paket hosting (hosting plan) 

 

Website Web site atau situs internet adalah kumpulan seluruh halaman yang 

disajikan oleh sebuah perusahaan, individu, organisasi atau entitas lainnya. 

Sering dianggap sebagai rumah atau kantor maya (virtual). Bisa berupa blog, 

forum diskusi atau yang lainnya. 
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WHM Web Host Manager. Antar muka grafis berbasis web (aplikasi web) untuk 

mengelola situs dan account pada sebuah server. WHM merupakan alat bantu 

bagi reseller untuk mengelola account kliennya. 

 

WHMCS  Atau WHMCompleteSolution adalah aplikasi web yang dikembangkan 

oleh Matthew Pugh dari WHMCS Ltd. Aplikasi web ini berfungsi sebagai 

pengelolaan konsumen, pembayaran/penagihan dan solusi dukungan konsumen 

untuk perusahaan webhosting dan bisnis online lain. RuangWeb menyediakan 

lisensi WHMCS bagi kliennya. 

 

Input devices adalah perangkat yang digunakan untuk memasukkan data - data 

dan memberikan perintah pada komputer. 

Output device merupakan perangkat keras komputer yang digunakan untuk 

mengkomunikasikan hasil pengolahan data yang dilakukan oleh komputer untuk 

pengguna. 

CPU (Central Processing Unit) atau prosesor merupakan pemroses data 

dalam sebuah perangkat komputer.  

Random access memory (RAM) merupakan tempat didalam komputer dimana 

OS, program aplikasi dan data yang sedang digunakan disimpan sehingga dapat 

dicapai dengan cepat oleh prosesor.  

Motherboard merupakan pengendali atau pengontrol semua hal yang terhubung 

untuk berkomunikasi dengan peranti yang lainnya dalam sistem. 

Jumper merupakan connector (penghubung) sirkuit elektrik yang digunakan 

untuk menghubungkan atau memutus hubungan pada suatu sirkuit. 

Power supply merupakan alat yang menyediakan tenaga listrik bagi semua 

komponen di dalam unit sistem. 

APT  Advance Packaging Tool (APT) adalah aplikasi berbasis command line 

yang dapat digunakan untuk menangani urusan instalasi dan un-install paket 

software berbasis distro debian dan turunannya. APT mempermudah proses 

manajemen software pada sistem berbasis Unix dengan mengotomatisasikan 

pengambilan ketergantungan paket yang dibutuhkan, melakukan konfigurasi, dan 

instalasi paket dalam bentuk binari atau dengan melakukan kompilasi paket 

source kode. 
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Mirror Dalam istilah manajemen paket, mirror adalah alternatif lokasi repositori 

paket dari repositori paket utama yang sudah tersedia. Dengan adanya mirror 

yang posisi jaringannya terdapat dekat dengan pengguna maka permasalahan 

minimnya alokasi bandwidth yang tersedia diharapkan dapat tertangani dengan 

baik. 

 

Sypnatic Package Manager Aplikasi berbasis GTK+ yang dibuat sebagai front-

end Advanced Packaging Tool (APT) yang digunakan sebagai sistem 

manajemen paket Debian. Synaptic biasanya digunakan pada sistem berbasis  

paket deb, namun dapat juga digunakan oleh sistem berbasis RPM. Synaptic 

dapat digunakan untuk menginstalasi, menghapus, meng-upgrade paket, dan 

juga untuk menambah daftar repositori paket. 

 

Ubuntu Software Center Ubuntu Software Center atau yang dulu dikenal 

dengan nama Uuntu Software Store, merupakan aplikasi berbasis GTK+ yang 

dibuat sebagai aplikasi front-end dari Advanced Packaging Tool (APT) untuk 

sistem manajemen Debian. Aplikasi ini dapat digunakan untuk menginstal dan 

meng-uninstall paket software dan dapat digunakan untuk menambah repositori. 

Pada menu utama aplikasi ini, tersedia sejumlah kategori paket software yang 

dapat dengan mudah diinstal atau di-uninstall oleh para penggunanya. 
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PETA KEDUDUKAN BAHAN AJAR 
 

Peta kedudukan bahan ajar merupakan suatu diagram yang menjelaskan 

struktur mata pelajaran dan keterkaitan antar mata pelajaran dalam satu 

kelompok bidang studi keakhlian. Gambar 1 menjelaskan peta kedudukan bahan 

ajar untuk program studi keahlian Rekayasa perangkat lunak.  Kelompok C1 

merupakan kelompok mata pelajaran wajib dasar bidang studi keahlian. C2 

merupakan kelompok mata pelajaran wajib dasar program keahlian dan C3 

merupakan kelompok mata pelajaran wajib paket keahlian. 

 

 

Gambar 1.  Peta Kedudukan Bahan Ajar Kelompok C2 Mata Pelajaran Perakitan 

Komputer 

 

 

Perakitan  
Komputer 

Jaringan 

Dasar 
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Sementara itu peta konsep mata pelajaran menjelaskan struktur urutan 

kegiatan belajar dan topik materi pelajaran. Gambar 2 dibawah ini menjelaskan 

peta konsep mata pelajaran perakitan komputer untuk kelas X semester 1. 

 

 

Gambar 2. Peta Konsep Mata Pelajaran Jaringan Dasar Komputer Kelas X 

Semester 2 
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BAB 1. PENDAHULUAN 

 

A. Diskripsi. 

Jaringan dasar komputer adalah salah satu mata pelajaran wajib dasar 

program keahlian Teknik Komputer dan Informatika (TKI). Berdasarkan struktur 

kurikulum mata pelajaran perakitan komputer disampaikan di kelas X semester 1 

dan semester dua masing-masing 4 jam pelajaran. Untuk semester 1 topik materi 

pembelajaran menekankan pada Konsep jaringan komputer yakni model OSI 

dalam jaringan komputer,topologi jaringan, media yang sesuai dalam 

komunikasi data jaringan, protokol jaringan. Sedangkan untuk semester 2 

topik materi pembelajaran menekankan pada memahami protokol 

pengalamatan jaringan memahami perangkat keras jaringan,memahami 

aplikasi jaringan pada sistem operasi komputer,memahami penggelaran 

jaringan. 

Pembelajaran Jaringan dasar komputer ini menggunakan metode 

pendekatan scientifik. Dalam pendekatan ini praktikum atau eksperimen berbasis 

sains merupakan bidang pendekatan ilmiah dengan tujuan dan aturan khusus, 

dimana tujuan utamanya adalah untuk memberikan bekal ketrampilan yang kuat 

dengan disertai landasan teori yang realistis mengenai fenomena yang akan kita 

amati. Ketika suatu permasalahan yang hendak diamati memunculkan 

pertanyaan-pertanyaan yang tidak bisa terjawab, maka metode eksperimen 

ilmiah hendaknya dapat memberikan jawaban melalui proses yang logis. Proses-

proses dalam pendekatan scientifik meliputi beberapa tahapan (gambar 3) yaitu:  

mengamati, hipotesis atau menanya, mengasosiasikan atau eksperimen, 

mengumpulkan atau analisa data dan mengkomunikasikan. Proses belajar 

pendekatan eksperimen pada hakekatnya merupakan proses berfikir ilmiah untuk 

membuktikan hipotesis dengan logika berfikir. 
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Gambar 3. Diagram Proses Metode Scientifik-Eksperimen Ilmiah 

 

B. Prasyarat. 

Berdasarkan peta kedudukan bahan ajar, mata pelajaran Jaringan dasar 

komputer ini berdiri sendiri dan bersama sama satu kelompok dengan mata 

pelajaran  pemrograman web,system operasi,perakitan computer dan simulasi 

digital Jaringan dasar komputer merupakan tahapan untuk menyiapkan 

bagaimana Jaringan dasar komputer dapat berfungsi dengan baik. Untuk 

memahami proses Jaringan dasar komputer yang benar, dibutuhkan 

pemahaman terhadap perangkat keras komputer baik  secara logical dan 

physical, dimana topik ini telah diuraikan dalam mata pelajaran sistem komputer. 

Sementara itu untuk dapat mengoperasikan perangkat lunak yang akan 

mengelola pemakaian sumber daya komputer telah diuraikan dalam mata 

pelajaran sistem operasi. 

 

C. Petunjuk Penggunaan. 

Buku pedoman siswa ini disusun berdasarkan kurikulum 2013 yang 

mempunyai ciri khas penggunaan metode scientifik. Buku ini terdiri dari dua bab 

yaitu bab 1 pendahuluan dan bab 2 pembelajaran. Dalam bab pendahuluan 

beberapa yang harus dipelajari peserta didik adalah diskripsi mata pelajaran 

yang berisi informasi umum, rasionalisasi dan penggunaan metode scientifik. 

Selanjutnya pengetahuan tentang persyaratan, tujuan yang diharapkan, 

kompetensi inti dan dasar yang akan dicapai serta test kemampuan awal.  
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Bab 2 menuntun peserta didik untuk memahami diskripsi umum tentang 

topik yang akan dipelajari dan rincian kegiatan belajar sesuai dengan kompetensi 

dan tujuan yang akan dicapai. Setiap kegiatan belajar terdiri dari tujuan dan  

uraian materi topik pembelajaran, tugas serta test formatif. Uraian pembelajaran 

berisi tentang diskripsi pemahaman topik materi untuk memenuhi kompetensi 

pengetahuan. Uraian pembelajaran juga menjelaskan diskripsi unjuk kerja atau 

langkah-langkah logis untuk memenuhi kompetensi skill. 

Tugas yang harus dikerjakan oleh peserta didik dapat berupa tugas 

praktek, eksperimen atau pendalaman materi pembelajaran. Setiap tugas yang 

dilakukan melalui beberapa tahapan scientifik yaitu : 1) melakukan pengamatan 

setiap tahapan unjuk kerja 2) melakukan praktek sesuai dengan unjuk kerja 3) 

mengumpulkan data yang dihasilkan setiap tahapan 4) menganalisa hasil data 

menggunakan analisa diskriptif 5) mengasosiasikan beberapa pengetahuan 

dalam uraian materi pembelajaran untuk membentuk suatu kesimpulan 5) 

mengkomunikasikan hasil dengan membuat laporan portofolio. Laporan tersebut 

merupakan tagihan yang akan dijadikan sebagai salah satu referensi penilaaian. 

 

D. Tujuan Akhir. 

Setelah mempelajari uraian materi dalam bab pembelajaran dan kegiatan 

belajar diharapkan peserta didik dapat memiliki kompetensi sikap, pengetahuan 

dan ketrampilan yang berkaitan dengan materi: 

 Penggunaan protokol pengalamatan dalam jaringan 

 Perangkat keras jaringan yang sesuai dengan kebutuhan 

 Aplikasi jaringan pada sistem operasi komputer  

 Penggelaran jaringan sederhana horisontal 

 

E. Kompetensi Inti Dan Kompetensi Dasar 

1. Kompetensi Inti 1 : Menghayati dan mengamalkan ajaran agama yang 

dianutnya. 

Kompetensi Dasar : 

1.1. Memahami nilai-nilai keimanan dengan menyadari hubungan 

keteraturan dan kompleksitas alam dan jagad raya terhadap kebesaran 

Tuhan yang menciptakannya  
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1.2. Mendeskripsikan kebesaran Tuhan yang menciptakan berbagai sumber 

energi di alam 

1.3. Mengamalkan nilai-nilai keimanan sesuai dengan ajaran agama dalam 

kehidupan sehari-hari. 

2. Kompetensi Inti 2: Menghayati dan Mengamalkan perilaku jujur, disiplin, 

tanggung jawab, peduli (gotong royong, kerjasama, toleran, damai), santun, 

responsif dan proaktif dan menunjukan sikap sebagai bagian dari solusi atas 

berbagai permasalahan dalam berinteraksi secara efektif dengan lingkungan 

sosial dan alam serta dalam menempatkan diri sebagai cerminan bangsa 

dalam menempatkan diri sebagai cerminan bangsa dalam pergaulan dunia. 

Kompetensi Dasar: 

2.1. Menunjukkan perilaku ilmiah (memiliki rasa ingin tahu; objektif; jujur; 

teliti; cermat; tekun; hati-hati; bertanggung jawab; terbuka; kritis; kreatif; 

inovatif dan peduli lingkungan) dalam aktivitas sehari-hari sebagai wujud 

implementasi sikap dalam melakukan percobaan dan berdiskusi  

2.2. Menghargai kerja individu dan kelompok dalam aktivitas sehari-hari 

sebagai wujud implementasi melaksanakan percobaan dan melaporkan 

hasil percobaan 

3. Kompetensi Inti 3: Memahami, menerapkan dan menganalisis pengetahuan 

faktual, konseptual, dan prosedural berdasarkan rasa ingin tahunya tentang 

ilmu pengetahuan, teknologi, seni, budaya, dan humaniora dalam wawasan 

kemanusiaan, kebangsaan , kenegaraan, dan peradaban terkait penyebab 

fenomena dan kejadian dalam bidang kerja yang spesifik untuk memecahkan 

masalah. 

Kompetensi Dasar: 

3.1  Memahami protokol pengalamatan jaringan 

3.2  Memahami perangkat keras jaringan 

3.3  Memahami aplikasi jaringan pada sistem operasi komputer 

3.4  Memahami penggelaran jaringan 

 

4. Kompetensi Inti 4: Mengolah, menalar, dan menyaji dalam ranah konkret 

dan ranah abstrak terkait dengan pengembangan dari yang dipelajarinya di 

sekolah secara mandiri, dan mampu melaksanakan tugas spesifik dibawah 

pengawasan langsung. 
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Kompetensi Dasar: 

4.1 Menyajikan penggunaan protokol pengalamatan dalam jaringan 

4.2 Menyajikan perangkat keras jaringan yang sesuai dengan 

kebutuhan 

4.3 Menyajikan aplikasi jaringan pada sistem operasi komputer  

4.4.Menyajikan hasil penggelaran jaringan sederhana horisontal 

 

F. Cek Kemampuan Awal. 

1. Jelaskan  penggunaan protokol pengalamatan dalam jaringan 

2. Jelaskan perangkat keras jaringan yang sesuai dengan kebutuhan  

3. Jelaskan aplikasi jaringan pada sistem operasi komputer 

4. Jelaskan penggelaran jaringan sederhana horisontal 

. 
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BAB II PEMBELAJARAN 

A. Diskripsi 

Jaringan dasar komputer merupakan matapelajaran yang membahas mulai dari 

Penggunaan protokol pengalamatan dalam jaringan, perangkat keras jaringan 

yang sesuai dengan kebutuhan dan aplikasi jaringan pada sistem operasi 

komputer serta dalam bab II ini  penggelaran jaringan sederhana horisontal 

 

B. Kegiatan Belajar 

Kegiatan belajar menjelaskan tentang aktifitas pembelajaran yang dilakukan 

siswa, meliputi mempelajari uraian materi, mengerjakan test formatif dan  tugas 

atau eksperimen dari proses mengamati sampai menyusun laporan 

 

 

1. Kegiatan Belajar 1 : Protokol Pengalamatan 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 1 ini siswa diharapkan dapat : 

1).Memahami  Protokol Pengalamatan 

2).Menganalisis  Protokol Pengalamatan 

 

b. Uraian Materi 

Protokol Pengalamatan 

Protokol  

Protokol adalah sebuah aturan atau standar yang mengatur atau 

mengijinkan terjadinya hubungan, komunikasi, dan perpindahan data antara 

dua atau lebih titik komputer.Protokol dapat diterapkan pada perangkat keras, 

perangkat lunak atau kombinasi dari keduanya.Pada tingkatan yang terendah, 

protokol mendefinisikan koneksi perangkat keras. Protocol digunakan untuk 

menentukan jenis layanan yang akan dilakukan pada internet. 

 

1.Pengalamatan IP v4 
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Dalam jaringan komputer pengalamatan IP merupakan hal yang sangat 

penting karena   pengalamatan ini merupakan pengidentifikasian suatu 

komputer pada  jaringan sehingga memiliki identitas yang unik. Dengan 

adanya IP address maka dapat  diketahui sumber ataupun tujuan dari 

pengiriman paket. Ipv4 menggunakan notasi biner yang memiliki panjang 32 

bit. Pada dasarnya, arsitektur IPv4 menganut konsep classful addressing, 

yaitu pembagian ruang alokasi alamat ke dalam 5 kelas (50% A, 25% B, 

12.5% C, 6.25% D,dan6.25% E). Bila direpresentasikan dengan notasi 

desimal, pembagian kelas ini dapat dilihat dari byte/oktet pertama seperti pada 

Tabel 1. 

 

Kelas IP Byte pertama 

A 0 – 127 

B 128 – 191 

C 192 – 223 

D 224 – 247 

E 248 – 255 

 

dari kelima kelas diatas, jenis alamat yang sering dipakai adalah alamat kelas 

A,B, dan C,     sedangkan alamat kelas D biasanya digunakan untuk 

keperluan multicasting dan kelas E untuk keperluan Experimental. Pada IPv4 

dikenal juga istilah subnet mask yaitu angka biner 32 bit yang digunakan untuk 

membedakan network ID dan host ID. 

 

IPv4 Address Syntax 

Sistem pengalamatan pada IPv4 menggunakan notasi biner sebesar 32 

bit yang dibagi atas 4 kelompok (setiap kelompok terdiri dari 8 bit atau oktet) 

dan tiap kelompok dipisahkan oleh sebuah tanda titik. IPv4 juga sering disebut 

sebagai sistem pengalamatan 4- oktet atau pengalamatan 4-bytes (1byte= 

8bit).Untuk memudahkan pembacaan, penulisan alamat dilakukan dengan 

angka decimal dan diberi pemisah menggunakan tanda titik(dot) 

Dibawah ini contoh pengelompokkan IPv4 menggunakan notasi w, x, y, z. 
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Gambar.1 IPv4 address dalam notasi titik decimal 

 

Sebagai contoh misalnya 100.3.1.100 yang jika dinyatakan dalam binary 

menjadi 01100100.00000011.00000001.01100100. Dari 32 bit ini berarti 

banyaknya jumlah maksimum alamat yang dapat dituliskan adalah 2 pangkat 

32, atau 4.294.967.296 alamat. Format alamat ini terdiri dari 2 bagian, netid 

dan hostid. Netid sendiri menyatakan alamat jaringan sedangkan hosted 

menyatakan alamat lokal (host/router). Dari 32 bit ini, tidak boleh semuanya 

angka 0 atau 1 (0.0.0.0 digunakan untuk jaringan yang tidak dikenal dan 

255.255.255.255 digunakan untuk broadcast). Dalam penerapannya, alamat 

internet ini diklasifikasikan ke dalam kelas (A-E).Alasan klasifikasi ini antara 

lain : 

 Memudahkan sistem pengelolaan dan pengaturan alamat-alamat. 

 Memanfaatkan jumlah alamat yang ada secara optimum (tidak ada alamat   

yang terlewat). 

 Memudahkan pengorganisasian jaringan di seluruh dunia dengan 

membedakan jaringan tersebut termasuk kategori besar, menengah,atau kecil. 

 Membedakan antara alamat untuk jaringan dan alamat untuk host/router. 

Dengan perkembangan internet dan jaringan akhir akhir ini telah membuat 

internet protocol  (IP) yang merupakan tulang punggung jaringan berbasis 

TCP/IP dengan cepat menjadi ketinggalan zaman, dan alamat IPv4 pun juga 

akan habis terpakai. 
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IPv4 Address Prefixes 

Representasi prefix dari alamat IPv4 adalah menunjukkan banyaknya 

jumlah alamat pada IPv4.Unutk menetukan panjang notasi dari alamat prefix, 

kamu bisa memulainya dengan cara merubah seluruh variable bit menjadi 0, 

kemudian konversi ke notasi decimal, dan tambahka potongan bit yang telah 

ditentukan(panjang prefix) diawal pengalamatan. Sebagai contoh misalnya 

alamat IPv4 adalah 131.107.0.0/16 memiliki 16 bit yang telah ditentukan 

(100000011 01101011). Awali pengalamatan dengan 16 bit sebelumnya yang 

telah ditentukan, kemudian merubah 16 bit terahir menjadi bit 0, sehingga 

hasilnya menjadi 1000000111 01101011 00000000 00000000 atau 

131.107.0.0. Kemudian tinggal menambahkan potongan bit yang telah 

ditentukan (/16) untuk merepresentasikan alamat prefix dari 131.107.0.0/16. 

 

Types of IPv4 Addresses 

Ada 3 model pengalamatan standar dari pengalamtan IPv4, yaitu; 

1. Unicast 

2. Multicast 

3. Broadcast 

 

1. IPv4 Unicast Addresses 

Penugasan terhadap sebuah interface jaringan yang menempatkan 

subnet khusus; digunakan untuk komunikasi point to point.Setiap antarmuka 

jaringan yang menggunakan protokol TCP/IP harus diidentifikasikan dengan 

menggunakan sebuah alamat logis yang unik, yang disebut dengan alamat 

unicast (unicast address).Alamat unicast disebut sebagai alamat logis karena 

alamat ini merupakan alamat yang diterapkan pada lapisan jaringan dalam 

DARPA Reference. 

Model dan tidak memiliki relasi yang langsung dengan alamat yang 

digunakan pada lapisan antarmuka jaringan dalam DARPA Reference Model. 

Sebagai contoh, alamat unicastdapat ditetapkan ke sebuah host dengan 

antarmuka jaringan dengan teknologi Ethernet, yang memiliki alamat MAC 

sepanjang 48-bit. Alamat unicast inilah yang harusdigunakan oleh semua host 

TCP/IP agar dapat saling terhubung.  
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Komponen alamat ini terbagi menjadi dua jenis, yakni alamat host (host 

identifier) dan alamat jaringan (network identifier). Alamat unicast 

menggunakan kelas A, B, dan C dari kelas-kelas alamat IP yang telah 

disebutkan sebelumnya, sehingga ruang alamatnya adalah dari 1.x.y.z hingga 

223.x.y.z. Sebuah alamat unicast dibedakan dengan alamat lainnya dengan 

menggunakan skema subnet mask. 

 

2. IPv4 Multicast Addresses 

Penugasan terhadap satu atau lebih interface jaringan dengan subnet 

yang berbeda; digunakan untuk komunikasi satu ke banyak komputer. Alamat 

IP Multicast (Multicast IPAddress adalah alamat yang digunakan untuk 

menyampaikan satu paket kepada banyak penerima. 

Dalam sebuah intranet yang memiliki alamat multicast paket yang 

ditujukan ke sebuah alamat multicast akan diteruskan oleh router ke 

subjaringan di mana terdapat host-host yang sedang berada dalam kondisi 

"listening" terhadap lalu lintas jaringan yang dikirimkan ke alama multicast 

tersebut. 

Dengan cara ini, alamat multicast pun menjadi cara yang efisien untuk 

mengirimkan paket data dari satu sumber ke beberapa tujuan untuk beberapa 

jenis komunikasi. Alamat multicast didefinisikan dalam RFC 1112. Alamat-

alamat multicast IPv4 didefinisikan dalam ruang alamat kelas D,yakni 

224.0.0.0/4, yang berkisar dari 224.0.0.0 hingga 239.255.255.255. Prefiks 

alamat 224.0.0.0/24 (dari alamat 224.0.0.0 hingg 224.0.0.255) tidak dapat 

digunakan karena dicadangkan untuk digunakan oleh lalu lintas multicast 

dalam subnet lokal. 

 

3. IPv4 Broadcast Addresses 

Penugasan terhadap seluruh interface jaringan dalam suatu subnet; 

digunakan untuk komunikasi satu computer ke semuanya dalam suatu subnet. 

Alamat broadcast untuk IP versi 4 digunakan untuk menyampaikan paket-

paket data "satu-untuk-semua". Jika sebuah host pengirim yang hendak 

mengirimkan paket data dengan tujuan alamat broadcast, maka semua node 

yang terdapat di dalam segmen jaringan tersebut akan menerima paket 

tersebut da memprosesnya. Berbeda dengan alamat IP unicast atau alamat IP 



 

J a r i n g a n  D a s a r  | 11 
 

Jaringan Dasar  

multicast, alamat IP broadcast hanya dapat digunakan sebagai alamat tujuan 

saja, sehingga tidak dapat digunakan sebagai alamat sumber. Ada empat 

buah jenis alamat IP broadcast, yakni network broadcast, subnetbroadcast, al 

subnets-directed broadcast, dan Limited Broadcast. Untuk setiap jenis alamat 

broadcast tersebut, paket IP broadcast akan dialamatkan kepada lapisan 

antarmuka jaringan dengan menggunakan alamat broadcast yang dimiliki oleh 

teknologi antarmuka jaringan yang digunakan. Sebagai contoh, untuk jaringan 

Ethernet dan Token Ring, semua paket broadcast IP akan dikirimkan ke 

alamat broadcast Ethernet dan Token Ring, yakni 0xFF-FF-FF-FF-FF-FF. 

  

c. Rangkuman. 

Protokol adalah sebuah aturan atau standar yang mengatur atau mengijinkan 

terjadinya hubungan, komunikasi, dan perpindahan data antara dua atau 

lebih titik komputer.Protokol dapat diterapkan pada perangkat keras, 

perangkat lunak atau kombinasi dari keduanya.Pada tingkatan yang 

terendah, protokol mendefinisikan koneksi perangkat keras. Protocol 

digunakan untuk menentukan jenis layanan yang akan dilakukan pada 

internet. 

. 

d. Tugas : Membuat Ringkasan Materi  Protokol Pengalamatan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi pembagian 

jaringan komputer berdasarkan luas areanya yaitu Protokol 

Pengalamatan.Masing-masing kelompok mebuat ringkasan pembagian 

jaringan komputer berdasarkan Protokol Pengalamatan 

.Kemudian secara bergantian masing-masing kelompok mempresentasikan 

hasilnya didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Protokol Pengalamatan menggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) katagori 

Protokol Pengalamatan,2) fungsi Protokol Pengalamatan,3) 

implementasi Protokol Pengalamatan  

1.3. Presentasikan hasil ringkasan di depan kelas. 
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e. Tes Formatif 

 

1. Kunci pokok suatu protocol adalah 

A. Syntax, Simantic, Timing 

B. Semantic, Timing, Working 

C. Timing, Working, Semantic                     

D. Working, Syntax, Semantic 

 

2. Macam-macam protocol antara lain, kecuali 

A. Ethernet            

B. Token Ring 

C. Local Disk                   

D. Internet 

 

3. 192.168.0.10 merupakan contoh pemberian alamat pada sebuah 

komputer yang akan dihubungkan dalam sebuah jaringan. Angka-angka 

tersebut dikenal dengan : 

A. Protokol     

B. IP Address     

C. Konfigurasi      

D. Domain      

E. TCP/IP      

 

4. Nilai angka digital dan bit adalah……  

A. 0 dan 1                                          

B. 5 dan 6 

C. 1 dan 3                                          

D. 4 dan 7 

E. 1 dan 2 

 

5. Berapa jumlahmaksimumIDhost yang tersediapada alamatkelasC? 

A. 65,534      

B. 192      

C. 16,384      
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D. 126      

E. 254      

 

f. Lembar Jawaban Test Formatif (LJ). 

 

1 

 
A 

 
B 

 
C 

 
D 

 
E 

 

   

 
           

  
2 

 
A 

 
B 

 
C 

 
D 

 
E 

 

  

 
           

  
3 

 
A 

 
B 

 
C 

 
D 

 
E 

 

  

 
           

  
4 

 
A 

 
B 

 
C 

 
D 

 
E 

 

  

 
           

  
5 

 
A 

 
B 

 
C 

 
D 

 
E 
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2. Kegiatan Belajar 2 : Protokol Pengalamatan IP.V4 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 13 ini siswa diharapkan dapat : 

1. Memahami Protokol Pengalamatan IP.V4 

2. Menganalisis perbandingan Protokol Pengalamatan IP.V4 dengan  

Protokol Pengalamatan IP.V6 

 

 

b. Uraian Materi 

 

Protokol Pengalamatan  IP.V4 

    Protokol 

Protokol adalah sebuah aturan atau standar yang mengatur atau 

mengijinkan terjadinya hubungan, komunikasi, dan perpindahan data antara 

dua atau lebih titik komputer.Protokol dapat diterapkan pada perangkat keras, 

perangkat lunak atau kombinasi dari keduanya.Pada tingkatan yang terendah, 

protokol mendefinisikan koneksi perangkat keras. Protocol digunakan untuk 

menentukan jenis layanan yang akan dilakukan pada internet. 

1.Pengalamatan IP v4 

Dalam jaringan komputer pengalamatan IP merupakan hal yang sangat 

penting karena   pengalamatan ini merupakan pengidentifikasian suatu 

komputer pada  jaringan sehingga memiliki identitas yang unik. Dengan 

adanya IP address maka dapat  diketahui sumber ataupun tujuan dari 

pengiriman paket. Ipv4 menggunakan notasi biner yang memiliki panjang 32 

bit. Pada dasarnya, arsitektur IPv4 menganut konsep classful addressing, 

yaitu pembagian ruang alokasi alamat ke dalam 5 kelas (50% A, 25% B, 

12.5% C, 6.25% D,dan6.25% E). Bila direpresentasikan dengan notasi 

desimal, pembagian kelas ini dapat dilihat dari byte/oktet pertama seperti pada 

Tabel 1. 
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Kelas IP Byte pertama 

A 0 – 127 

B 128 – 191 

C 192 – 223 

D 224 – 247 

E 248 – 255 

 

dari kelima kelas disamping, jenis alamat yang sering dipakai adalah alamat 

kelas A,B, dan C, sedangkan alamat kelas D biasanya digunakan untuk 

keperluan multicasting dan kelas E untuk keperluan Experimental. Pada IPv4 

dikenal juga istilah subnet mask yaitu angka biner 32 bit yang digunakan untuk 

membedakan network ID dan host ID. 

IPv4 Address Syntax 

Sistem pengalamatan pada IPv4 menggunakan notasi biner sebesar 32 

bit yang dibagi atas 4 kelompok (setiap kelompok terdiri dari 8 bit atau oktet) 

dan tiap kelompok dipisahkan oleh sebuah tanda titik. IPv4 juga sering disebut 

sebagai sistem pengalamatan 4- oktet atau pengalamatan 4-bytes (1byte= 

8bit).Untuk memudahkan pembacaan, penulisan alamat dilakukan dengan 

angka decimal dan diberi pemisah menggunakan tanda titik(dot) 

Dibawah ini contoh pengelompokkan IPv4 menggunakan notasi w, x, y, z. 

 

Gambar.1 IPv4 address dalam notasi titik desimal 
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Sebagai contoh misalnya 100.3.1.100 yang jika dinyatakan dalam binary 

menjadi 01100100.00000011.00000001.01100100. Dari 32 bit ini berarti 

banyaknya jumlah maksimum alamat yang dapat dituliskan adalah 2 pangkat 

32, atau 4.294.967.296 alamat. Format alamat ini terdiri dari 2 bagian, netid 

dan hostid. Netid sendiri menyatakan alamat jaringan sedangkan hosted 

menyatakan alamat lokal (host/router). Dari 32 bit ini, tidak boleh semuanya 

angka 0 atau 1 (0.0.0.0 digunakan untuk jaringan yang tidak dikenal dan 

255.255.255.255 digunakan untuk broadcast). Dalam penerapannya, alamat 

internet ini diklasifikasikan ke dalam kelas (A-E).Alasan klasifikasi ini antara 

lain : 

 Memudahkan sistem pengelolaan dan pengaturan alamat-alamat. 

 Memanfaatkan jumlah alamat yang ada secara optimum (tidak ada alamat 

yang terlewat). 

 Memudahkan pengorganisasian jaringan di seluruh dunia dengan 

membedakan jaringan tersebut termasuk kategori besar, menengah,atau kecil. 

  Membedakan antara alamat untuk jaringan dan alamat untuk host/router 

Dengan perkembangan internet dan jaringan akhir akhir ini telah membuat 

internet protocol  (IP) yang merupakan tulang punggung jaringan berbasis 

TCP/IP dengan cepat menjadi ketinggalan zaman, dan alamat IPv4 pun juga 

akan habis terpakai. 

IPv4 Address Prefixes 

Representasi prefix dari alamat IPv4 adalah menunjukkan banyaknya 

jumlah alamat pada IPv4.Unutk menetukan panjang notasi dari alamat prefix, 

kamu bisa memulainya dengan cara merubah seluruh variable bit menjadi 0, 

kemudian konversi ke notasi decimal, dan tambahka potongan bit yang telah 

ditentukan(panjang prefix) diawal pengalamatan. Sebagai contoh misalnya 

alamat IPv4 adalah 131.107.0.0/16 memiliki 16 bit yang telah ditentukan 

(100000011 01101011). Awali pengalamatan dengan 16 bit sebelumnya yang 

telah ditentukan, kemudian merubah 16 bit terahir menjadi bit 0, sehingga 

hasilnya menjadi 1000000111 01101011 00000000 00000000 atau 



 

J a r i n g a n  D a s a r  | 17 
 

Jaringan Dasar  

131.107.0.0. Kemudian tinggal menambahkan potongan bit yang telah 

ditentukan (/16) untuk merepresentasikan alamat prefix dari 131.107.0.0/16. 

Types of IPv4 Addresses 

Ada 3 model pengalamatan standar dari pengalamtan IPv4, yaitu; 

1. Unicast 

2. Multicast 

3. Broadcast 

1. IPv4 Unicast Addresses 

Penugasan terhadap sebuah interface jaringan yang menempatkan 

subnet khusus; digunakan untuk komunikasi point to point.Setiap antarmuka 

jaringan yang menggunakan protokol TCP/IP harus diidentifikasikan dengan 

menggunakan sebuah alamat logis yang unik, yang disebut dengan alamat 

unicast (unicast address).Alamat unicast disebut sebagai alamat logis karena 

alamat ini merupakan alamat yang diterapkan pada lapisan jaringan dalam 

DARPA Reference.Model dan tidak memiliki relasi yang langsung dengan 

alamat yang digunakan pada lapisan antarmuka jaringan dalam DARPA 

Reference Model. Sebagai contoh, alamat unicastdapat ditetapkan ke sebuah 

host dengan antarmuka jaringan dengan teknologi Ethernet, yang memiliki 

alamat MAC sepanjang 48-bit. Alamat unicast inilah yang harusdigunakan 

oleh semua host TCP/IP agar dapat saling terhubung. Komponen alamat ini 

terbagi menjadi dua jenis, yakni alamat host (host identifier) dan alamat 

jaringan (network identifier). Alamat unicast menggunakan kelas A, B, dan C 

dari kelas-kelas alamat IP yang telah disebutkan sebelumnya, sehingga ruang 

alamatnya adalah dari 1.x.y.z hingga 223.x.y.z. Sebuah alamat unicast 

dibedakan dengan alamat lainnya dengan menggunakan skema subnet mask. 

c. Rangkuman. 

Protokol adalah sebuah aturan atau standar yang mengatur atau mengijinkan 

terjadinya hubungan, komunikasi, dan perpindahan data antara dua atau 

lebih titik komputer.Protokol dapat diterapkan pada perangkat keras, 

perangkat lunak atau kombinasi dari keduanya.Pada tingkatan yang 
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terendah, protokol mendefinisikan koneksi perangkat keras. Protocol 

digunakan untuk menentukan jenis layanan yang akan dilakukan pada 

internet. 

. 

d. Tugas : Membuat Ringkasan Materi  Protokol Pengalamatan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi pembagian 

jaringan komputer berdasarkan luas areanya yaitu Protokol 

Pengalamatan.Masing-masing kelompok mebuat ringkasan pembagian 

jaringan komputer berdasarkan Protokol Pengalamatan .Kemudian secara 

bergantian masing-masing kelompok mempresentasikan hasilnya didepan 

kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Protokol Pengalamatan menggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) katagori 

Protokol Pengalamatan,2) fungsi Protokol Pengalamatan,3) 

implementasi Protokol Pengalamatan  

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

 Tes Esay  

1. Kantor 1: salah satu IP 202.117.18.5 dengan jumlah Personal 

Computer 27 Tentukan IP Prefik dan jaringan yang bisa digunakan 

agar jaringan yang digunakan agar jaringan yang dibuat efisien ! 

 Tes Pilihan Ganda  

1. Ada 3 model pengalamatan standar dari pengalamtan IPv4, 

kecuali…. 

A. Unicast 

B. Multicast 

C. IP Address 

D. Broadcast 
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2. Penerapannya, alamat internet ini diklasifikasikan ke dalam kelas (A-

E).Alasan klasifikasi ini antara lain keculai :  

a. Memudahkan sistem pengelolaan dan pengaturan alamat-alamat. 

b. Memanfaatkan jumlah alamat yang ada secara optimum (tidak ada 

alamat   yangterlewat). 

c. Memudahkan pengorganisasian jaringan di seluruh dunia dengan 

membedakan jaringan tersebut termasuk kategori besar, 

menengah,atau kecil. 

d. Membedakan antara alamat untuk jaringan dan alamat untuk 

modem/router  

 

3. 

 

 

 

 

 

 

 

Dari kelima kelas diatas, jenis alamat yang sering dipakai adalah 

alamat kelas A,B dan C, sedangkan alamat kelas D biasanya 

digunakan untuk keperluan …… 

A. Multicasting 

B. Experimental 

C. Unicast 

D. Broadcast 

 

4. Pada dasarnya, arsitektur IPv4 menganut konsep…… 

A. Unicast Addresses 

B. Classful addressing 

C. Address Prefixes 

D. Experimental 

 

 

Kelas IP Byte pertama 

A 0 – 127 

B 128 – 191 

C 192 – 223 

D 224 – 247 

E 248 – 255 
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f. Lembar Jawaban Test Formatif  

 Test Essay  (LJ.01). 

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

                           

 

 Pilihan Ganda (LJ.02). 

1  A  B  C  D  

 

   

          
 

  
2  A  B  C  D  

 

  

          
 

  
3  A  B  C  D  

 

  

          
 

  
4  A  B  C  D  
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3. Kegiatan Belajar 3 : Peralatan Jaringan 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 3 ini siswa diharapkan dapat : 

1) Memahami  macam – macam peralatan jaringan 

2) Menganalisis fungsi dan cara kerja   peralatan jaringan 

 

b. Uraian Materi 

Peralatan Jaringan 

Ada beberapa peralatan yang digunakan dalam jaringan, peralatan ini sering 

digunakan di dalam perkantoran dan perusahan besar. Peralatan ini adalah : 

 

1. Network Interface Card 

Dalam memilih network interface card, ada beberapa pertimbangan yang 

harus diperhatikan. Pertimbangan-pertimbangan ini sangat penting untuk 

diperhatikan, yaitu : 

 Tipe jaringan seperti Ethernet LANs, Token Ring, atau Fiber Distributed 

Data Interface (FDDI). 

 Tipe Media seperti Twisted Pair, Coaxial, Fiber-Optic, dan Wireless. 

 Tipe Bus seperti ISA dan PCI. 

 

 

Gambar 2. Network Interface Card 
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2. PCMCIA Network Interface Card 

PCMCIA card adalah card jaringan yang digunakan untuk terhubung 

kedalam sebuah jaringan tanpa menggunakan kabel. 

 

Gambar 3. PCMCIA Network Interface Card 

3. Modem 

Modem atau Modul the Modulator adalah peralatan jaringan yang 

digunakan untuk terhubung ke jaringan internet menggunakan kabel telepon. 

 

 

Gambar 4. PCMCIA Network Interface Card 
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4. HUB/Switch 

HUB atau Switch digunakan untuk menghubungkan setiap node dalam 

jaringan LAN. Peralatan ini sering digunakan pada topologi star dan extended 

star. Perbedaan antara HUB dan Switch adalah kecepatan transfer datanya. 

Yaitu 10:100 Mbps. 

 

 

 

 

 

 

 

 

 

 

Gambar 5. HUB 8 Port dan Switch 24 Port 

 

5. Bridge 

Bridge adalah peralatan jaringan yang digunakan untuk memperluas atau 

memecah jaringan. Bridge berfungsi untuk menghubungkan dan 

menggabungkan media jaringan yang tidak sama seperti kabel unshielded 

twisted pair (UTP) dan kabel fiber-optic, dan untuk menggabungkan arsitektur 

jaringan yang berbeda seperti Token Ring dan Ethernet. Bridge meregenerate 

sinyal tetapi tidak melakukan konversi protocol, jadi protocol jaringan yang sama 

(seperti TCP/IP) harus berjalan kepada kedua segemen jaringan yang terkoneksi 

ke bridge. Bridge dapat juga mendukung  Simple Network Management Protocol  

(SNMP), serta memiliki kemampuan diagnosa jaringan. 

Bridge hadir dalam tiga tipe dasar yaitu Local, Remote, dan Wireless. 

Bridge local secara langsung menghubungkan Local Area Network (LAN). Bridge 

remote yang dapat digunakan untuk membuat sebuah Wide Area Network 

(WAN) menghubungkan dua atau lebih LAN. Sedangkan wireless bridge dapat 

digunakan untuk menggabungkan LAN atau menghubungkan mesin-mesin yang 

jauh ke suatu LAN. 
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Bridge beroperasi mengenali alamat MAC address node asal yang 

mentransmisi data ke jaringan dan secara automatis membangun sebuah table 

routing internal. Table ini digunakan untuk menentukan ke segmen mana paket 

akan di route dan menyediakan kemampuan penyaringan (filtering). Setelah 

mengetahui ke segmen mana suatu paket hendak disampaikan, bridge akan 

melanjutkan pengiriman paket secara langsung ke segmen tersebut. Jika bride 

tidak mengenali alamat tujuan paket, maka paket akan di forward ke semua 

segmen yang terkoneksi kecuali segmen alamat asalanya. Dan jika alamat tujuan 

berada dalam segmen yang sama dengan alamat asal, bridge akan menolak 

paket. Bridge juga melanjutkan paket-paket broadcast ke semua segmen kecuali 

segmen asalnya. 

 

Gambar 6.Wireless Bridge 

6. Router 

Router adalah peralatan jaringan yang digunakan untuk memperluas atau 

memecah jaringan dengan melanjutkan paket-paket dari satu jaringan logika ke 

jaringan yang lain. Router banyak digunakan di dalam internetwork yang besar 

menggunakan keluarga protocol TCP/IP dan untuk menghubungkan semua host 

TCP/IP dan Local Area Network (LAN) ke internet menggunakan dedicated 

leased line. Saat ini, masih banyak perusahaan menggunakan router Cisco 2500 

series untuk mengkoneksikan dua buah LAN (WAN dengan anggota dua LAN), 
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LAN ke ISP (Internet Service Provider). Koneksi seperti ini menyebabkan semua 

workstation dapat terkoneksi ke internet selama 24 jam. 

Router berisi table-tabel informasi internal yang disebut label routering 

yang melakukan pencatatan terhadap semua alamat jaringan yang diketahui dan 

lintasan yang mungkin dilalui. Router membuat jalur paket-paket berdasarkan 

lintasan yang tersedia dan waktu tempuhnya. Karena menggunakan alamat 

paket jaringan tujuan, router bekerja hanya jika protocol yang dikonfigurasi 

adalah protocol yang routetable seperti TCP/IP atau atau IPX/SPX. Ini berbeda 

dengan bridge yang bersifat protocol independent. 

 

Gambar 7. Cisco Router 2600 series 

 

7. Crimping Tools 

Crimping tools berguna untuk memotong, merapikan dan mengunci kabel 

UTP dalam melakukan instalasi Networking. 

 

 

 

 

 

 

 

 

Gambar 8.  Crimping Tools 

Digunakan untuk 
memotong 

Dan menjepit kabel 

Digunakan untuk 
mengupas 

kabel 
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c. Rangkuman. 

Ada beberapa peralatan yang digunakan dalam jaringan, peralatan ini sering 

digunakan di dalam perkantoran dan perusahan besar. Peralatan ini adalah 

:Network Interface Card, PCMCIA Network Interface Card, 

Modem,HUB/Switch, Bridge,Router,Crimping Tools 

 

d. Tugas : Membuat Ringkasan Materi  peralatan jaringan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi peralatan 

jaringan.Masing-masing kelompok mebuat ringkasan peralatan 

jaringan.Kemudian secara bergantian masing-masing kelompok 

mempresentasikan hasilnya didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk peralatan jaringan menggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) katagori 

peralatan jaringan ,2) fungsi peralatan jaringan, 3) implementasi 

peralatan jaringan 

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. Bridge yang mengkoneksikan media kabel yang satu dengan media kabel 

lainnya. Adalah pengertian dari…?  

a. Ethernet Bridge  

b. Wireless Bridge 

c. Modem  

d. Internet Bridge  

e. Switch 

 

2. Perangkat jaringan komputer yang menghubungkan host pada jaringan yang 

berlainan adalah…? 

a. Hub  

b. Switch  

c. Router  
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d. Repeater  

e. Modem  

 

3. Perangkat jaringan komputer yang bekerja pada lapisan fisik model 

referensi…? 

a. Hub  

b. Switch  

c. Router  

d. Repeater  

e. Modem 

 

 

4. Di bawah ini adalah gambar dari perangakat jaringan.... 

 

 

 

a. router 

b. modem 

c. wi-fi 

d. switch 

e. bridge 

 

5. Diantara karakteristik swicth dibawah ini,yang tidak termasuk karakteristik 

swicth adalah nomor ... 

a.Tergolong peralatan Layer 2 dalam OSI Model (Data Link Layer) 

b.Dapat menginspeksi data yang diterima  

c.Dapat menentukan sumber dan tujuan data 

d.Dapat mengirim data ke tujuan dengan tepat sehingga akan menghemat 

bandwith. 

e.Dapat menangani lebih dari dua port dan lebih dari dua komunikasi data 

dalam waktu bersamaan. 

 
 
 



 

28 | J a r i n g a n  D a s a r   
 

Jaringan Dasar 

f. Lembar Jawaban Test Formatif (LJ). 

 

1  A  B  C  D  E 

 

   

           
 

  
2  A  B  C  D  E 

 

  

           
 

  
3  A  B  C  D  E 

 

  

           
 

  
4  A  B  C  D  E 

 

  

           
 

  
5  A  B  C  D  E 
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4.Kegiatan Belajar 4 : Konsep Sistem Operasi Jaringan 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 4 ini siswa diharapkan dapat : 

1) Memahami konsep system operasi jaringan  

2) Menganalisis konsep system operasi jaringan 

 

b. Uraian Materi 

KONSEP SISTEM OPERASI JARINGAN 

Sistem operasi merupakan penghubung antara pengguna computer 

dengan  perangkat  keras  komputer.  Pengertian  sistem  operasi  secara 

umum adalah suatu pengelola seluruh sumber daya yang terdapat pada 

sistem komputer dan menyediakan sekumpulan layanan (Web, FTP, DNS, 

dan  lain-lain)  untuk  memudahkan  dan  memberi  kenyamanan  dalam 

penggunaan dan pemanfaatan sumber daya sistem komputer. Sistem operasi 

jaringan atau sistem operasi komputer yang dipakai sebagai  server dalam 

jaringan  komputer hampir  mirip dengan  system operasi  komputer  stand  

alone, bedanya  hanya  pada  sistem  operasi jaringan,  salah  satu  komputer  

harus  bertindak  sebagai  server  bagi komputer lainnya. Di dalam Jaringan 

komputer terdiri dari: 

 Komputer Server adalah komputer yang menyediakan fasilitas bagi 

komputer-komputer lain didalam jaringan.  

 Komputer  Client  adalah  komputer-komputer  yang  menerima atau 

menggunakan fasilitas yang disediakan oleh server.  

Sistem operasi dalam jaringan disamping berfungsi untuk mengelola sumber  

daya  dirinya  sendiri  juga  untuk  mengelola  sumber  daya komputer lain 

yang tergabung dalam jaringan.  

Sistem  operasi  harus  diinstal  ke  dalam  komputer  agar  dapat berfungsi 

dengan baik. Dalam instalasi sistem operasi jaringan terdapat beberapa mode 

pilihan yang disediakan yaitu  berupa  mode text dan mode grafik. Instalasi 
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sistem operasi berbasis text merupakan salah satu mode instalasi sistem 

operasi komputer dengan tampilan text. Mode text digunakan  jika  spesifikasi  

hardware  komputer  yang  akan  diinstal mempunyai spesifikasi yang rendah.  

Metode instalasi berbasis text akan mempercepat proses instalasi. Metode 

instalasi sistem operasi berbasis text sering digunakan untuk mempercepat 

proses instalasi walaupun dengan tampilan yang kurang menyenangkan.  

Biasanya  untuk  spesifikasi  komputer  yang  sederhana dibanding  dengan  

sistem  operasinya  akan  menggunakan  metode berbasis text.  

Sistem  operasi  komputer  telah  mengalami  perkembangan  yang sangat 

pesat baik untuk keperluan stand alone maupun jaringan. Ada banyak sistem 

operasi komputer yang dapat digunakan dalam sebuah komputer  baik  stand  

alone  maupun  jaringan  diantaranya  adalah Microsoft Windows Series (Win 

98, Win ME, Win 2000, Win XP, Win NT, Win 7, Win 8), Unix, Sun Solaris, 

Linux Series (Redhat, Debian, SUSE, Ubuntu,  fedora),  Mac,  dan  lain.  

sebagainya.  Masing-masing  system operasi memiliki kelebihan dan 

kekurangan sehingga diperlukan analisis dalam memilih sistem operasi mana 

yang sesuai dengan kebutuhan  

 

c. Rangkuman. 

Sistem operasi merupakan penghubung antara pengguna computer 

dengan  perangkat  keras  komputer.  Pengertian  sistem  operasi  secara 

umum adalah suatu pengelola seluruh sumber daya yang terdapat pada 

sistem komputer dan menyediakan sekumpulan layanan (Web, FTP, DNS, 

dan  lain-lain)  untuk  memudahkan  dan  memberi  kenyamanan  dalam 

penggunaan dan pemanfaatan sumber daya sistem komputer. 

. 

d. Tugas : Membuat Ringkasan Materi  konsep system operasi jaringan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. 

Dalam kegiatan ini peserta didik akan membuat ringkasan materi konsep 

system operasi jaringan. Masing-masing kelompok mebuat ringkasan konsep 

system operasi jaringan.Kemudian secara bergantian masing-masing 

kelompok mempresentasikan hasilnya didepan kelas. 
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1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Protokol Pengalamatan menggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) katagori 

konsep system operasi jaringan ,2) fungsi konsep system operasi 

jaringan ,3) implementasi konsep system operasi jaringan  

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. jenis jaringan komputer dimana server melayani permintaan client 

adalah...... 

a. feer to feer 

b. protokol 

c. lan 

d. client-server 

e. wan 

2. komputer-komputer yang menrima atau menggunakan fasilitas   tyang 

disediakan oleh server disebut ........ 

a. host 

b. proxt 

c. server  

d. client 

e. router 

 

3. Server yang dapat membuat sistem berbasis Unix (seperti Linux) untuk 

melakukan sharing  resource dengan sistem berbasis Windows adalah..... 

a.     Apache  

b.     Proxy      

c.     Samba    

d.     Squirel     

e.     Squid   

4. Salah satu OS yang dapat digunakan sebagai server manajemen hotspot 

adalah……………….. 

a. IPCOP 
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b. Mac OS 

c. Windows 

d. Mikrotik 

e. DOS 

5. Yang bukan merupakan software sistem operasi jaringan adalah….. 

a. Norton 

b. Linux 

c. Free BSD 

d. Windows 2000 server 

e. Windows NT 

f. Lembar Jawaban Test Formatif (LJ). 

 

1  A  B  C  D  E 

 

   

           
 

  
2  A  B  C  D  E 

 

  

           
 

  
3  A  B  C  D  E 

 

  

           
 

  
4  A  B  C  D  E 

 

  

           
 

  
5  A  B  C  D  E 
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5. Kegiatan Belajar 5 : Sistem Operasi Windows Server 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 5 ini siswa diharapkan dapat : 

1) Memahami sistem operasi windows server 

2) Menganalisis sistem operasi windows server 

 

b. Uraian Materi 

SISTEM OPERASI WINDOWS SERVER  

Sistem operasi (sering disebut OS) adalah perangkat lunak yang bertugas 

untuk melakukan kontrol,manajemen perangkat keras serta operasi-operasi 

dasar sistem dan memberikan kemudahan penggunaan komputer ke 

pemakai. Sistem operasi ini mengontrol penyimpanan data, masuk,keluar 

dari satu perangkat ke perangkat lainnya. Secara umum, Sistem operasi 

merupakan perangkat lunak pertama di tempatkan oleh komputer dalam 

memorinya saat komputer dinyalakan atau di hidupkan.Setelah Sistem 

Operasi berjalan dengan baik, baru kemudian perangkat-perangkat lunak 

lain dijalankan. Semua perangkat lunak yang di jalankan akan mendapat 

layanan dari sistem operasi, seperti akses disk, manajemen memori, 

skeduling task, dan multitasking. 

Windows NT Server 

 

Windows NT Server adalah sistem operasi untuk server yang sistem 

operasinya 32 bit dari microsoft yang menjadi leluhur sistem operasi operasi 

windows 2000, windows XP, server 2003 dan windows Visata. sistem 
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operasi tersebut pada awalnya mendukung beberapa platform 

mikroprosesor. windows NT server ini tidak di bngun dari MS-DOS mampu 

mengamati 4 GB.. Windows  NT sebenarnya dibangun dari puing-puing sisa 

pengembangan dari sistem operasi IBM 03/2 versi 3.0, Selanjutnya microsoft 

merekut beberapa orang pengembangan sistem operasi dari Digital 

Equipment corporation (DEC). tim pengembangan dikepalai oleh David 

Neilcutler, SR. 

KELEBIHAN   

1.  Peningkatkan kapasitas server untuk melayani lebih simultan koneksinya. 

2.  Bebas dari kode 16 Bit milik MS-DOS 

3.  Peningkatkan kemampuan layanan server TCP/IP 

4.  Model keamanan berbasis domain penuh 

5.  Tool untuk mengintegrasikan Netware dan MeMonitoring jaringan 

KEKURANGAN  

1. Browser yang digunakan sebagai sistem dasar pada sistem perangkat 

bantu administrasi banyak  mengunakan Java script dan Active X. 

2. Pengubahan Konfigurasi yang mendasar jarang dapat dilakukan dengan 

berhasil. 

3. Dokumentasi online 

Windows Server 2000    
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Microsoft merilis windows 2000 pada 17 Febuari 2000 sebuah versi yang 

sebelumnya dikenal dengan sebutan NT 5,0 atau ―NT.5,0″ versi 2000 ditujukan 

untuk dua pangsa pasaar yakni pangsa pasar workstation dan juga pangsa pasar 

server.  

Diantara fitur windows 2000 yang paling signifikan adalah active 

Directory, sebuah model jaringan pengganti jaringan NT domain yang 

menggunakan teknologi yang merupakan standar industri seperti Domain Name 

System (DNS) Light weight Directory Access Protocol (LDAP) dan kerberos 

untuk menghubungkan antara sebuah mesin ke mesinlainnya. 

Windows 2000 dapat memperbaruhi komputer yang sebelumnya menjalankan 

windows 98, windows 2000 tidak lah dianggap sebagai prodok yang cocok untuk 

rumahan, alasannya bnyak diantaranya adalah kurangnya device driver untuk 

banyak penggunaseperti pemindai (Scanner) dan juga pencetak (Printer) pada 

saat di liris windows 2000 tersedia dalam enam edisi yakni. 

 

1.Windows 2000 Professional 

2.Windows 2000 Server 

3. Windows 2000 Advanced Server 

4. Windows 2000 Datacenter Server 

5. Windows 2000 Advanced Server limited Edition 

6. Windows 2000 Datacenter Server Limited Edition 

Windows Server 2003 
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Pada tanggal 24 April 2003 microsoft windows server 2003 sebuah 

pembaruan untuk sistem operasi windows 2000 server yang menawarkan 

bbanyak fitur-fitur keamanan yang baru, pemadu ‖ Manage your server Wizard‖ 

yang menyederhanakan peranan sebuah mesin yang menjalankannya dan juga 

peningkatkan kinerja, windows server 2003 mengunakan kernel windows NT 

versi 5.2.  

Di dalam windows server 2003, beberapa layanan yang tidak terlau 

dibutuhkan didalam lingkungan server dinonaktifkan secara default ―Windows 

Audio‖ dan ―Themes‖ pada bulan Desember 2005, Microsoft merilis windows 

server 2003 R 2. yang merupakan windows server 2003 server pick 1 

ditambahkan dengan beberapa paket tambahan diantara semua fitur-fitur 

barunya adalah fitur-fitur manajemen untuk kantor-kantor cabang dan integrasi 

identitas yang luas. 

Windows 2003 tersedia dalam lima buah edisi: 

1. Windows 2003 Web Edition 

2. Windows 2003 Standard Edition 

3. Windows 2003 Enterprise Edition 

4. Windows 2003 Datacenter Edition 

5. Windows 2003 Small Business Server 

 

Windows Server 2008 

 

Windows server 2008 adalah sebuah versi baru windows server, yang jadwalkan 

untuk diliris pada tanggal 27 febuari 2008. Pada saat pengembangannya 

windows server memiliki nama kode ―Windows Server Codenamed longhorn‖. 

Windows Server 2008 dibangun diatas beberapa keunggulan teknologi dan 

keamanan yang pada awalnya diperkenalkan dengan windows visata dan 
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ditujukan agar bisa lebih modular secara signifikan ketimbang pendahulunya 

windows server 2007. 

 

CONTOH INSTALASI WIN SERVER 2003 

Microsoft Windows Server 2003 merupakan generasi penerus dari Windows 

Server 2000.Windows ini dibuat khusus untuk server pada jaringan. Secara garis 

besar Windows Server 2003 memiliki Versi : 

 Windows Server 2003 Standard Edition (Win2K3 SE) 

 Windows Server 2003 Web Edition 

 Windows Server 2003 Enterprise Edition 

 Windows Server 2003 Datacenter Edition 

 Windows Small Business Server 2003 

 

Windows Server 2003 mempunyai beberapa fasilitas yaitu : 

 File Server 

 Print Server 

 Web Server 

 Mail Server 

 Multimedia Server 

 DNS Server 

 Aplikasi Server (Web Server, FTP Server, dll) 

 DHCP Server 

 Dan Juga bisa sebagai Router (NAT) 

 

Untuk Win2K3 SE, komputer yang akan menggunakannya harus memenuhi 

beberapa persyaratan minimal sebagai berikut : 

 Processors minimum speed 550 megahertz (MHz). Atau minimum support 

133 MHz. Maximum mendukung 4 processors per computer. 

 256 megabytes (MB) RAM (recommended minimum) atau minimum 128 

MB, dan maksimum 4 gigabytes (GB). 

 

Cara Menginstal Win2K3 SE 
Untuk melakukan install Win2K3 SE Cara yang paling mudah dan banyak 

dilakukan adalah Install dari CD. Instalasi Windows Server 2003 dari CD/DVD 

hampir mirip dengan instalasi Windows XP dan sama mudahnya. Hal-hal yang 

perlu Anda siapkan: 

 



 

38 | J a r i n g a n  D a s a r   
 

Jaringan Dasar 

1. CD/DVD instalasi Win2K3 SE 

2. CD/DVD driver untuk motherboard, video card, sound card, ethernet card, 

dll. 
Atur konfigurasi BIOS agar melakukan boot ke CD/DVD ROM. Masukkan 

CD/DVD Windows Server 2003. 

1. Mulai dari instalasi dari CD/DVD 

 
2. Anda akan mendapatkan layar selamat datang di setup Windows Server 2003. 

 
 

3. Tekan tombol ‗ENTER‘ di keyboard. Anda akan menuju ke layar EULA 
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4. Tekan ‗F8′ di keyboard untuk persetujuan lisensi Windows Server 2003. 

5. Membuat partisi. 

6. Sekarang anda diminta membuat partisi hardisk. Jika hardisk Anda masih 

kosong, anda harus membuat partisi untuk sistem Windows Server 2003. 

 
7. Tekan ‗C‘ untuk membuat partisi dan masukkan ukuran partisi yang 

dibutuhkan, misal 10000MB (1GB) dan isi ukuran partisi yang ingin anda buat 

dalam ukuran Mega Byte  

 

 
 

8. Jika sudah selesai, tekan ‗ENTER‘. Maka akan tampil ukuran partisi dari 

hardisk yang anda buat.  
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9. Jika sudah selesai, tekan ‗ENTER‘.Format partisi tersebut dengan filesystem 

NTFS dengan metode quickformat.  

 

 
10.Tekan ‗ENTER‘. Windows Server 2003 Setup memformat partisi hardisk 

Anda.  

 

 
 

11. Setelah format selesai, Windows Server 2003 Setup meng-copy file-file ke 

partisi Windows.  
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12. Setelah selesai, Windows Server 2003 Setup akan me-restart komputer dan 

boot ulang.  

 

 
 

13. Setelah restart ulang maka komputer akan di Setup GUI (Grafis)  

 

 
 

14. Setelah booting ulang Windows akan dilanjutin dengan konfigurasi. 
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15. Tunggu beberapa saat sampai muncul Wizard berikut: 

 
 

16. Pilih ‗Customize‘, dan lakukan setting seperti screen di bawah ini. 

 
 

17. Klik ‗OK‘, kembali ke layar sebelumnya dan klik ‗Next‘. 
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18. Isi dengan Nama Anda dan Nama Perusahaan Anda. Kemudian klik ‗Next‘. 

 
 

19. Isi dengan CD key Windows Server 2003 yang disertakan bersama CD 

Windows Server 2003. Klik ‗Next‘.  

 

 
 

20. Pilih Licensing Mode ‗Per Server‘ dan isi dengan jumlah koneksi yang 

dibutuhkan. Klik ‗Next‘.  
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21. Isi ‗Computer Name‘ dan password untuk Administrator. Klik ‗Next‘.  

 

 
 

22. Pilih ‗Time Zone‘ dengan (GMT +07:00 ) Bangkok, Hanoi, Jakarta. Klik ‗Next‘. 

Setup akan melakukan instalasi Network.  

 

 
 

20. PIlih ‗Custom settings‘ dan klik ‗Next‘.  
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21. Pilih komponen ‗Internet Protocol (TCP/IP)‘ dan klik ‗Properties‘.  

 

 
 

22. Isi ‗IP address‘, ‗Subnet mask:‘, ‗Default gateway:‘ sesuai konfigurasi network 

Anda. Klik ‗OK‘. Misalnya:  

IP : 192.168.0.203  

Subnet Mask : 255.255.255.0  

Gateway : 192.168.0.203  

 

 
 

23. Isi nama Workgroup yang diinginkan, misalnya : ‗Workgroup. dan klik ‗Next‘ 

.  
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24. Setup mencopy file-file komponen ke partisi Windows. Setelah itu Setup akan 

melakukan restart dan boot ulang komputer Anda.   

 

 
 

25. Setelah booting ulang maka akan tampil seperti gambar di bawah. 

 
 

26. Selamat, Anda berhasil melakukan instalasi Windows Server 2003!. Login 

Administor dan password  
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27. Sekarng ada sudah siap meninstalasi 

 
 

 

c. Rangkuman. 

Sistem operasi (sering disebut OS) adalah perangkat lunak yang bertugas 

untuk melakukan kontrol,manajemen perangkat keras serta operasi-operasi 

dasar sistem dan memberikan kemudahan penggunaan komputer ke 

pemakai. Sistem operasi ini mengontrol penyimpanan data, masuk,keluar 

dari satu perangkat ke perangkat lainnya. Secara umum, Sistem operasi 

merupakan perangkat lunak pertama di tempatkan oleh komputer dalam 

memorinya saat komputer dinyalakan atau di hidupkan.Setelah Sistem 

Operasi berjalan dengan baik, baru kemudian perangkat-perangkat lunak lain 

dijalankan. Semua perangkat lunak yang di jalankan akan mendapat layanan 

dari sistem operasi. 

. 

d. Tugas : Membuat Ringkasan Materi  sistem operasi windows 

server 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi sistem operasi 

windows server  Masing-masing kelompok mebuat ringkasan sistem operasi 

windows server.Kemudian secara bergantian masing-masing kelompok 

mempresentasikan hasilnya didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 
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1.2. Buatlah ringkasan materi untuk sistem operasi windows server 

menggunakan software pengolah presentasi. Topik yang di tulis meliputi 

1) katagori sistem operasi windows server ,2) fungsi sistem operasi 

windows server ,3) implementasi sistem operasi windows server  

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. Windows Server 2008 mendukung sistem klien dengan.. 

a. Linux      

b. Windows Xp      

c. Sistem Operasi Jaringan     

d. Jaringan Dunia      

e. windows Vista  

      

2. Beberapa Sistem Operasi Server antara lain : 

a. Win NT 

b. Windows 2000 Server 

c. Windows 2003 Server  

d. Windows 2008 Server 

e. Mac Os  

 

3. Sistem operasi windows disajikan dalam bentuk GUI. GUI adalah 

singkatan dari… 

a. Graph Use Interchange 

b. Graphical User Interface 

c. Group User Interface 

d. Graph User Internal 

e. Geograpic United Internasional 

 

4. Windows Server 2003 mempunyai beberapa fasilitas yaitu,kecuali……. 

a. File Server 

b. Advanced Server limited Edition  

c. Web Server 

d. Mail Server 
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e. Multimedia Server 

 

5. Kelebihan Windows NT Antaralain Sebagai berikut kecuali ….. 

a. Peningkatkan kapasitas server untuk melayani lebih simultan 

koneksinya. 

b. Bebas dari kode 16 Bit milik MS-DOS 

c. Peningkatkan kemampuan layanan server TCP/IP 

d. Model keamanan berbasis domain penuh 

e. Dokumentasi online 

 

f. Lembar Jawaban Test Formatif (LJ). 

 

1  A  B  C  D  E 

 

   

           
 

  
2  A  B  C  D  E 

 

  

           
 

  
3  A  B  C  D  E 

 

  

           
 

  
4  A  B  C  D  E 

 

  

           
 

  
5  A  B  C  D  E 
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6. kegiatan Belajar 6 : SISTEM OPERASI GNU LINUX SERVER 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 6 ini siswa diharapkan dapat : 

1. Memahami Sistem operasi GNU linux server 

2. Menganalisis Sistem operasi GNU linux server 

 

b. Uraian Materi 

SISTEM OPERASI GNU LINUX SERVER 

GNU/Linux adalah sebuah sistem operasi yang diciptakan oleh Linus 

Benedict Torvalds seorang mahasiswa Universitas Helsinki Finlandia di 

tahun 1991.Proyek GNU ini diluncurkan pada tahun 1984 untuk 

mengembangkan sebuah sistem operasi lengkap mirip UNIX berbasis 

perangkat lunak bebas: yaitu sistem GNU (GNU merupakan akronim 

berulang dari ―GNU‘s Not Unix‖; GNU dilafalkan dengan ―genyu‖). Varian 

dari sistem operasi GNU, yang menggunakan kernel Linux, dewasa ini telah 

digunakan secara meluas.Walau pun sistem ini sering dirujuk sebagai 

―Linux‖, sebetulnya lebih tepat jika disebut sistem GNU/Linux. Ada salah 

satu fitur atau kemampuan yang sangat menarik dari GNU/Linux yang 

belum ada pada sistem operasi populer lainnya, yaitu menjalankan sistem 

operasi dan aplikasi lengkap tanpa menginstalnya di hard disk. Dengan cara 

ini dengan mudah kita dapat menggunakan GNU/Linux di komputer orang 

lain karena tak perlu menginstalnya (tak perlu mengutak-atik hard disk dan 

partisinya). Sejarah sistem operasi Linux berkaitan erat dengan 

proyek GNU, proyek program bebas freeware terkenal diketuai oleh Richard 

Stallman. Proyek GNU diawali pada tahun 1983 untuk membuat sistem 

operasi seperti Unix lengkap — kompiler, utiliti aplikasi, utiliti pembuatan 

dan seterusnya — diciptakan sepenuhnya dengan perangkat lunak bebas. 

Pada tahun 1991, pada saat versi pertama kerangka Linux ditulis, proyek 

GNU telah menghasilkan hampir semua komponen sistem ini — kecuali 

kernel.Torvalds dan pembuat kernel seperti Linux menyesuaikan kernel 

mereka supaya dapat berfungsi dengan komponen GNU, dan seterusnya 
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mengeluarkan Sistem operasi yang cukup berfungsi.Oleh karena itu, Linux 

melengkapi ruang terakhir dalam rancangan GNU. 

Beberapa distro Linux Live CD yang banyak dipakai antara lain 

Knoppix, SUSE Live Eval, Mandrake Move, Gentoo Live CD, Slackware 

Live CD dll. Meskipun bentuknya Live CD, tetapi distro tersebut memiliki 

fungsi yang sama dengan distro-distro terinstal. Di dalam CD tersebut, 

sudah terdapat paket-paket umum yang biasa kita jumpai di distro Linux 

besar, seperti: OpenOffice, KOffice, XMMS, GIMP, Konqueror, dan 

sebagainya. Namun ada beberapa pengecualian, yaitu beberapa paket 

yang memang sangat besar dan kiranya tidaklah umum digunakan oleh 

home user, mengingat kapasitas CD yang terbatas, yaitu sekitar 700MB. 

Kepraktisan itu ada batasnya karena selama operasionalnya, Linux Live CD 

tidak mempunyai sebuah tempat khusus di dalam harddisk. Linux Live CD 

hanya memiliki tempat di memori utama (RAM), sehingga setelah di-restart, 

semua isi RAM akan dikosongkan dan Linux Live CD harus melakukan 

inisialisasi ulang untuk mendeteksi semua perangkat keras yang dimiliki 

oleh user. Selain itu, kinerja dari Linux Live CD sendiri juga tidak bisa 

maksimal, karena kecepatan komputer untuk mengakses       CD-ROM jauh 

lebih lambat dibandingkan dengan kecepatan mengakses harddisk. 

Dalam ilmu komputer, kernel adalah suatu perangkat lunak yang 

menjadi bagian utama dari sebuah sistem operasi.Tugasnya melayani 

bermacam program aplikasi untuk mengakses perangkat 

keras komputer secara aman.Istilah Linux sebetulnya hanya mengacu pada 

kernel dari suatu sistem operasi.Kernel adalah Jembatan antara hardware 

dan aplikasi-aplikasi yg menterjemahkan bahasa software sehingga mampu 

dimengerti dan diproses oleh hardware sesuai dengan permintaan. Karena 

akses terhadap perangkat keras terbatas, sedangkan ada lebih dari satu 

program yang harus dilayani dalam waktu yang bersamaan, maka kernel 

juga bertugas untuk mengatur kapan dan berapa lama suatu program 

dapatmenggunakan satu bagian perangkat keras tersebut.Hal tersebut 

dinamakan sebagai multiplexing.Akses kepada perangkat keras secara 

langsung merupakan masalah yang kompleks, oleh karena itu kernel 
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biasanya mengimplementasikan sekumpulan abstraksi hardware. Abstraksi-

abstraksi tersebut merupakan sebuah cara untuk menyembunyikan 

kompleksitas, dan memungkinkan akses kepada perangkat keras menjadi 

mudah dan seragam. Sehingga abstraksi pada akhirnya memudahkan 

pekerjaan programer.Sebuah kernel sistem operasi tidak harus ada dan 

dibutuhkan untuk menjalankan sebuah komputer.Program dapat langsung 

dijalankan secara langsung di dalam sebuah mesin (contohnya 

adalah CMOS Setup) sehingga para pembuat program tersebut membuat 

program tanpa adanya dukungan dari sistem operasi atau hardware 

abstraction. Cara kerja seperti ini, adalah cara kerja yang digunakan pada 

zaman awal-awal dikembangkannya komputer (pada sekitar tahun 1950). 

Kerugian dari diterapkannya metode ini adalah pengguna harus melakukan 

reset ulang komputer tersebut dan memuatkan program lainnya untuk 

berpindah program, dari satu program ke program lainnya. Selanjutnya, 

para pembuat program tersebut membuat beberapa komponen program 

yang sengaja ditinggalkan di dalam komputer, seperti 

halnya loader atau debugger, atau dimuat dari dalam ROM (Read-Only 

Memory). Seiring dengan perkembangan zaman komputer yang mengalami 

akselerasi yang signifikan, metode ini selanjutnya membentuk apa yang 

disebut dengan kernel sistem operasi. 

Selanjutnya, para arsitek sistem operasi mengembangkan kernel 

sistem operasi yang pada akhirnya terbagi menjadi empat bagian yang 

secara desain berbeda, sebagai berikut: 

 Monolithic Kernel. Monolithic kernel mengintegrasikan banyak fungsi 

di dalam kernel dan menyediakan lapisan abstraksi perangkat 

keras secara penuh terhadap perangkat keras yang berada di 

bawah sistem operasi. 

 Microkernel. Microkernel menyediakan sedikit saja dari abstraksi 

perangkat keras dan menggunakan aplikasi yang berjalan di 

atasnya—yang disebut dengan server—untuk melakukan beberapa 

fungsionalitas lainnya. 
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 Hybrid kernel. Hybrid kernel adalah pendekatan desain microkernel 

yang dimodifikasi. Pada hybrid kernel, terdapat beberapa tambahan 

kode di dalam ruangan kernel untuk meningkatkan performanya. 

 Exokernel. Exokernel menyediakan hardware abstraction secara 

minimal, sehingga program dapat mengakses hardware secara 

langsung. Dalam pendekatan desain exokernel, library yang dimiliki 

oleh sistem operasi dapat melakukan abstraksi yang mirip dengan 

abstraksi yang dilakukan dalam desain monolithic kernel. 

open source adalah sistem pengembangan yang tidak dikoordinasi oleh 

suatu orang/lembaga pusat, tetapi oleh para pelaku yang bekerja sama 

dengan memanfaatkan kode sumber (source-code) yang tersebar dan 

tersedia bebas (biasanya menggunakan fasilitas komunikasi internet). Pola 

pengembangan ini mengambil model ala bazaar, sehingga pola Open 

Source ini memiliki ciri bagi komunitasnya yaitu adanya dorongan yang 

bersumber dari budaya memberi, yang artinya ketika suatu komunitas 

menggunakan sebuah program Open Source dan telah menerima sebuah 

manfaat kemudian akan termotivasi untuk menimbulkan sebuah pertanyaan 

apa yang bisa pengguna berikan balik kepada orang banyak. 

Pengembangan Linux bersifat open source artinya source code dari aplikasi 

pembentuk sistem dan aplikasi lainnya diberikan secara terbuka sehingga 

setiap orang dapat melakukan modifikasi atau kustomisasi sesuai dengan 

kebutuhan masing-masing. 

Pola Open Source lahir karena kebebasan berkarya, tanpa intervensi 

berpikir dan mengungkapkan apa yang diinginkan dengan menggunakan 

pengetahuan dan produk yang cocok. Kebebasan menjadi pertimbangan 

utama ketika dilepas ke publik.Komunitas yang lain mendapat kebebasan 

untuk belajar, mengutak-ngatik, merevisi ulang, membenarkan ataupun 

bahkan menyalahkan, tetapi kebebasan ini juga datang bersama dengan 

tanggung jawab, bukan bebas tanpa tanggung jawab.Pada intinya konsep 

sumber terbuka adalah membuka ―kode sumber‖ dari sebuah perangkat 

lunak.Konsep ini terasa aneh pada awalnya dikarenakan kode sumber 

merupakan kunci dari sebuah perangkat lunak. Dengan diketahui logika 
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yang ada di kode sumber, maka orang lain semestinya dapat membuat 

perangkat lunak yang sama fungsinya. Sumber terbuka hanya sebatas 

itu.Artinya, dia tidak harus gratis.Definisi sumber terbuka yang asli adalah 

seperti tertuang dalam OSD (Open Source Definition)/Definisi sumber 

terbuka.Pergerakan perangkat lunak bebas dan sumber terbuka saat ini 

membagi pergerakannya dengan pandangan dan tujuan yang 

berbeda.Sumber terbuka adalah pengembangan secara metodelogi, 

perangkat lunak tidak bebas adalah solusi suboptimal.Bagi pergerakan 

perangkat lunak bebas, perangkat lunak tidak bebas adalah 

masalah sosial dan perangkat lunak bebas adalah solusi. 

10 Distro Linux Yang Cocok Untuk Server 

1. Ubuntu  

 

 

Ubuntu merupakan distro linux yang berbasis Debian berada dalam kelas 

dengan sendirinya. Ini melampaui semua distro lain dari segi instalasinya yang 

sederhana dan dibantu dengan dukungan kinerja hardware yang sangat baik 

untuk kebutuhan komersial kelas dunia,dan tentunya ubuntu juga menjadi pilihan 

dalam membuat sebuah server jaringan. 
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2. Red Hat  

 

Red Hat Enterprise Linux (RHEL) adalah sebuah perusahaan Linux kecil yang 

sekarang menjadi kekuatan utama dalam upaya untuk rackspace data center.                                  

Dan Redhat ini banyak dijadikan pilihan untuk dibuat menjadi                                         

server meskipun ada beberapa paket yang memerlukan biaya untuk memilikinya. 

 

3. SUSE 

 

 

SUSE Linux adalah distro milik novell suse linux juga dijadikan pilihan yang tidak 

kalah dari distro lainnya,dan banyak juga yang tidak tanggung tanggung untuk 

memilih suse sebagai os pribadi maupun server 

 

4. Mandriva 

 

Mandriva adalah sistem operasi linux server yang mungkin agak asing.linux ini 
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berasal dari Perancis dan klaim penerimaan ekstrim di Eropa dan Amerika 

Selatan. Hal ini, seperti klaim situsnya, penyedia Linux di seluruh dunia.Namanya 

dan konstruksinya berasal dari Mandrake Linux dan Connectiva distribusi Linux. 

 

5. Xandros 

 

 

Jika Anda lebih memilih distribusi Linux dengan koneksi Microsoft, Xandros 

adalah satu pilihan yang tepat untuk Anda. Rumor mengenai, Xandros dan 

Microsoft berkolaborasi dalam apa yang dikenal di kalangan teknis sebagai 

"cooperatition." Ini berarti bahwa mereka bersaing secara kooperatif. 

 

6. Slackware 

 

 

Slackware yang meruapakan distro milik Patrick Volkerding adalah salah satu 
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sistem operasi yang free atau gratis Meskipun tidak umumnya terkait dengan 

distribusi komersial, Slackware mempertahankan hubungan dengan beberapa 

perusahaan yang memberikan dukungan fee-based. Salah satu distro awal yang 

tersedia, Slackware memiliki basis penggemar yang luas dan setia.Pengembang 

secara teratur merilis versi baru dan keunggulan fitur di tiap perbaharuannya. 

7. Debian 

 

Debian adalah sistem operasi yang tidak memiliki dukungan komersial formal, 

tetapi Anda dapat terhubung dengan konsultan Debian-savvy di seluruh dunia 

melalui halaman Konsultan mereka.Debian telah melahirkan anak distribusi lebih 

dari distribusi linux lainnya, seperti Ubuntu, Linux Mint dan Vyatta. 

 

8. Vyatta 

 

Linux Vyatta memiliki kelelebih dalam pengaturan router dan firewall dari sistem 

berbasis PC tetapi jika Anda ingin distribusi komersial-driven untuk aplikasi 

tersebut, Vyatta bekerja dengan baik untuk kebutuhan pada media komunikasi 

dan tentunya sangat aman dan terjangkau.Vyatta Linux Juga memiliki versi 

gratis. 
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9. CentOS 

 

Memang benar bahwa CentOS tidak sepenuhnya komersial tetapi karena 

didasarkan pada Red Hat Enterprise Linux, Anda dapat memanfaatkan dukungan 

komersial untuk itu. CentOS memiliki repositori sendiri dan dukungan masyarakat 

dan tidak sama dengan Fedora Linux. 

 

10. Unbreakable Linux 

 

Oracle Unbreakable Linux Red Hat Enterprise Linux dengan beberapa logo 

Oracle dan seni.Oracle bersaing langsung dengan Red Hat dengan distribusi dan 

cukup efektif, karena dukungan dibeli melalui Oracle adalah setengah harga dari 

model setara Red Hat. 
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c. Rangkuman. 

Proyek GNU ini diluncurkan pada tahun 1984 untuk mengembangkan 

sebuah sistem operasi lengkap mirip UNIX berbasis perangkat lunak bebas: 

yaitu sistem GNU (GNU merupakan akronim berulang dari ―GNU‘s Not 

Unix‖; GNU dilafalkan dengan ―genyu‖). Varian dari sistem operasi GNU, 

yang menggunakan kernel Linux, dewasa ini telah digunakan secara 

meluas.Walau pun sistem ini sering dirujuk sebagai ―Linux‖, sebetulnya lebih 

tepat jika disebut sistem GNU/Linux. Ada salah satu fitur atau kemampuan 

yang sangat menarik dari GNU/Linux yang belum ada pada sistem operasi 

populer lainnya, yaitu menjalankan sistem operasi dan aplikasi lengkap 

tanpa menginstalnya di hard disk. Dengan cara ini dengan mudah kita dapat 

menggunakan GNU/Linux di komputer orang lain karena tak perlu 

menginstalnya (tak perlu mengutak-atik hard disk dan partisinya). 

 

d. Tugas : Membuat Ringkasan Materi  Sistem operasi GNU linux server 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi Sistem operasi 

GNU linux server. Masing-masing kelompok mebuat ringkasan Sistem 

operasi GNU linux server.Kemudian secara bergantian masing-masing 

kelompok mempresentasikan hasilnya didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Sistem operasi GNU linux server 

menggunakan software pengolah presentasi. Topik yang di tulis meliputi 

1) katagori Sistem operasi GNU linux server ,2) fungsi Sistem operasi 

GNU linux server ,3) implementasi Sistem operasi GNU linux server 

1.3. Presentasikan hasil ringkasan di depan kelas. 
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e. Tes Formatif 

1. LINUX merupakan kepanjangan dari… 

a. Linus Minix 

b. Linus Unix 

c. Line Tux 

d. Line Unix 

e. Linus Mix 

2. Dibawah ini yang termasuk distribusi LINUX, kecuali 

a. Mandrake 

b. Corel 

c. Debian 

d. RedHat 

e. Hackware 

3. Macam – macam sistem operasi linux 

a. Redhat, avast, xandros 

b. Suse Linux, Winbi, Winzip 

c. Memphis, knoppix, Arobat 

d. Mandrake, transtool, debian 

e. Redhat, Slackware, Mandrake 

 

4. Berikut ini kelebihan LINUX dibanding SO yang lain, kecuali… 

a. Kebal Virus 

b. Freeware 

c. Open Source 

d. Dualboot 

e. Dualchannel 

 

5. Logo LINUX adalah… 

a. Pinguin 

b. Burung 

c. Sigung 

d. Kadal 
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e. Zebra 

 

f. Lembar Jawaban Test Formatif (LJ). 

 

1  A 
 

B 
 

C 
 

D 
 

E 
 

   

  
          

  
2  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
3  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
4  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
5  A 

 
B 

 
C 

 
D 

 
E 
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7. Kegiatan Belajar  7 : SISTEM OPERASI UNIX SERVER 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 4 ini siswa diharapkan dapat : 

1). Memahami Sistem operasi unix  server 

2). Menganalisis Sistem operasi unix  server 

 

b. Uraian Materi 

SISTEM OPERASI UNIX SERVER 

UNIX adalah sebuah sistem operasi komputer yang dikembangkan oleh 

AT&T Bell Labs pada  tahun  1960  dan  1970-an.  UNIX  didesain  sebagai  

sistem  operasi  yang  portable,  multitasking dan multi-user. BSD adalah salah 

satu turunan (varian) Unix  yang dikembangkan oleh Universitas California, 

Berkeley.Sistem  operasi  Unix  digunakan  secara  luas  baik  sebagai  server  

atau  workstation. Arsitektur  Unix  dan  model  client/server  merupakan  elemen  

yang  paling  penting  dalam perkembangan internet dan mengubah proses 

komputasi secara terpusat dalam jaringan dari pada proses  tunggal  di  

komputer.  Linux,  merupakan  sistem  operasi  yang  diadopsi  dari  Unix  dan 

tersedia  secara  bebas  mendapat  popularitas  sebagai  alternatif  dari  sistem  

operasi  proprietary seperti  Microsoft  Windows  . 

Pada  tahun  1960,  Massachusetts  Institute  of  Technology,  AT&T Bell Labs, 

and General Electric bekerja dalam sebuah sistem operasi eksprimental yang 

disebut Multics (Multiplexed Information and Computing Service). 

APLIKASI 

Banyak aplikasi-aplikasi dalam sistem operasi lain yang awalnya lahir dalam 

lingkungan sistem operasi Unix. Salah satu contoh aplikasi yang dimaksud 

misalnya adalah gnuplot. 

1. Gnuplot adalah  suatu  program  perintah-baris  fleksibel  yang  dapat  

digunakan  untuk menghasilkan baik grafik dua maupun tiga dimensi. 
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Program ini umumnya dapat berjalan hampir  pada  semua  jenis  

komputer  dan  sistem  operasi,  walaupun  pada  awalnya  ia diturunkan 

dari program yang berasal dari sistem operasi Unix. gnuplot dapat 

dikatakan sebagai suatu program yang telah memiliki sejarah panjang, 

boleh dikatakan sejak tahun 1986. gnuplot dapat menghasilkan keluaran 

langsung ke layar, sebagaimana pula ia dapat menghasilkan  keluaran  

dalam  bentuk  berkas  grafik  dengan  beragam  format.  Diantara format-

format yang didukung adalah PNG, EPS, SVG, JPEG, LaTeX, PostScript, 

PDF, GIF, CorelDraw dan banyak format lainnya 

 

2. Samba adalah himpunan  aplikasi  yang bertujuan  agar komputer dengan  

sistem operasi Linux,  BSD  (  atau  UNIX  lainnya)  dapat  bertindak  

sebagai  file  dan  print  server  yang berbasis  protokol  SMB  (session  

message  block).  Jaringan  yang  semacam  ini  biasa dijumpai pada 

Windows workgroup atau Windows NT Domain. Samba juga dilengkapi 

dengan beberapa program bantu sehingga sistem operasi Linux (dan 

UNIX lainnya) bisa mengakses resources  yang ada pada jaringan 

Windows  yang telah  ada. Bisa dikatakan, Samba adalah jembatan 

penghubung antara Windows dan UNIX. 

 

 

3. Squidadalah  software  public  domain  berbasis  UNIX,  berfungsi  

mengcache  data  yang diminta  oleh  pengguna  (biasanya  berupa  web  

pages  dan  ftp).  Platform  UNIX  yang didukung  Squid  adalah  

FreeBSD,  BSDI,  Digital  Unix,  Irix,  Linux,  Solaris  dan  SunOs. Namun 

data-data yang bersifat dinamik, seperti CGI-BIN, tidak dicache oleh 

Squid, jadi setiap kali ada permintaan CGI-BIN, Squid  akan 

menghubungi langsung server  tujuan. Saat ini protokol yang bisa dilayani 

oleh Squid adalah "http", "ftp", "gopher" dan "wais".Proxy  server berguna  

sebagai  mediator  antara  pengguna  dan  dunia  luar  (Web).  Semua 

request HTTP dari pengguna akan diarahkan ke Proxy Server (dengan 

mengkonfigurasi semua  browser  pengguna)  dan  data  berupa  tujuan  

(misal  http://www.itb.ac.id)  yang diminta pengguna akan diteruskan oleh 

Proxy server ke tujuan yang diminta. Data yang telah didapat oleh Proxy 
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server tidak dibuang begitu  saja; selain akan dikembalikan ke arah 

pengguna  yang  meminta,  data ini  juga  akan  disimpan  (dicache). Jadi  

apabila data yang sama diminta oleh pengguna lain, proxy tidak usah 

meminta data tersebut ke server yang  diminta,  tetapi  cukup  

mengirimkan  data  yang  telah  ada  di  cache  ke  pengguna tersebut. 

4. Dan lain-lain 

UNIX DI INDONESIA 

Di  Indonesia  Unix  digunakan  sebagai  Server  aplikasi,  produk  yang  

beredar  di  pasaran antara lain IBM AIX, HP UX, Sun Solaris. Masing-masing 

produk ini umumnya memiliki pasar tersendiri seperti Sun Solaris yang digunakan 

pada operator telekomunikasi selular, HP UX pada manufaktur dan distribusi. 

Fungsi Unix sebagai workstation kurang populer mengingat harganya yang 

mahal. 

STRUKTUR UNIX 

 Perangkat Keras 

1. Unit System (Mencakup Central Processing Unit (CPU) , memory , media 

penyimpanan (Hardisk) serta piranti untuk keperluan backup, misal floppy 

disk, flshdisk, dll.) 

2. Console  (Piranti  yang  terdiri  dari  layar  dan  keyboard  yang  dipakai  

oleh  manajer  suatu sistem (administrator sistem) untuk mengendalikan 

operasi sistem.) 

3. Terminal  (Piranti  yang  terdiri  dari  layar  dan  keyboard  yang  biasa  

digunakan  oleh pemakai untuk berinteraksi dengan sistem.) 

4. Jalur  Komunikasi  Piranti  yang  biasa  digunakan  untuk  

menghubungkan  terminal  jarak jauh ke sistem unix.) 

5. Printer (Piranti yang digunakan untuk memperoleh informasi dalam 

kertas.) 
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 Perangkat Lunak 

1. Kernel 

Adalah  inti  dari  sistem  UNIX  yang  mengendalikan  perangkat  keras  dan  

membentuk berbagai fungsi. Fungsi yang di laksanakan oleh Kernel adalah : 

 Pelayanan tanggal dan jam system 

 Manajemen berkas dan penanganan security 

 Pelayanan operasi masukan dan keluaran 

 Penjadwalan proses 

 Manajemen memori 

 Melakukan kegiatan akuntansi system 

 Melakukan penanganan dan interupsi system 

2. Shell 

Merupakan penerjemah pada sistem UNIX menjadi jembatan antara pemakai 

dan sistem UNIX. 

3. Utilitas 

Merupakan program yang disediakan sistem UNIX untuk melaksanakan tugas 

tertentu, seperti : 

 Utilitas manajemen file dan direktori 

 Utilitas penyunting berkas 

 Utilitas penunjang komunikasi dan jaringan 

 Utilitas administrasi system , dll . 

4. Aplikasi 

Merupakan program‖ yang dibuat oleh pemakai, untuk memenuhi kebutuhan 

sendiri. 

CIRI-CIRI SISTEM UNIX 

1. Portabilitas (Sistem UNIX mudah diadaptasikan ke sistem komputer yang 

lain atau pada berbagai jenis komputer.) 
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2. Multiuser (Sejumlah pemakai dapat menggunakan sistem secara 

bersamaan. Keuntungan dengan adanya ciri multiuser : 

 Penghematan perangkat keras 

 Data dapat di akses oleh banyak pengguna secara serentak.) 

3. Multitasking (Seorang pemakai dapat melakukan beberapa pekerjaan 

dalam waktu yang bersamaan dari sebuah terminal.) 

4. System Berkas yang Hierarkis (Memungkinkan pemakai 

mengorganisasikan informasi / data dalam bentuk yang mudah untuk 

diingat dan mudah untuk mengaksesnya.) 

5. Utilitas (Merupakan program yang disesuaikan dengan kebutuhan/tugas 

tertentu .) 

KELEBIHAN UNIX 

 Unix  bisa  berinteraksi  dengan  operating  system  lain  dengan  cara  

kompabilitas  file system, kompabilitas network, dan emulasi (simulasi) 

operating system. 

 Virtual memory membuat Unix mempunyai kemampuan untuk 

menjalankan program –program yang lebih dari seharusnya karena 

penggunaan swap memori.. 

 Skalabilitas  artinya  Unix  bisa  berjalan  dari  komputer  286  XT  sampai  

dengan  mesin sebesar Beowulf clusters dengan multi prosesor 16 buah. 

 Stabilitas,  Unix  sangat  luar  biasa  stabil,  jika  dikonfigurasi  dengan  

benar,  system  Unix akan  hidup  terus  menerus  hingga  hardwarenya  

tidak  memadai  (rusak),  lain  dengan windows  yang  memerlukan  

reboot  berkala  untuk  menjaga  stabilitas.  Salah  satu  yang mendasari 

stabilitas ini adalah penomoran versi dari shared libraries, kebanyakan 

aplikasi windows  menginstall  versi-versi  baru  dari  dynamic  link  

libraries  (DLL),  yang mengakibatkan aplikasi lain yang menimpa versi 

lain dari DLL tersebut tidak berfungsi dengan semestinya. virus pada 

dasarnya tidak dikenal di dunia Unix 

 Didukung  oleh  ribuan  programmer  di  seluruh  dunia,  jadi  kalau  

ditemukan  bug  cepat untuk  mendapatkan  solusinya,  bahkan  dalam  
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hitungan  jam  kalau  ditemukan  bug, workaround sudah tersedia untuk di 

download. 

 Paket Unix merupakan satu kesatuan artinya, saat instalasi tergantung 

keinginan pemakai. 

 Sudah mulai banyak didukung oleh vendor hardware maupun software 

dunia meskipun masih kalah dengan windows. 

Kekurangan UNIX 

 Operating system yang agak sulit untuk dipelajari terutama bagi yang 

tidak mempunyai dasar komputer yang kuat. 

 Aplikasi yang tersedia belum sebanyak windows. 

 Operating system yang tidak sepenuhnya GUI(Graphical User Interface) 

meskipun sudah menggunakan X-windows seperti GNOME dan KDE 

 Nama-nama paket program antara distro satu dengan distro lainnya 

berbeda beda. Seperti paket Yaz.tar.gz.rpm.krpm.deb dan lain -lain 

 

c. Rangkuman. 

UNIX adalah sebuah sistem operasi komputer yang dikembangkan oleh 

AT&T Bell Labs pada  tahun  1960  dan  1970-an.  UNIX  didesain  sebagai  

sistem  operasi  yang  portable,  multitasking dan multi-user. BSD adalah 

salah satu turunan (varian) Unix  yang dikembangkan oleh Universitas 

California, Berkeley.Sistem  operasi  Unix  digunakan  secara  luas  baik  

sebagai  server  atau  workstation. Arsitektur  Unix  dan  model  client/server  

merupakan  elemen  yang  paling  penting  dalam perkembangan internet dan 

mengubah proses komputasi secara terpusat dalam jaringan dari pada 

proses  tunggal  di  komputer.  Linux,  merupakan  sistem  operasi  yang  

diadopsi  dari  Unix  dan tersedia  secara  bebas  mendapat  popularitas  

sebagai  alternatif  dari  sistem  operasi  proprietary seperti  Microsoft  

Windows. 

. 
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d. Tugas : Membuat Ringkasan Materi  sistem operasi Unix server 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. 

Dalam kegiatan ini peserta didik akan membuat ringkasan materi sistem 

operasi Unix server 

,Masing-masing kelompok mebuat ringkasan sistem operasi Unix server 

.Kemudian secara bergantian masing-masing kelompok 

mempresentasikan hasilnya didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk sistem operasi Unix server 

menggunakan software pengolah presentasi. Topik yang di tulis 

meliputi 1) katagori sistem operasi Unix server, 2) fungsi sistem 

operasi Unix server ,3) implementasi sistem operasi Unix server 

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. Dibawah ini yang termasuk dalam perangkat keras UNIX. Kecuali 

a. Unit system   

b. Kernel 

c. Terminal              

d. Console 

 

2. Berikut ini kelebihan dari sistem operasi UNIX, Kecuali... 

a. Operating system yang agak sulit untuk dipelajari terutama bagi yang 

tidak mempunyai dasar komputer yang kuat. 

b. Skalabilitas  artinya  Unix  bisa  berjalan  dari  komputer  286  XT  

sampai  dengan  mesin sebesar Beowulf clusters dengan multi 

prosesor 16 buah. 

c. Paket Unix merupakan satu kesatuan artinya, saat instalasi 

tergantung keinginan pemakai. 

d. Sudah mulai banyak didukung oleh vendor hardware maupun 

software dunia meskipun masih kalah dengan windows. 

 

3. Software yang menjalankan  public  domain  berbasis  UNIX.... 

a. Samba 
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b. Gnuplot 

c. Squid 

d. Utilitas 

4. Pada tahun berapa sistem operasi Unix di kembangkan...... 

a. 1991 

b. 1984 

c. 2000 dan 2003 

d. 1960 dan 1970-an 

e. 2000 

 

5. Pada tahun 1960 AT&T Bell Labs, Massachusetts  Institute  of  

Technology, General Electric yang bekerja dalam sebuah sistem operasi 

eksprimental yang disebut.......... 

a. Multics (Multiplexed Information and Computing Service). 

b. Universitas Helsinki Finlandia 

c. Digital Equipment corporation (DEC). 

d. Microsoft  

e. Linux 

 

f. Lembar Jawaban Test Formatif (LJ). 

 

1  A 
 

B 
 

C 
 

D 
 

E 
 

   

  
          

  
2  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
3  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
4  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
5  A 

 
B 

 
C 

 
D 

 
E 
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8. Kegiatan Belajar 8 :Tahapan Perancangan  dan 

Pengembangan  Jaringan 

 

a. Tujuan Pembelajaran 

Setelah mengikuti kegiatan belajar 8 ini siswa diharapkan dapat : 

1. Memahami  Tahapan Perancangan  dan Pengembangan  Jaringan 

2. JaringanMenganalisis Tahapan Perancangan  dan Pengembangan  

Jaringan 

 

b. Uraian Materi 

1. Tahapan Perancangan  dan Pengembangan  Jaringan 

Ada banyak cara dan perencanaan pembangunan sebuah jaringan komputer. 

Tergantung bagaimana jaringan komputer itu dibangun disesuaikan dengan 

kebutuhan dan lingkungan kerja.Dalam operasi jaringan lokal, sebenarnya 

tidak membutuhkan perancangan yang komplek, karena pada dasarnya setiap 

kelompok jaringan memiliki sepesifikasi sendiri.Meskipun demikian, masih 

dibutuhkan satu router yang berfungsi untuk menghubungkan antar-

workgroup. 

 

Router tersebut bisa berupa software maupun router hardware. Router 

software ada free atau open sources ada juga yang berbayar. Untuk yang 

berbayar dan yang beredar di pasaran antara lain Winroute. 

 

Router tadi bertugas sebagai penghubung antara satu kelompok jaringan 

dengan kelompok jaringan yang lain atau sebagai penghubung antara 

jaringan lokal dengan internet. 

Dalam sistem operasi jaringan routing sederhana bisa dilakukan tanpa 

software tambahan.System Operasi Linux atau Windows 2000/XP bisa 

melakukan routing antar kelas IP dan bahkan bisa berfungsi sebagai router 

penghubung antara jaringan lokal dengan internet. 

Tahapan perencanaan yang harus dilakukan antara lain: 
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1. Perkiraan Jumlah PC 

Perkiraan jumlah masksimum PC dalam satu kelompok kerja harus dilakukan 

dengan tepat, karena akan menentukan kelas IP  dan rencana jangka panjang 

pengembangan jaringan komputer. 

2. Menentukan Kelas IP 

Kelas IP dapat ditentukan berdasarkan jumlah maksimum PC dalam satu 

kelompok kerja, jika jumlah maksimum PC lebih dari 254 maka harus 

dipertimbankan menggunakan IP kelas B , supaya tidak terjadi perubahan 

konfigurasi pada saat jumlah PC sudah sangat banyak dan kompleks.  

3. Menentukan Range Nomor IP 

Jika kita merencanakan jumlah kelompok kerja lebih dari satu maka penentuan 

range nomor IP perlu dipertimbangkan. Namun penentuan range IP dilakukan 

berdasarkan perkiraan jumlah PC. 

4. Pemberian Nama Kelompok Kerja. 

Alasan utama pemberian nama kelompok kerja dalam satu jaringan adalah untuk 

kemudahan mencari bagian dari kelompok kerja yang dibutuhkan. 

Sebaiknya pemberian nama kelompok kerja disesuaikan menurut fungsi dari 

suatu bagian tertentu, misalnya untuk bagian Akademik Kampus UNIGHA, dalam 

hal ini, kita bisa memberi nama kelompok kerja tersebut dengan nama 

AKADEMIK-UNIGHA. 

5. PC Router 

Tugas Router pada jaringan kecil dan menengah bisa dilakukan oleh PC yang 

dilengkapi Sistem Operasi jaringan baik Linux maupun MS Windows NT atau 

2000.Dengan langkah-langkah sederhana maka PC tersebut sudah berfungsi 

sebagai Router. 

Untuk satu kelompok kerja jaringan diperlukan satu PC yang berfungsi sebagai 

Router.PC tersebut tidak harus PC dengan spesifikasi tinggi karena dengan 

basis Sistem Operasi Linux kita bisa memanfaatkan PC sekelas 80486 sebagai 

PC Router beberapa kelompok kerja jaringan. 

 

pembagian kelas IP 
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Konfigurasi Internet Sharing dengan WinRoute 

I.Pendahuluan 

WinRoute yang diproduksi oleh Kerio Technology menyediakan banyak fasilitas 

untuk mengelola jaringan.Internet sharing merupakan fasilitas yang paling sering 

digunakan di WinRoute. Fasilitas lain yang disediakan oleh WinRoute adalah : 

• Firewall dengan metode Packet Filter  

• Network Address Translation (NAT) 

• DHCP Server 

• Mail Server 

• DNS Forwarder 

Metode internet sharing di WinRoute menggunakan 2 cara : 

Network Address Translation:WinRoute bertindak sebagai router yang 

menterjemahkan source IP Address (IP Lokal) menjadi IP Address yang berada 

dalam 1 subnet dengan network tujuan. 

Proxy Server : Adalah metode Web Caching yang berjalan di atas service NAT. 

Dalam teknik ini WinRoute menyimpan temporary website yang pernah 

dikunjungi user di cache-nya. Apabila terdapat user yang mengakses halaman 

tertentu, WinRoute akan mencari halaman tersebut di cache. Bila tidak 

ditemukan maka diakses alamat tersebut yang terdapat di internet.Teknik ini 

sangat berguna untuk menghemat bandwith dan meningkatkan kecepatan 

koneksi internet di LAN, karena tidak semua permintaan akses diteruskan ke 

internet.Kelebihan teknik proxy server adalah kemampuan mengontrol akses 

yang dilakukan user.Administrator dapat menutup atau membatasi situs tertentu 

yang dianggap berdampak negatif. Untuk mencegah user mengakses internet 

dengan metode NAT, perlu dikonfigurasi packet filter sehingga akses internet 

hanya dapat dilakukan melalui proxy. 

II. Persiapan Instalasi 

 Download versi trial WinRoute di 

http://www.kerio.com/wrp_download.html. Versi trial tersebut dapat 

berjalan dengan fasiitas penuh 
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 Instal modem dan dialup networking, dan pastikan anda sudah dapat 

mengakses interet dengan komputer yang akan digunakan sebagai server 

WinRoute . Cara instalasi modem dan dialup networking ke internet tidak 

dibahas dalam artikel ini. Untuk keperluan ini penulis menggunakan 

contoh koneksi dialup TelkomNet Instan 

 Spesifikasi komputer untuk server WinRoute minimal adalah sebagai 

berikut : 

 CPU Pentium 200 

 RAM 32 MB 

 Space HDD 10 MB 

 Network Card 10/100 MBps 

 

Instalasi WinRoute sangat mudah dilakukan, anda tinggal mengklik ganda file 

hasil download dan mengikuti instruksinya. 

 

III. Konfigurasi Jaringan Lokal 

Sebelum mengkonfigurasi WinRoute anda harus memastikan jaringan lokal 

(LAN) telah dikonfigurasi dengan benar dan berfungsi baik. Dalam tulisan ini 

diberikan contoh jaringan klas C dengan IP Address 192.168.0.x dan subnet 

mask 255.255.255.0. Komputer WinRoute 

dikonfigurasi dengan IP 192.168.0.1.Berikut adalah beberapa pedoman 

konfigurasi jaringan lokal. 

Jaringan dengan IP Statis 

Apabila anda mengkonfigurasi LAN dengan IP Address manual / statis maka 

pada tiap komputer klien harus dikonfigurasi sebagai berikut : 

IP Address : 192.168.0.x 

Subnet Mask : 255.255.255.0 

Default Gateway : IP komputer WinRoute ; 192.168.0.1 

DNS Server : IP komputer WinRoute ; 192.168.0.1 

Bila anda sudah memiliki DNS Server di jaringan lokal maka dapat digunakan 

DNS Server yang sudah ada, dan fasilitas DNS Forwarder di WinRoute harus 
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dimatikan (Settings > DNS Forwarder) Selain itu fasilitas DHCP Server di 

WinRoute juga harus dimatikan agar tidak konflik dengan konfigurasi IP Statis di 

klien (Settings > DHCP Server). 

Jaringan dengan DHCP 

Untuk mempermudah alokasi dan konfigurasi IP Address di klien anda dapat 

menggunakan fasiltas DHCP.WinRoute memiliki fasilitas DHCP yang dapat 

digunakan untuk mengalokasikan IP Address di jaringan. Pilihan lain adalah 

menggunakan DHCP yang telah tersedia di Windows 

NT/2000 Server dan mematikan DHCP Server di WinRoute. 

 Menggunakan DHCP Non WinRoute 

Apabila anda tidak menggunakan DHCP Server yang terdapat di 

WinRoute, maka lakukan konfigurasi berikut di DHCP Server jaringan 

lokal : 

 Pastikan IP Komputer WinRoute (192.168.0.1) belum digunakan 

oleh komputer lain di jaringan. Masukkan IP tersebut di daftar 

exclusion agar tidak dipakai oleh komputer lain di jaringan. 

 Masukkan IP komputer WinRoute : 192.168.0.1 sebagai default 

gateway di DHCP Option. 

 Untuk option DNS Server, arahkan ke IP WinRoute apabila anda 

ingin menggunakan DNS forwarder WinRoute. Jika tidak, 

masukkan IP DNS Server jaringan anda di DHCP Option dan 

matikan DNS Forwarder WinRoute. 

 Menggunakan DHCP dan DNS WinRoute 

Cara termudah dan sederhana adalah dengan menggunakan DHCP dan 

DNS Forwarder yang disediakan WinRoute. Untuk menggunakan teknik 

ini anda harus mematikan fungsi DHCP yang terdapat di jaringan lokal 

dan mengaktifkan DHCP WinRoute. Klik Settings > DHCP Server untuk 

menampilkan konfigurasi DHCP, lalu aktifkan ceklis DHCP Server 

enabled. Selanjutnya klik New Scope untuk menentukan alokasi IP 

Address di jaringan lokal. Masukkan range IP dari 192.168.0.2 s/d 

192.168.0.50. Alokasi IP tersebut dapat disesuaikan dengan jumlah 

komputer di jaringan anda. Alamat 192.168.0.1 telah digunakan untuk 
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WinRoute, sehingga tidak dimasukkan di DHCP. Untuk menentukan 

option klik Default Gateway dan masukkan IP komputer WinRoute 

192.168.0.1. Sedangkan untuk DNS Server masukkan pula 192.168.0.1 di 

bagian specify value. Dengan konfigurasi DHCP tersebut IP komputer 

klien akan disetting otomatis oleh WinRoute sesuai konfigurasi yang telah 

diisikan. 

Langkah berikutnya adalah konfigurasi DNS Forwarder di menu Settings > DNS 

Forwarder.Anda dapat menggunakan DNS Server yang terdapat di internet atau 

menggunakan DNS Server yang terdapat di jaringan lokal. Isikan konfigurasi 

DNS  

Forwarder seperti berikut : 

DNS Server diarahkan ke 202.135.0.155 yang merupakan server DNS milik 

TelkomNet. Anda dapat menyesuaikannya dengan server milik ISP yang anda 

gunakan atau server lain yang telah ditentukan. 

Langkah terakhir adalah konfigurasi IP komputer klien, sehingga dapat 

mengambil alamat IP secara otomatis dari WinRoute. Perlu diingat apabila 

terdapat DHCP Server lain di jaringan lokal, anda harus mematikannya sehingga 

tidak konflik dengan DHCP Server WinRoute. Konfigurasi IP Address klien 

adalah seperti berikut : 

IP Address komputer WinRoute dikonfigurasi dengan data-data sebagai berikut : 

Komputer WinRoute harus menggunakan IP statis karena bertindak sebagi 

gateway jaringan lokal ke internet. Untuk pengisian DNS Server digunakan DNS 

TelkomNet, anda dapat menyesuaikannya dengan DNS milik ISP yang anda 

gunakan.Setelah konfigurasi jaringan selesai anda harus menguji konfigurasi 

tersebut dengan utility ping dari command prompt. Lakukan ping dari komputer 

WinRoute ke klien dan sebaliknya. Apabila konfigurasi sudah benar maka akan 

terlihat jawaban reply dari host yang dituju. Contoh berikut adalah ping dari 

komputer klien ke komputer WinRoute dengan nomor IP 192.168.0.1. 

IV. Konfigurasi Dialup dan Proxy Server WinRoute 

Setelah konfigurasi jaringan berhasil baik langkah berikutnya adalah setting 

WinRoute agar dapat bertindak sebagai gateway dan Proxy Server. Sebelumnya 

anda sudah harus memasang modem dan dialup ke ISP, dan harus sudah 
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berfungsi baik. Buka menu Settings > Interface table, dimana ditampilkan dua 

interface masing-masing Network Card untuk jaringan lokal dan interface dialup 

ke TelkomNet. Buka property RAS dan pastikan NAT diaktifkan untuk interface 

ke internet. Untuk setting dialup WinRoute, klik tab RAS dan isikan data koneksi 

ke ISP TelkomNet. Tutup konfigurasi RAS dan kembali ke menu Interface Table, 

buka property untuk interface Ethernet – NDIS Driver yang merupakan koneksi 

ke LAN. Pastikan NAT untuk interface tersebut tidak diaktifkan. Tujuan 

konfigurasi NAT tersebut adalah agar WinRoute melakukan NAT pada internet 

interface, sehingga trafik yang melewati interface tersebut dapat diterjemahkan 

sesuai alamat tujuan.Dengan demikian IP jaringan lokal dapat terhubung dengan 

internet. 

Untuk mengaktifkan fasilitas Proxy Server buka menu Settings > Proxy Server 

dan aktifkan Proxy Server Enabled.Proxy WinRoute berjalan di port 3128, 

sehingga setting browser di klien juga harus disesuaikan. Anda dapat mengatur 

halaman-halaman yang tidak boleh diakses di tab Access menu Proxy Server 

Setttings tersebut. Sedangkan untuk mengatur lamanya sebuah halaman 

disimpan di cache WinRoute bukalah menu Time to Live dan isikan lamanya 

penyimpanan temporary site. Sampai di sini WinRoute sudah siap untuk 

digunakan sebagai server internet sharing. 

 

V. Konfigurasi Browser 

Browser yang digunakan di klien harus diarahkan ke Proxy Server WinRoute 

sehingga dapat mengakses internet lewat WinRoute.Bagi anda yang 

menggunakan Internet Explorer, buka menu Tools > Internet Options. Klik tab 

Connections, lalu klik tombol LAN Settings. Masukkan konfigurasi berikut : 

Setelah browser selesai disetting, hubungkan komputer WinRoute ke internet 

dan cobalah melakukan browsing dari klien. 

 

2. Membangun Jaringan Lokal  

Tutorial Cara Membuat Jaringan Komputer LAN secara sederhana dan mudah 

dipahami. Bisa dijadikan sebagai referensi untuk para pelajar yang akan 

mengikuti uji komptensi jaringan komputer. LAN dapat definisikan sebagai 
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network atau jaringan sejumlah sistem komputer yang lokasinya terbatas 

didalam satu gedung, satu kompleks gedung atau suatu kampus dan tidak 

menggunakan media fasilitas komunikasi umum seperti telepon, melainkan 

pemilik dan pengelola media komunikasinya adalah pemilik LAN itu sendiri. 

 

Kesimpulan dari definisi di atas adalah bahwa LAN adalah jaringan dari 

sejumlah komputer yang dapat saling berhubungna namun dibatasi oleh 

lokasi jarak terterntu. Kalau masalah fungsi sudah pasti, jarigan LAN berfungsi 

agar komputer dapat terhubung antara satu komputer dengan komputer yang 

lain sehingga bisa bertukar data dan berbagi pakai perangkat keras yang lain. 

Untuk membuat sebuah jaringan LAN ada material yang kita butuhkan. 

Berikut Peralatan atau material yang dibutuhkan untuk membuat sebuah 

jaringan komputer LAN:  

 

1. Dua atau lebih PC  

2. Network Card sesuai dg jumlah PC  

3. Kabel coaxial atau UTP  

4.Hub bila diperlukan  

5.Terminator  

6. T-Connector  

 

Langkah-langkah Membuat Jaringan Komputer LAN:  

 Sebelumnya anda harus mengetahui dahulu tipe jaringan yang ingin anda 

gunakan.untuk mengetahui tipe-tipe jaringan komputer silakan anda buka 

artike saya terdahulu Mengenal Macam-Macam Topologi Jaringan.  

 Pasanglah kabel dan network card. Pemasangan kabel disesuaikan 

dengan topologi/tipe jaringan yang anda pilih sedangkan pemilihan 

network card disesuaikan dengan slot yang ada pada motherboard anda. 

Bila board anda punya slot PCI maka itu lebih baik karena LAN card 

berbasis PCI bus lebih cepat dalam transfer data.  

 Bila anda menggunakan tipe bus maka pada masing-masing komputer 

harus anda pasang T-Connector yang memiliki dua input. Dan pada 
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komputer yang hanya mendapat 1 input pada input kedua harus dipasang 

terminator kecuali bila anda membuat jaringan berbentuk circle(lingkaran) 

dimana semua komputer mendapat 2 input. Misalnya 

komp1,komp2,komp3 berjajar maka t-conncector pada komp1 dipasang 

terminator dan kabel ke komp2. Pada komp2 dipasang kabel dr komp1 

dan kabel ke komp3. Sedangkan komp3 dipasang kabel dr komp2 dan 

terminator.  

 Bila anda memilih tipe star maka masing-masing kabel dari komputer 

dimasukkan ke dalam port yang tersedia di hub. Dan bila anda ingin 

menghubungkan hub ini ke hub lainnya anda gunakan kabel UTP yang 

dimasukkan ke port khusus yang ada pada masing-masing hub.  

Langkah selanjutnya dadalah sebagai berikut :  

Pilih Sistem Operasi yang sesuai, Mis : Windows atau Linux Persiapkan 

Komputer Server yang memadai, sesuai dengan jumlah klien. Pilih Jenis 

Jaringan, Mis: Jaringan Kabel atau Wireless.  

 

Alat – Alat yang dibutuhkan dalam membuat jaringan LAN :  

1. PC Server  

2. OS (Operating System)  

3. Lan Card (untuk jaringan kabel) atau Card WLAN (U/ Wireless)  

4.Kabel UTP Cat 5 (u/ jaringan Kabel)  

5.Access Point (U/ Jaringan Wireless)  

6.Switch atau Hub (u/ Jaringan Kabel)  

7.RJ 45 (u/ jaringan kabel)  

8.Pemotong kabel / Crimping Tool (u/ jaringan Kabel)  

9.Tester kabel (u/ Jaringan Kabel)  

 

Langkah terakhir adalah setting control panel network conection  

1.      Setting network connection di controlpanel>networkConection  

2.      Klik kanan local Area Conection pilih properties  

3.      Pilih TAB General pilih internet protocol (TCP/IP) pilih prporties  

4.      Pilih use the following Ip adress  

5.      Masukan IPadress : 192.168.0.1 subnet mask : 255.255.255.0  
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6.      pilih OK  

7.      Klik kanan mycomputer pilih properties  

8.      pilih TAB ‗Computer Name‘ pilih tombol ‗change‘  

9.      di member of pilih ‗workgorup‘isi apasaja misal ‗Beres‘  

10.  Isi ‗Computer Name‘ apasaja misal ‗User 1′  

11.  Pilih ‗OK‘ atomatis windows merestart  

12.  Lakukan hal demikian di komputer lain dengan syarat ‗Computer Name‘ 

harus berbeda dan Ip address harus berbeda yang lainya harus sama, misal 

dikomputer lain ‗computer name‘ di isi ‗user 2′ dan ip addressnya : 198.168.0.2 

untuk ip adress yang harus berbeda cuma digit terakhir yang lainya harus sama. 

Digit terakhir pada nomor IP address yaitu nomor untuk mengidentifikasi alama 

sebuah komputer.ata 

 

catatan: konfigurasi di atas belum bisa untuk online, hanya bisa komunikasi antar 

PC yang terhubung, selanjutnya akan dibahas bagaimana komputer2 dalam 

jaringan LAN dapat terhubung ke internet 

 

3 .Membangun Server Berbagi Data 

1). Cara Berbagi File Antara Dua Komputer 

Semakin banyak rumah tangga yang sekarang memiliki lebih dari satu komputer. 

Sering kali ini berarti melompat dari satu mesin ke mesin lain untuk menemukan 

dokumen atau file yang Anda butuhkan. Kecuali, entu saja, Anda berbagi file 

antara komputer menggunakan network rumah. Proses ini bahkan menjadi lebih 

mudah dengan Windows 7*, yang dilengkapi dengan fitur Homegroup. 

Membentuk Homegroup 

Untuk mulai berbagi file antara komputer, Anda akan perlu membuat sebuah 

homegroup, yang sebenarnya merupakan kumpulan komputer yang dapat 

berbagi file. 

 Akses Control Panel dari Menu Start 

 Pastikan opsi ditampilkan sesuai dengan kategori di kanan atas layar. 
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 Cari kategori "Network and Internet". Klik link "Choose homegroup and 

sharing options‖. 

Ini adalah tempat Anda bisa membuat homegroup untuk berbagi file antara 

komputer atau mengakses homegroup yang ada untuk digunakan pada mesin 

lain. 

 Jika "There is currently no homegroup on the network": Klik link di bagian 

bawah layar yang menyebutkan"Create a Homegroup". 

 Jika "This computer belongs to a homegroup": Klik link untuk "View or 

print the homegroup password‖. 

Pada titik ini, Anda akan dapat memutuskan apa jenis file yang ingin berbagi 

antara dua komputer. Opsinya adalah gambar, dokumen, musik, printer, serta 

video, dan Anda dapat memilih untuk berbagi kombinasi apa pun dari jenis file 

tersebut. Setelah Anda membuat pilihan itu, Windows 7 akan memberikan 

password alfanumerik yang harus Anda simpan di tempat aman. Anda akan 

membutuhkan password ini untuk mengatur homegroup di komputer lain di 

rumah Anda. 

Mengakses Komputer Windows 7* Lain di Homegroup 

Semua yang tersisa untuk dilakukan sebelum Anda dapat berbagi file antara 

komputer adalah mengakses homegroup tersebut dari komputer lain. Untuk 

melakukan ini di Windows 7, Anda akan perlu menghidupkan mesin, klik pada 

menu start, dan akses panel kontrol seperti sebelumnya. Temukan link untuk 

"Choose homegroup and sharing options" di bawah kategori "Network and 

Internet". 

Alih-alih membuat homegroup baru, Anda akan melihat kotak peringatan yang 

memberi tahu bahwa sebuahhomegroup telah terdeteksi pada network Anda. Klik 

tombol "Join Now". Anda akan memasukkan password yang Anda simpan dari 

komputer lain dan pilih jenis file seperti sebelumnya. 

Tunggu beberapa saat sementara sambungan dibuat, setelah itu Anda siap 

untuk berbagi file antara komputer. 
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Mengakses File Bersama 

Jika Anda ingin meminimalkan klik yang diperlukan untuk mengakses berbagi file 

antara komputer, Anda dapat membuat shortcut pada desktop Anda.Cara 

termudah melakukannya adalah dengan membuat shortcut pada desktop Anda. 

 Klik menu start, lalu tombol "Computer" di bagian sebelah kanan menu. 

 Klik dobel hard disk drive (biasanya "C"). 

 Klik dobel folder "Pengguna" pada layar berikutnya. 

 Klik kanan folder "Public" dan klik "Create shortcut". 

 Ubah nama short cut folder menjadi apa pun yang Anda suka, lalu drag 

ke desktop. 

Sekarang Anda telah siap mentransfer file antara komputer, berbagi dokumen, 

stream musik, berbagi printer, dan hal lain yang ingin Anda masukkan pada 

Homegroup. 

4. Cara Mudah Membuat Printer Jaringan Pada Windows 

Kemudahan berbagi printer 

Salah satu keuntungan mempunyai suatu jaringan komputer dirumah atau 

dikantoran kecil adalah kemudahan untuk berbagi resources seperti berbagi 

printer jaringan agar bisa diakses oleh semua user yang ada pada jaringan. 

Dua metoda 

Ada dua cara untuk bisa berbagi printer pada jaringan: 

 Dengan komputer – koneksikan sebuah printer USB kepada salah satu 

port USB pada komputer dan lakukan konfigurasi untuk bisa di sharing 

 Gunakan piranti print-server baik wired maupun wireless print-server 

Perhatikan gambar dibawah ini, sebuah jaringan komputer sederhana yang terdiri 

dari sebuah switch, dan beberapa komputer.Sebuah printer USB dihubungkan 

kepada sebuah desktop PC dengan OS Windows XP Pro atau Windows 7 

(kecuali Windows 7 starter). 
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Setting jaringan printer pada Windows XP 

Secara tradisional, yang paling umum untuk melakukan sharing printer adalah 

dengan menggunakan salah satu komputer pada jaringan dan menghubungkan 

sebuah printer USB ke salah satu port USB komputer dan melakukan konfigurasi 

Windows agar bisa di sharing dengan users lainnya pada jaringan. Kerugian dari 

cara ini adalah bahwa komputer harus selalu ON agar printer jaringan bisa 

diakses kapanpun. Jika tidak, maka printer tidak akan bisa diakses. 

Dalam Windows XP, komponen File and Printer sharing sudah terinstall dan 

default nya adalah enable. 

Bagaimana melakukannya? Berikut adalah step-step nya: 

 Buka Printers and Faxes. Klik Start, Klik Control Panel, Klik Printers and 

Other Hardware, dan kemudian klik Printers and Faxes. 

 Klik kanan printer yang mau di sharing, dan kemudian Sharing. 

  

Pilih Share this printer dan beri nama 
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Pada tab Sharing, klik Share this printer dan ketik nama sharing yang mudah 

diingat untuk printer ini. Jika nantinya harus dilepas shairngnya, maka tinggal klik 

Do not share this printer 

Jika printer ini akan di share dengan komputer dengan OS lain maka 

klik Additional Drivers. Klik Environment dan OS computer lain kemudian klik OK. 

Klik Ok untuk menyelesaikan proses ini. 

 Setting Shared Printer Windows 7 

Setting untuk Windows 7 berikut tidak berlaku untuk windows 7 starter.Starter kit 

hanya bisa bergabung kepada jaringan local yang ada termasuk akses printer 

jaringan. 

Pertama kali harus membuka akses file and printer sharing. 

 Klik Start, kemudian control panel, Cari Network and Sharing center, 

kemudian klik Change advanced sharingsettings dan kembangkan 

tampilan network profile 

 Jika printer sharing off, pada File and printer sharing pilih Turn on file and 

printer sharing dan klik Save changes. Jika diminta administrator 

password maka masukkan password dan confirmasikan 

Langkah selanjutnya adalah melakukan sharing printernya sendiri. 

Lakukan langkah berikut untuk sharing printer pada Windows 7. 

 Buka Devices and Printers dengan meng-klik Start, dan pada start menu 

klik Devices and printers. 

 Pilih printer yang ada dan klik kanan dan pilih Printer properties 

 Klik tab Sharing dan pilih Share this printer 

 Selesai 

Koneksi User ke Printer Jaringan 

Setelah selesai konfigurasi sharing printer, maka semua user yang ada pada 

jaringan bisa melakukan koneksi ke printer dan menggunakan nya untuk 

mencetak ke printer lewat jaringan. 
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Untuk Windows 7 starter, bisa mengakses printer yang ada pada jaringan 

dengan langkah sederhana. 

 Buka explorer dan arahkan ke paling bawah explorer dan klik Netwrok. 

Jika pada jaringan ada beberapa resources yang di share, maka akan 

kelihatan disini. Dari printer yang di share pada jaringan pada langkah-

langkah diatas, maka terlihat ada sebuah printer Epson. 

 Klik kanan printer Epson tersebut dan pilih Connect. 

 

Printer jaringan pada windows 7 

Lihat di Devices and printer maka akan muncul printer seperti terlihat pada 

gambar berikut ini 
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Dengan tersedianya printer jaringan ini dan setting dari printer adalah printer 

default, maka user tinggal mengirim dokumen ke printer untuk dicetak. 

 

c. Rangkuman. 

Perencanaan pembangunan sebuah jaringan komputer. Tergantung 

bagaimana jaringan komputer itu dibangun disesuaikan dengan kebutuhan 

dan lingkungan kerja.Dalam operasi jaringan lokal, sebenarnya tidak 

membutuhkan perancangan yang komplek, karena pada dasarnya setiap 

kelompok jaringan memiliki sepesifikasi sendiri.Meskipun demikian, masih 

dibutuhkan satu router yang berfungsi untuk menghubungkan antar 

workgroup. Router bisa berupa software maupun router hardware. Router 

software ada free atau open sources ada juga yang berbayar. Untuk yang 

berbayar dan yang beredar di pasaran antara lain Winroute. 

 

d. Tugas : Membuat Ringkasan Materi  Protokol Pengalamatan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi pembagian 

jaringan komputer berdasarkan luas areanya yaitu Protokol 

Pengalamatan.Masing-masing kelompok mebuat ringkasan pembagian 

jaringan komputer berdasarkan Protokol Pengalamatan. Kemudian secara 

bergantian masing-masing kelompok mempresentasikan hasilnya didepan 

kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Protokol Pengalamatan menggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) katagori 

Protokol Pengalamatan,2) fungsi Protokol Pengalamatan,3) 

implementasi Protokol Pengalamatan  

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. Alat yang digunakan untuk menguji Jaringan adalah : 

a. Tang Crimping    
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b. Tespen 

c. Multimeter     

d. Obeng 

e. LAN Tester 

2.  Tujuan dibentuknya workgroup 

a.     Mempermudah pengalamatan IP 

b.     Mempermudah transfer data 

c.     Mempermudah sharing data 

d.     Mempermudah koneksi internet 

e.      Mempermudah pengelolaan jaringan 

      3. 192.168.0.10 merupakan contoh pemberian alamat pada sebuah 

komputer yang akan dihubungkan dalam sebuah jaringan. Angka-angka 

tersebut dikenal dengan : 

    a. Protokol      

    b. IP Address       

    c. Konfigurasi      

    d. Domain      

    e. TCP/IP     

     4. Untuk mendeteksi apakah hubungan komputer dengan jaringan sudah 

berjalan dengan baik, utilitas yang digunakan adalah..... 

    a. Route      

    b. Tracert      

    c. ping       

    d. tail      

    e. route - pr     

     5.  Sedangkan Subnet Mask 255.255.255.246 termasuk dalam kelas? 

    a. A      

    b. B      

    c. C      

    d. D       

    e. E     
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f. Lembar Jawaban Test Formatif (LJ). 

 

1  A 
 

B 
 

C 
 

D 
 

E 
 

   

  
          

  
2  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
3  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
4  A 

 
B 

 
C 

 
D 

 
E 

 

  

  
          

  
5  A 

 
B 

 
C 

 
D 

 
E 
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9. Kegiatan Belajar 9 : Aplikasi Ubuntu 

 

a. Tujuan Pembelajaran 

Setelah selesai pemelajaran ini, peserta pelatihan dapat: 

1. Menjelaskan cara menginstal software aplikasi Ubuntu 

2. Menjelaskan  cara mengedit standar Ubuntu 

 

b. Uraian Materi 

Aplikasi Ubuntu 

 

A. Nautilus – File Manager Ubuntu 

Ringan dan Ringkas! Itulah fitur yang diusung oleh Nautilus yang sudah lama 

menemani Desktop Gnome sebagai file manager. Fitur–fitur yang dimilikinya 

memiliki kelebihan dibandingkan dengan file manager di beberapa sistem operasi 

lainnya. 

1. Mengaktifkan Nautilus 

Ada dua cara untuk mengaktifkan nautilus, yaitu : 

1) Klik menu Places dan pilih salah satu item yang ada di sana. 

2) Tekan ALT+F2 dan ketikkan nautilus kemudian tekan Enter. 

Window Nautilus akan tampak seperti berikut ini (gambar N.1). 
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Keterangan : 

1. Menubar 

2. Toolbar 

3. Pengatur Tampilan Panel kiri 

4. Address bar (alamat folder dalam komputer) 

5. Panel Folder Utama (drive, home, desktop, dll) 

6. Panel bookmark (mempercepat akses ke folder favorit) 

7. Daftar File atau Folder 

8. Status bar (informasi isi folder dan ruang kosong harddisk) 

Perhatikan tata letak item-item di atas karena akan bermanfaat untuk memahami 

penjelasan selanjutnya1 

2 

2. Optimalkan Setting Nautilus 

Secara standar nautilus telah terseting sesuai dengan kemudahan pengguna, 

ada aiknya beberapa pengaturan tambahan perlu dilakukan untuk lebih  

memudahkan pengguna. Pengaturan ini bersifat relatif (tidak mesti harus 

dilakukan). Untuk melakukan perubahan pengaturan klik menu Edit → 

Preferences. 

Dua bagian yang bisa dioptimalkan adalah tab behavior dan tab media, 

perhatikan gambar N.2 dan gambar N.3 dibawah ini. 

 

Tab Behavior 

Gambar N.2 
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Tab Media 

Gambar N.3 

 

Lakukan setting seperti gambar di atas, sehingga file autorun tidak langsung  

aktif dan media yang disisipkan pada komputer (USB Flash Disk) tidak akan 

dibrowse otomatis. 

3. Operasi File atau Folder 

1) Menyalin Data (Copy) 

Klik kanan pada file atau folder yang bersangkutan dan pilih Copy atau tekan 

tombol CTRL+C. Untuk menempelkan data yang telah disalin tadi kemudian 

ke folder tujuan lalu klik kanan pada panel file (sebelah kanan) dan pilih Paste 

atau tekan tombol CTRL+V. 

Ketika proses menyalin data berlangsung maka akan muncul window 

progress yang diperlihatkan gambar N.4 seperti dibawah ini. 

 

2) Memindah Data (move) 

Klik kanan pada file atau folder yang bersangkutan dan pilih Cut atau 

tekan tombol CTRL+X, untuk menempelkan klik kanan pada area kosong di 

panel file dan pilih Paste atau tekan tombol CTRL+V. 

3) Menghapus Data (Delete) 

Menghapus data ada dua jenis : 

 Memindahkan ke Tong Sampah atau Wastebasket (file yang terhapus  

bisa dikembalikan) Klik file atau folder yang bersangkutan dan klik kanan 

pilih Move to Trash atau tekan tombol Del pada Keyboard. 
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 Menghapus secara permanen (file terhapus tidak bisa dikembalikan lagi). 

Klik file atau folder yang bersangkutan dan klik kanan pilih Delete atau 

tekan tombol SHIFT+DEL. 

4) Mengembalikan data yang terhapus dari Tong Sampah 

Klik icon Trash pada panel kiri (gambar N.5). 

 

Jika Anda ingin mengembalikan file yang telah terhapus, klik kanan pada file 

yang bersangkutan dan pilih Restore, dan jika ingin menghapus permanen pilih 

Delete Permanently. Untuk mengosongkan isi Tong Sampah, klik tombol Empty 

Trash pada pojok kanan atas. 

 

5) Mengganti Nama File atau Folder  

Klik file atau folder yang bersangkutan dan klik kanan pilih Rename atau tekan 

tombol F2 setelah file atau folder tersorot. Tekan Enter jika sudah selesai 

mengganti nama file. 

 

6) Menampilkan File atau folder tersembunyi 

Pada sistem operasi GNU/Linux, file atau folder hidden ditandai dengan nama file 

yang ada ―titik‖ di depannya (misal : .config). Untuk memunculkan file hidden klik 

menu View → Show hidden Files atau tekan tombol CTRL+H. Untuk 

menyembunyikan lagi lakukan hal yang sama. Gambar N.6 merupakan contoh 

folder home dengan menampilkan file dan folder yang hidden. 
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7) Mencari File atau Folder 

Sebelum melakukan pencarian file atau folder, Anda harus masuk ke folder di 

mana kira-kira berkas yang Anda simpan. Setelah itu klik toolbar pencarian file 

(lihat gambar N.7). Selanjutnya ketik nama berkas yang ingin Anda cari pada 

teks Search dan tekan Enter untuk memulai proses pencarian. Beberapa file 

ditemukan dengan kata kunci pencarian ―ubuntu‖ (lihat gambar N.7 di bawah) 
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8) Filter Nama file atau folder 

File dan folder yang banyak kadang membuat kesulitan saat pencaharian. 

Agar cepat menemukan, cara yang efisien adalah dengan mem-filter nama 

item yang dicari.  aranya klik pada area kosong di Daftar file atau folder (panel 

kanan) dan mulailah mengetikkan nama item yang dicari (tulisan yang Anda 

ketik akan tampil pada panel kanan bawah), jika ada maka item akan diseleksi 

oleh nautilus, pada contoh ini penulis ingin menemukan folder Public pada 

direktori Home saya (lihat gambar N.8). 

 

9) Kompres/Ekstrak File atau Folder 

Untuk mengecilkan ukuran file yang ingin distribusikan, ada baiknya file 

tersebut  dikompres dalam format tertentu. Ubuntu memiliki utility kompres file 

yang sudah terintegrasi. Anda tinggal klik kanan file atau folder yang 

bersangkutan dan pilih Compress... kemudian klik Create untuk memulai 

pembuatan file arsip. Sebaliknya untuk mengekstrak file arsip Anda klik kanan 

dan pilih menu Ekstract Here. 

Catatan: 

File .rar dan .7z tidak didukung secara standar oleh nautilus. Anda perlu 

menginstall aplikasi 7zip (FREE) untuk bisa mengakses file arsip tipe ini dan 

beberapa tipe arsip komersial lainnya. 
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4. Removeable Media di Ubuntu 

Removeable media di Ubuntu berupa: 

a. CD/DVD ROM 

CD/DVD ROM akan di-mount otomatis oleh oleh nautilus, Anda bias 

menemukannya di panel kiri (panel folder utama). Untuk mengeluarkan 

CD/DVD dari Drive, klik kanan pada CD/DVD pilih Eject. 

b. Flashdisk/Harddisk Eksternal 

Flashdisk atau Harddisk juga akan Anda temukan di panel folder utama. 

Untuk melakukan remove yang aman, klik kanan Flashdisk dan pilih Safely 

Remove Drive. Jika sukses maka drive flashdisk Anda tidak akan muncul di 

panel lagi. 

5. Beberapa fitur-fitur menarik Nautilus 

1) File pdf, gambar, music ditampilkan otomatis. 

 

Untuk file music dapat didengarkan potongannya tanpa perlu membuka sebuah 

player khusus. Cukup sorot file music yang diinginkan maka Anda akan 

mendengarkan musik tersebut. 

2) Tab-tab pada daftar file. 

Tab-tab pada program mungkin sering Anda jumpai pada browser saat ini. 

Keunikan fitur ini juga sudah disisipkan pada nautilus. Untuk memanfaatkan fitur 

ini Anda bisa klik kanan pada folder (baik itu pada panel kiri maupun panel kanan 



 

J a r i n g a n  D a s a r  | 95 
 

Jaringan Dasar  

serta Address bar) dan pilih Open in New Tab, atau dengan cara klik folder yang 

ingin dibuka dan tekan tombol CTRL+T. Fitur ini untuk menghemat jumlah 

window yang terbuka pada desktop (gambar N.10). 

3) Bookmark Folder favorit sehingga cepat diakses. 

Di panel kiri terdapat fitur folder bookmark (lihat bagian Mengaktifkan Nautilus, 

gambar N.1). Untuk menambah daftar panel bookmark ada beberapa cara 

yang bisa Anda lakukan : 

• Klik folder yang bersangkutan lalu pilih menu Bookmark – Add Bookmark. 

• Klik folder yang bersangkutan lalu tekan tombol CTRL+D 

• Klik folder yang bersangkutan lalu drag ke panel bookmark. 

Untuk menghapusnya Anda bisa klik kanan pada panel bookmark dan pilih 

Remove (folder asli tidak ikut terhapus). Bisa juga ke menu Bookmark - Edit 

Bookmark. 

 

4) Mounting file arsip (.tar.gz, .iso, dll) sebagai drive. 

Tanpa perlu membuka file arsip dengan program arsip manager, Anda bias 

membuka file arsip Anda sebagai drive (gambar N.11). Klik kanan file yang 

bersangkutan dan pilih Open with Archive Mounter. 
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5) Script-script yang bermanfaat untuk nautilus. 

Untuk menambahkan script buat nautilus Anda perlu meng-install beberapa 

script (cara instalasi paket ini bisa Anda pelajari pada bagian instalasi 

software ubuntu) yang sering dipakai dalam sehari-hari, yaitu: 

• nautilus-open-terminal (untuk mempercepat akses ke terminal) 

• nautilus-image-converter (untuk merubah ukuran gambar dan orientasi 

gambar) 

• nautilus-wallpaper (untuk mengatur gambar menjadi wallpaper) 

6. Running Nautilus sebagai Root 

Pada paparan di atas, nautilus masih bekerja pada mode user biasa yang 

sering Anda pakai dalam kegiatan sehari-hari. Kadang kala perlu juga 

mengaktifkan nautilus pada mode Administrator atau lebih dikenal root untuk 

memberikan hak akses yang lebih pada file atau folder. Untuk melakukan hal 

tersebut tekan tombol ALT+F2 dan ketikkan gksudo nautilus kemudian tekan 

enter atau buka terminal ketik gksudo nautilus. Gunakan metode ini 
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seperlunya saja untuk menghindari kesalahan operasi dengan hak akses root 

di sistem Ubuntu Anda. 

B. Gedit, text editor standar Ubuntu 

Gedit adalah aplikasi default text-editor dari Ubuntu khususnya desktop 

gnome. Jika di windows anda mengenal notepad sebagai text-editor, maka di 

Ubuntu dikenal gedit. Sepintas hanya terlihat seperti text editor sederhana 

untuk editing dasar. Pada kenyataanya gedit lebih powerfull, selain sebagai 

peng-edit dokumen juga sebagai peng-edit source code bagi developers atau 

programmers karena menyediakan fitur-fitur serta plugins. Langsung saja, 

gedit bisa diakses dengan beberapa cara berikut. 

 

1. Yang pertama adalah melalui GUI (Graphical User Interface). Dari menu 

Application accessories → → gedit Text Editor. 

2. Cara yang kedua merupakan favorit kebanyakan linuxer, yakni melalui 

konsol 

terminal, terminal sendiri berada pada Application → Accessories → 

Terminal. 

Pada konsol terminal ketik dan masukkan password jika diminta seperti 

dibawah ini. 

hikari@Hikari:~$ sudo gedit 

[sudo] password for hikari: 

Cara di atas adalah menggunakan gedit dengan hak akses user biasa, jika 

ingin 

menggunakan gedit dengan hak akses root dapat dilakukan dengan cara di 

bawah ini. 

hikari@Hikari:~$ gksudo gedit 

[sudo] password for hikari: 

Dengan tampilan kurang lebih tampak digambar GD.1 
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Beberapa fitur berguna yang dimiliki gedit: 

- Dukungan penuh untuk teks yang ada didunia (UTF-8) 

- Sintaks highlighting yang bisa dikonfigurasi untuk berbagai macam bahasa 

seperti (C, C++, Java, HTML, XML, Python, Perl dan masih banyak lagi 

- Undo / Redo 

- Edit file secara remote 

- File reverting 

- Dukungan print dan print preview 

- Dukungan clipboard (cut/copy/paste) 

- Search dan replace 

- Menuju baris spesifik 

- Auto indentation 

- Teks rata (Align) 

- Penomoran baris 

- Highlinght ('sorot') baris saat ini 
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- Pencocokan tanda kurung 

- Backup file 

- Font dan warna yang bisa dikonfigurasi 

- User manual online yang lengkap 

Dengan fitur-fitur diatas gedit telah lebih dari sekedar text editor biasa (gambar 

GD.2). Namun, ada satu lagi letak kekuatan riil dari gedit yaitu Plugins. Gedit 

dilengkapi dengan plugins yang sangat membantu serta dapat ditambahkan 

sesuai kebutuhan dari end user. 

 

Untuk mengakses daftar dari plugins, pilih menu edit → preferences, dan pilih tab 

plugins. Anda bisa mengaktifkan atau men-disable serta konfigurasi plugins yang 

tersedia. Plugins gedit bisa ditambahkan dengan cara menginstall gedit-plugins, 

dengan menjalankan perintah di bawah ini melalui terminal. sudo apt-get install 

gedit-plugins 

Bagi Anda yang tidak memiliki akses internet, bisa mendownload plugins secara 

manual di gedit-plugins package (http://live.gnome.org/GeditPlugins). Di bawah 

ini ditunjukkan beberapa plugins yang umum digunakan dan memiliki 

fungsionalitas yang baik (gambar GD.3). 
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Penjelasan beberapa plugins diatas. 

1) Snippets 

Plugin ini dapat mempercepat kerja para programmer, snippets dapat 

memasukkan code yang sering digunakan pada gedit dengan cepat . Dengan 

menekan tombol <tab>pilihan snippets yang akan dimasukkan (tergantung text 

trigger yang diketikkan). Dalam plugin ini sudah tersedia snippets untuk beberapa 

bahasa pemrograman seperti css, javascript, html dan ruby. Anda juga dapat 

menambahkan sendiri snippets yang diinginkan, pilih menu Tools → Manage 

Snippets. 

 

2) File Browser 

Ini merupakan plugin yang sangat baik, dengan menampilkan sebuah file 

browser di sidebar sebelah kiri (gambar GD.2), tekan F9 untuk mengaktifkan. 
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Plugin ini hampir mirip file browser milik Dreamweaver atau Textmate. Plugin ini 

terkoneksi dengan nautilus (explorer gnome/ubuntu), artinya Anda bias 

menghubungkannya melalui FTP, SFTP, SSH, Windows Share dan lain-lain. 

Anda hanya perlu mengaktifkan plugin ini, dengan cara yang telah dijelaskan di 

atas. 

 

3) Session Saver 

Sebuah plugin yang sangat berguna, khususnya jika Anda bekerja pada suatu 

proyek dan memerlukan multiple file yang dibuka secara bersamaan. Dengan 

plugin ini session bisa di simpan (save) dan di load, dari menu File → Saved 

session. 

 

4) Color Picker 

Bagi Anda yang sedang belajar web dan pemrogramannya atau seorang web 

developer. Mungkin plugin ini akan sangat berguna, tentunya akan terasa 

menyusahkan bila harus menemukan nilai hexa decimal suatu warna. Namun, 

dengan color picker ini anda cukup mengklik apapun di desktop dan anda akan 

segera melihat Hue, Saturation, Nilai RGB kode dan kode Hex untuk warna yang 

diklik sebelumnya. Klik tombol memasukkan dan warna itu akan dimasukkan.  

 

5) Document Words Completion 

Plugin ini memiliki fungsionalitas sebagai auto-complete bagi gedit. Ketika Anda 

sedang mengetik, plugin ini akan melengkapi huruf yang barusan anda ketik, 

berdasarkan huruf yang muncul atau telah ada sebelumnya di dokumen yang 

sama. Anda dapat  mengkon figurasikannya ke auto-complete atau memberikan 

saran ketika menekan Ctrl+Enter. 

Masih banyak lagi plugin yang disediakan oleh gedit, jika Anda adalah seorang 

yang selalu ingin mencoba sesuatu yang baru, anda bisa menemukan 

pluginplugin yang sesuai bagi anda sendiri. Sebenarnya, tidak banyak pengguna 

gedit yang mengetahui bahwa gedit dapat mendukung banyak sekali 

fungsionalitas melalui plugins. 
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Mudah-mudahan, dengan Anda menyadari bahwa gedit lebih dari apa yang 

terlihat sekilas. Antara keberadaan plugin dan fitur yang powerfull, gedit bias 

diandalkan dalam dunia developer sebagai text editor utama. 

C. Pemutar Multimedia di Ubuntu 

1. Rhythmbox 

1) Tentang Rhythmbox 

Rhythmbox adalah aplikasi pemutar musik populer untuk desktop Gnome yang 

terinspirasi dari Apple I-Tunes, menggunakan multimedia framework Gstreamer 

dan merupakan aplikasi bawaan Ubuntu. 

 

2) Instalasi Rhythmbox 

Karena Rhythmbox merupakan aplikasi bawaan Ubuntu, jadi sudah terinstall 

secara  langsung dan tinggal menginstall beberapa codec Gstreamer agar bisa 

memutar file .mp3 .wma dan jenis file multimedia  lainnya yang berlisensi. 

Untuk meng-install codec Gstreamer buka Application → Accessories → 

Terminal lalu ketikkan perintah dibawah ini. 
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$ sudo apt-get install gstreamer-plugins-bad gstreamer- \ 

plugins-ugly gstreamer-plugins-ugly-multiverse gstreamer- \ plugins-bad-

multiverse 

Keterangan : Baris yang diakhiri dengan \ berarti satu baris yang bersambung. 

3) Menggunakan Rhythmbox 

Buka di menu Applications → Sound & Video → Rhythmbox Music Player. 

Jika window rhythmbox tidak muncul coba cek di area notifikasi icon mirip 

Loudspeaker di bagian sudut kanan atas desktop, klik lalu pilih Show 

Rhythmbox (gambar MP.2). 

 

Kalau window Rhythmbox sudah muncul klik Music → Import Folder 

(gambar MP.3) 

 

Pilih folder yang berisi koleksi musik yang ingin ditambahkan ke dalam library 

musik rhythmbox, jika sudah ketemu klik open dan tunggu sampai rhythmbox 

selesai memindai koleksi musik. Untuk memainkan, klik 2x lagu yang diinginkan. 

Untuk membuat playlist baru : klik kanan pada lagu yang diinginkan → Add To 

Playlist → New Playlist, lalu ketikan nama playlist yang diinginkan  

(gambar MP.4). 
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4) Fitur Tambahan Rhythmbox 

Selain untuk mendengarkan koleksi musik rhythmbox juga mempunyai segudang 

fitur-fitur canggih seperti yang tampak pada gambar MP.5 berikut.   

 

Pada gambar di atas fitur-fitur yang terdapat dalam Rhythmbox antara lain: 

◦ Podcast 
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◦ Radio 

Dengarkan stasiun radio favorit secara Online seperti Last.fm 

◦ Toko Musik Online 

Hargai karya cipta seniman musik, beli yang original melalui toko music online 

seperti : Magnatune, Ubuntu Music Store, Jamendo dan lainnya. 

◦ Perbaharui Status IM sesuai dengan lagu yang diputar 

◦ Import musik dari Portable mp3 player, Handphone, Ipod dan lainya. 

◦ Tag Editor 

◦ Gapless Playback dengan Crossfade plugin 

 

2. Audacious 

1) Tentang Audacious 

Tak bisa lepas dari winamp? Tenang saja Ubuntu menyediakan aplikasi mirip 

winamp yang tak kalah hebatnya yaitu audacious - ―your music,your way, no 

exception‖. Berikut tampilan window audacious (gambar MP.6). 

 

2) Installasi Audacious 

Seperti biasa, buka Application → Accessories → Terminal lalu ketikan perintah 

berikut: 

$ sudo apt-get install audacious 

Atau bisa diinstall melalui Ubuntu Software Center. Beda dengan Rhythmbox, 

Audacious langsung menyediakan dukungan format .mp3 dan lainya. 

3) Menggunakan Audacious 
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Buka Aplication → Sound & Video → Audacious atau Sound & Video → 

Audacious(GTKui) untuk versi gtk(GTKui). Secara umum penggunan audacious 

sama dengan menggunakan winamp. Cukup drag dan drop file  

musik ke window Audacious dan mainkan atau klik kanan pada file musik lali 

open with → Audacious. 

 

Mengatur playlist dengan Audacious sangatlah mudah, klik tombol list atau icon 

musik pada pojok kanan bawah Audacious, pilih Export Playlist atau dengan 

tombol singkat Shift+S (gambar MP.8). 
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4) Simpan Playlist 

Audacious juga menyediakan fitur tag editor yang digunakan untuk mengubah 

Judul, Artis, Album, Genre, Tahun, Nomor Trek dan lainnya (gambar MP.9). 

 

 

 

5) Fitur-fitur tambahan Audacious 

◦ Skin 

Audacious bisa menggunakan skin Winamp versi 2.x 

◦ Graphic Equalizer 

◦ Crystalizer 

Membuat suara menjadi lebih jernih 

◦ Extra Stereo 

◦ Alarm 

Otomatis memainkan musik pada waktu yang ditentukan 

◦ Gapless Playback dengan Crossfade plugin 
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3. Exaile 

1) Tentang Exaile 

Exaile adalah pemutar dan manager musik yang disebut-sebut sebagai amarok-

nya desktop Gnome, dibuat menggunakan bahasa python dan GTK+ serta 

menggunakan multimedia framework Gstreamer. 

 

2) Installasi Exaile 

Exaile dapat diinstall melalui terminal ataupun Ubuntu Software Center. Melalui 

terminal caranya : Buka Application → Accessories → Terminal lalu ketikan 

perintah berikut: 

$ sudo apt-get install exaile 

Akan tetapi exaile belum mampu memutar musik format proprietary seperti mp3 

dan wma. Agar dapat memainkan berbagai jenis musik, perlu meng-install 

beberapa codec lagi dengan perintah berikut: 

$ sudo apt-get install gstreamer-plugins-bad gstreamer-\ plugins-ugly 

gstreamer-plugins-ugly-multiverse gstreamer-\ plugins-bad-multiverse 

Keterangan : 

Baris yang diakhiri dengan \ berarti satu baris yang bersambung. 

3) Menggunakan Exaile 

Sama dengan beberapa aplikasi pemutar musik lainnya, untuk menjalankan 

aplikasi tersebut, double click atau klik kanan file-file music kemudian pilih open 

with – exaile atau drag and drop file-file musik ke window playlist. Fungsi utama 

dari exaile adalah sebagai music manager sama seperti Rythmbox, Amarok dan 
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Banshee yang  menyediakan fasilitas import koleksi musik untuk mempermudah 

pengaturan file-file musik. 

4) Mengimpor koleksi musik 

Mengimpor koleksi musik di exaile sangatlah mudah, caranya klik pada Berkas – 

Open Directories () lalu pilih folder yang merupakan gudang musik anda, atau 

bagi yang terbiasa menggunakan winamp cukup dragand drop file-file musik ke 

dalam playlist. 

 

5) Mengatur Playlist 

Playlist merupakan satu hal yang wajib dimiliki setiap music player, melalui 

playlist Anda bisa mengelompokan lagu-lagu favorit. Begitu juga di Exaile 

mengatur playlist sangatlah mudah, dengan fitur tabbed playlist yang bisa 

membuka lebih dari satu playlist dalam waktu yang bersamaan, cukup tekan 

CTRL+T, untuk mengaktifkan fitur ini. Untuk menambahkan lagu ke daftar main 

(playlist) yang sudah ada caranya, klik kanan pada lagu yang diinginkan pilih 

Tambahkan ke daftar main kostumisasi (gambar MP.12), lalu pilih daftar main 

yang diinginkan, sedangkan untuk membuat playlist baru pilih Daftar Lagu Baru. 
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6) Menggunakan Lyric Plugin 

Pilih Sunting → Preferences lalu pilih plugin, cari plugin yang bernama Lyric Wiki, 

Lyrics Fly, Lyric Viewer dan centang ketiganya untuk  mengaktifkan. Mainkan 

sebuah lagu, klik tab lyrics Plugin ini berfungsi jika artis dan judul dan artis benar 

dan ada koneksi internet. 

 

4. Amarok 

1) Tentang Amarok 

Amarok merupakan aplikasi pemutar musik yang sangat terkenal terutama di 

desktop KDE, bahkan ada juga beberapa pengguna desktop GNOME yang tetap 

menggunakan Amarok. Amarok disukai umumnya karena tampilan yang 

menawan serta fitur-fitur yang cukup lengkap dan mudah dikostumisasi sesuai 

keinginan end user. Berikut tampilan window amarok (gambar MP.14). 
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2) Installasi Amarok 

Untuk pengguna desktop KDE (Kubuntu), Amarok sudah ter-install secara default 

tinggal meng-install beberapa codec tambahan supaya bias memutar file-file 

mp3. Jika Anda pertama kali membuka aplikasi amarok,  akan muncul 

pemberitahuan di area notifikasi seperti gambar MP.15 dibawah ini. 

 

 

 

Klik Details untuk melanjutkan, akan muncul lagi window untuk memilih apa saja 

yang akan di install. Klik install selected, kemudian muncul dialog yang 

menanyakan konfirmasi password, masukan password lalu klik OK. Tunggu 

beberapa saat Amarok siap digunakan, atau bisa juga menginstall lewat terminal 

:  

Buka K-Menu → Application → System → Terminal lalu ketikan perintah berikut: 

$ sudo apt-get install libmp3lame0 libxine1-plugins 

Bagi yang menggunakan desktop Gnome, satu-satunya cara, harus menginstall 

amarok dari awal. Buka Application → Accessories → Terminal lalu ketikan 

perintah berikut: 

$ sudo apt-get install amarok libmp3lame0 libxine1-plugins 

3) Menggunakan Amarok 

◦ Mengatur Playlist 

Cukup drag and drop file-file musik ke playlist amarok untuk mulai memakainya, 

atau juga mem-browse secara langsung file-file music melalui sidebar pada 

menu Files. 

• Pengaturan playlist dapat dilakukan melalui toolbar, tepat di bawah playlist. 

Mulai dari menyimpan, meghapus, undo-redo dan lainnya (gambar MP.16). 
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• Untuk menyimpan playlist tekan tombol Save (icon disket) secara otomatis 

playlist disimpan pada Internal Database amarok yang namanya sesuai dengan 

hari, bulan ,tanggal dan jam. 

• Playlist yang namanya seperti : Thu June 17 10 11:52 rasanya kurang enak 

dipadang, untuk mengganti nama playlist klik kanan pada playlist – Rename lalu 

masukan nama yang diinginkan (gambar MP.17). 

 

 



 

J a r i n g a n  D a s a r  | 113 
 

Jaringan Dasar  

◦ Mengatur Koleksi musik 

Untuk meng-import semua file musik melalui collection caranya: klik Settings → 

Configure Amarok pada tab Collection centang folder yang berisi koleksi musik 

kemudian klik Apply. 

◦ Fitur-fitur Amarok 

Salah satu alasan banyak yang menyukai amarok adalah karena fiturnya yang 

melimpah seperti: 

• Context 

Widget Context merupakan salah satu daya tarik Amarok, dikemas dengan 

tampilan yang menarik, widget ini memiliki banyak fungsi seperti: 

- Pengunduh lirik dan sampul album 

- Informasi lagu/artis/album di wikipedia 

- Rating, dan lainya. 
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Applet default yang terdapat pada context, hanya current track dan lyric untuk 

menambakan applet yang lain klik ikon tang pada pojok kanan bawah context 

untuk meng-unlock applet lalu klik tanda tambah (+) selanjutnya klik pada applet 

yang  diinginkan misalnya Wikipedia dan klik lagi ikon tang untuk mengunci 

kembali applet. 

Sedangkan untuk menghapus klik ikon tang, secara otomatis muncul tanda 

silang (x) pada applet yang sedang aktif. Klik tanda silang (x) dan applet berhasil 

dihapus (gambar MP.19). 

 

• Amarok Script 

• Layout player yang bisa diubah-ubah 

• Integrasi MySQL database 

• 10 Band Graphic Equalizer 

Dan masih banyak lagi fitur-fitur amarok yang lain, yang pastinya harus Anda cari 

dan coba sendiri. Selamat menikmati Amarok.. 

 

5. Totem Movie Player 

1) Tentang Totem Movie Player 

Totem Movie Player merupakan aplikasi pemutar video default di Ubuntu yang 

menggunakan Gstreamer multimedia framework dan xine library. Berikut ini 

window Totem Movie Player (gambar MP.20). 
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2) Installasi Totem Movie Player 

Untuk pengguna Ubuntu, Totem Movie Player merupakan aplikasi bawaan 

sehingga cuma perlu meng-install beberapa codec tambahan agar bias 

memainkan berbagai jenis video. Buka Application → Accessories → 

Terminal, lalu ketikan perintah berikut: 

$ sudo apt-get install gstreamer-plugins-bad gstreamer-pluginsugly gstreamer-

plugins-ugly-multiverse gstreamer-plugins-badmultiverse 

Keterangan : 

Baris yang diakhiri dengan \ berarti satu baris yang bersambung. Sedangkan 

untuk memutar Encrypted DVD perlu menginstall libdvdcss dengan 

menjalankan skrip berikut: 

$ sudo /usr/share/doc/libdvdread4/install-css.sh 

3) Menggunakan Totem Movie Player 

Menggunakan Totem Movie Player sangat mudah apalagi buat end user yang 

baru bermigrasi dari windows, dengan tampilan sidebar yang mirip WMP, 

mengatur playlist-pun jadi tidak sulit. 

◦ Memutar File Video 

Cukup dengan double click pada file yang ingin diputar atau drag and drop ke 

playlist, maka Anda sudah bisa menikmati video dengan Ubuntu. 

◦ Mengatur Playlist 

Pada pojok kanan bawah Totem Movie Player, tepatnya di bawah playlist 

terdapat icons yang berfungsi untuk mengatur playlist diantaranya, 

menghapus item, menambahkan dan menyimpan playlist (gambar MP.21). 

 

• Menambahkan item ke playlist caranya, tekan tombol add ( + ) dan pilih file 

yang ingin ditambahkan 

• Menghapus item dari playlist caranya, klik pada item yang akan dihapus lalu 

tekan tombol  ( - ). 

• Menyimpan playlist cukup tekan tombol save playlist ( ) lalu 

masukan nama playlist yang diinginkan. 
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◦ Streaming Video 

Totem Movie Player mampu men-streaming video dari beberapa situs 

terkenal, salah satunya Youtube dan BBC. Klik combo box yang terdapat di 

atas playlist, kemudian pilih saluran streaming. 

 

◦ Memutar CD/DVD 

Masukan CD/DVD yang ingin diputar lalu pilih movie selanjutnya pilih disk 

yang diinginkan (gambar MP.23). 

 

 

◦ Membuat Screenshot 

Ada adegan keren dalam film yang sedang Anda nonton dan anda ingin 

menjadikanya wallpaper? Totem Movie Player menyediakan fitur screenshoot 

yang memungkinkan hal itu tanpa perlu direpotkan dengan penambahan aplikasi. 

Temukan adegan yang keren yang diinginkan lalu Pause, kemudian klik Edit → 

Take Screenshot dan simpan. Selain itu bagi para blogger yang sering mengulas 

film-film terbaru bias memanfaatkan fitur Screenshot Gallery pada totem untuk 

membuat cuplikan sekilas film dalam satu gambar. Klik Edit → Create 

Screenshot Gallery, pilih folder tempat menyimpan gambar lalu klik save. 
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6. VLC Media Player 

1) Tentang VLC Media Player 

VLC Media Player (VideoLan Client) adalah sebuah aplikasi media player 

besutan VideoLan team, bukan hanya sekedar player tapi sekaligus streamer 

dan encoder. Gambar MP.25 window VLC Media Player. 

 

2) Installasi VLC Media Player 

Langsung saja buka Application → Accessories → Terminal lalu ketikan perintah 

dibawah ini: 

$ sudo apt-get install vlc 
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Secara otomatis VLC Media Player langsung meng-install codec yang diperlukan 

atau dapat juga di install melalui Ubuntu Software Center. 

3) Menggunakan VLC Media Player 

◦ Memutar file video 

Sama seperti beberapa aplikasi pemutar video lainya, cukup double click atau 

klik kanan lalu pilih open with – vlc. Bisa juga dengan drag and drop file ke 

window VLC Media Player untuk mulai memutarnya.  

◦ Mengatur Playlist 

• Klik View → Playlist untuk memunculkan playlist. 

• Gunakan tombol + untuk menambahkan file satu persatu atau memindai folder 

yang berisi kumpulan file multimedia. Klik kanan pada item yang dipilih untuk 

menghapus dari playlist. 

 

 

 

◦ Streaming dengan VLC Media Player 

VLC Media player mendukung banyak protokol streaming, tapi tak usah 

bingung memilihnya, cukup copy paste saja url streaming pada alamat 

maka secara otomatis VLC Media Player akan memilih protokol yang 

sesuai. 
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Selain itu VLC Media Player juga mendukung Streaming melalui Capture Device 

seperti Webcam, DVB dan lainya (gambar MP.28). 

 

4) Fitur-fitur VLC Media Player 

VLC media player memiliki segudang fitur lainya; bagi yang ingin sekedar 

memutar DVD dan file-file multimedia lainya hal-hal di atas sudah cukup tapi bagi 

end user yang penasaran bisa mencoba sendiri fitur-fitur lainnya yaitu: 

◦ Services Directory 
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◦ Audio, Video Effect dan Filter 

◦ Track Synchronization 

7. Gnome MPlayer 

1) Tentang Gnome MPlayer 

Gnome MPlayer merupakan front end dari aplikasi pemutar video Mplayer, yang 

sudah tentu sangat terkenal karena kemampuanya memutar berbagai format 

video dan audio. Berikut tampilan window Gnome MPlayer (gambar MP.29). 

 

2) Installasi Gnome MPlayer 

Langsung saja buka Application → Accessories → Terminal lalu ketikan perintah 

berikut: 

$ sudo apt-get install gnome-mplayer Dapat juga di-install melalui Ubuntu 

Software Center. 

3) Menggunakan Gnome MPlayer 

Cara membuka file multimedia di Gnome Mplayer sama seperti multimedia 

player lainnya, cukup drag and drop ke window gnome Mplayer atau klik 

kanan → open with → Gnome Mplayer. Sedangkan untuk memainkan CD, 



 

J a r i n g a n  D a s a r  | 121 
 

Jaringan Dasar  

VCD atau DVD pilih File → Disc lalu pilih yang sesuai, bahkan Anda juga 

dapat membuka DVD dari folder beserta 

subtitle-nya. 

◦ Mengatur Playlist 

Klik menu View → Playlist untuk menampilkan playlist. Dari sini Anda bisa 

menambahkan item dengan drag and drop, menghapus item, menyimpan playlist 

dan mengosongkan playlist yang ditunjukkan oleh ikon di bawah playlist (gambar 

MP.30). 

 

 

◦ Mengatur kecerahan, kontras dll 

Klik menu View → Video Picture Adjustments, Anda dapat mengatur tingkat 

kecerahan, kontras, gamma, hue dan satuartion dari window pengaturan ini. Fitur 

Video Picture Adjustments diperlukan saat video terasa terlalu gelap atau terlalu 

cerah. 
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D. MMC, Multimedia Converter GNU/Linux 

Mobile Media Converter adalah suatu aplikasi yang sanggup meng-convert file-

file music seperti MP3 audio, WMA, OGG audio, WAV audio, MPEG video, AVI 

video, WMV, FLV, AMR audio dan 3GP video menjadi suatu file yang Anda 

inginkan dan lebih baik lagi apabila diconvert ke file yang opensources (stop 

pembajakan). 

 

Berikut tahapan instalasinya: 

Untuk menggunakan aplikasi ini Anda diharuskan mendownload terlebih dahulu 

di situs MMC http://www.miksoft.net/products/mmc_1.6.0_i386.deb. Diwajibkan 

sebelum menginstall mmc_1.6.0_i386.deb Anda harus meng-install paket-paket 

dependensi MMC sebagai berikut:  

GTK+2.8 (or higher) 

glibc-2.4 (or higher) 

libstdc++.so.6 

Setelah didownload Anda install file tersebut dengan cara mengklik dua kali file  

mmc_1.6.0_i386.deb lalu klik tombol install package tunggu sampai prosesnya 

selesai. Setelah selesai Anda bisa akses MMC melalui menu Applications → 

Sound and video Mobile → Media Converter (Gambar MC.1). 

 

Untuk penggunaannya Anda akan sangat dimudahkan oleh aplikasi ini, berikut 

penulis berikan contohnya. Setelah mobile media converter terbuka (Gambar 

MC.2), klik tombol yang bersimbol + lalu cari file music yang ingin Anda convert, 
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setelah itu tentukan output penyimpanannya. Atur file convert ke file yang Anda 

inginkan, atur juga quality yang Anda inginkan. 

 

Setelah semua pengaturan selesai, klik convert dan tunggu sampai prosesnya 

selesai (Gambar MC.3) dan Anda bisa menikmati hasilnya. 

 

 

E. Cheese – Aplikasi Webcam GNU/Linux 

Banyak orang menggunakan fasilitas webcam di laptopnya, entah itu untuk 

megcapture foto dirinya ataupun merekam pertunjukannya. Maka dari itu Cheese 

adalah aplikasi berbasis GNU/Linux yang dibuat untuk memfasilitasi itu semua. 

Dengan penggunaan yang tidak rumit dan sangat sederhana, cheese dapat 

menjadi salah satu aplikasi webcam yang bisa diandalkan. 

1. Installasi Cheese 

Pertama-tama agar dapat menggunakan cheese bisa dilakukan dengan 

menginstall 

lewat terminal dengan cara sebagai berikut (koneksi internet): 

Meng-update source list melanjutkan proses install dengan mengetikan: 

$ sudo apt-get update 
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$ sudo apt-get install cheese 

Bisa juga menggunakan menu application ubuntu → software center → search, 

ketik cheese lalu install. Cara lain (penulis tidak menggunakan cara ini) adalah 

dengan mengunduh file source cheese di https://launchpad.net/cheese. 

Kemudian ekstraklah lalu install dengan cara seperti dibawah ini: 

-   Ekstrak dahulu file tar.gz 

- Buka terminal pindahkan ke lokasi direktori(path) tempat Anda menyimpan hasil 

ekstraknya:  

$ cd (path tempat Anda menyimpan hasil ekstraknya) 

Setelah itu ketikkan di terminal: 

$ ./configure 

$ make 

$ sudo make install 

Tunggu beberapa saat, dan aplikasi cheese siap digunakan. 

2. Cara penggunaan cheese webcam 

Buka aplikasi di Applications → sound & video → cheese webcam booth, maka 

akan muncul window cheese dibawah ini (gambar CS.1). 
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Untuk meng-capture foto, silahkan tekan tombol ―take a photo‖  

Untuk merekam video klik icon:  Lalu klik ―start recording‖ 

Untuk melakukan capture foto secara banyak klik icon:  lalu klik ―take Multiple 

photo‖ 

Cheese webcam sendiri menyediakan beberapa effect berikut (gambar CS.2): 

 

Dan efek-efek tersebut dapat digunakan secara bersamaan. 

Contohpenggabungan efek hulk, dice, dan vertigo (gambar CS.3). 

 

 

F. K3B – Disc Burner GNU/Linux yang Powerfull 

K3B aplikasi Disc Burner secara default tidak terinstall dalam desktop Gnome 

Ubuntu, melainkan terdapat pada versi KDE (Kubuntu), namun pengguna Gnome 
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juga dapat menikmati K3B pada desktop Gnome, begitulah kehebatan 

GNU/Linux, di mana aplikasi antar desktop manager bisa berjalan dengan baik, 

seolah-olah mereka berjalan pada desktop manager mereka sendiri. K3B 

direkomendasikan karena memiliki banyak fitur untuk pengguna GNU/Linux. 

Dalam bahasan ini penulis mencoba membahas beberapa fitur standar yang 

sering digunakan. 

 

1. Install K3B 

Untuk install K3B buka terminal dengan cara klik menu aplication → accessories 

→ terminal dan ketik perintah berikut: 

$ sudo apt-get install k3b 

Aplikasi ini juga bisa Anda temukan di Synaptic Package Manager atau Ubuntu 

Software Center. 

Menjalankan Aplikasi 

K3B bisa Anda jalankan lewat menu Applications → Sound & Video → K3b 

 

2. Burning CD dalam bentuk Data 

Fitur yang sering dilakukan untuk mem-backup data ke CD atau DVD. Untuk 

melakukan hal ini Anda bisa memulai dengan membuat proyek baru lewat menu 

File → New Project → New Data Project (lihat gambar B.1 di bawah). 

 

Seperti program burner lainnya, Anda bisa melakukan drag file atau folder yang 

ingin dimasukkan ke CD ke list pada panel kanan bawah. Untuk mengubah nama 
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disk, bisa Anda lakukan pada bagian Volume Name. Untuk memulai membakar 

data klik tombol Burn. 

 

Beberapa hal yang perlu di-setting sebelum mulai membakar data (Gambar B.2), 

adalah: 

1) Kecepatan tulis CD, bisa Anda atur pada bagian Speed. 

2) Jika ingin melakukan verifikasi data setelah burning, Anda harus mengaktifkan 

opsi Verity written data. 

Untuk memulai Anda bisa mengklik tombol Burn. 

 

3. Menyimpan Data dalam Bentuk File .ISO 

Jika masih belum ingin melakukan burning, Anda dapat menyimpannya dalam 

bentuk file .iso dan bisa dibakar kemudian, untuk melakukannya pada proses di 

atas (Gambar B.2) aktifkan opsi Only Create Image dan nonaktifkan opsi 

Remove Image. 
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Kemudian masuk ke tab Image untuk menentukan lokasi penyimpanan file .iso 

(Gambar B.3) 

 

Selanjutnya klik tombol Start untuk memulai pembuatan file .iso. 

4. Burning File .ISO 

File .iso ini sering sekali ditemukan ketika men-download file installer distribusi 

GNU/Linux. Untuk memulai klik menu Tools → Burn Image... (Gambar B.5) 

 

Untuk melakukan burning dari file .iso ke cd langkah-langkahnya sebagai berikut: 

1) memilih file .iso yang akan dibakar sebagaimana yang ditunjukkan dengan 

angka 1 pada gambar di atas. 

2) Selanjutnya tentukan kecepatan tulis cd (biasanya diambil kecepatan paling 

rendah). 

3) Kemudian aktikfan opsi Verity written data untuk memastikan kalau data yang 

dibakar tidak rusak. 
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4) Langkah terakhir mulai proses burning dengan mengklik tombol Start. 

 

5. Erase CD/DVD 

Untuk menghapus isi CD/DVD klik menu Tools Format/→ Erase rewriteable 

disk... pada gambar B.1 Klik tombol Start untuk memulai penghapusan data. 

Perlu diperhatikan CD/DVD yang bisa dihapus adalah jenis RW, bisa diperiksa 

dilabel CD/DVD yang digunakan. 

 

6. Burning Data Multimedia 

1) Audio 

Untuk membuat CD mp3 perlu menginstall paket tambahan yang bernama 

libk3b2-extracodecs. 

2) Video 

Format file video yang didukung oleh K3b adalah MPEG1 dan MPEG2. Jadi 

untuk mempermudah membakar data video sebaiknya Anda men-convert file 

video terlebih dahulu. Sedangkan cara pembuatannya hampir sama dengan 

burning CD/DVD dalam bentuk data. 

 

G. Clamav – Antivirus untuk GNU/Linux 

1. Seberapa penting Antivirus di GNU/Linux? 

Sering terdengar bahwa salah satu kelebihan sistem operasi GNU/Linux adalah 

―kebal‖ terhadap serangan virus! Lantas buat apa memasang antivirus di 

GNU/Linux? Ada beberapa alasan yang mendasari kenapa diperlukan antivirus 

di GNU/Linux sebagai berikut: 

1) Jika komputer yang digunakan memiliki sistem operasi lebih dari satu (salah 

satunya adalah Windows). Penulis pernah membaca sebuah artikel tentang virus 
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yang bisa menginfeksi file executable multi operation system (Windows, 

GNU/Linux dan Mac). 

2) Scan flashdisk yang sering dipakai di Windows, sehingga bisa mencegah 

penyebaran virus di Windows dan bekerja lebih nyaman. Dengan dua alasan di 

atas antivirus di lingkungan GNU/Linux juga perlu mendapat perhatian. Saat ini 

sudah banyak vendor-vendor antivirus windows yang menciptakan antivirus 

untuk GNU/Linux, mulai dari AVG, Eset Antivirus dan yang lainnya. Kali ini 

penulis mengulas antivirus yang lisensinya  sesuai dengan GNU/Linux yaitu 

General Public License (GPL), antivirus ini dikenal dengan nama ClamAV. 

ClamAV masih merupakan antivirus yang bekerja di mode command line, penulis 

yakin banyak pemula GNU/Linux yang tidak suka dengan hal ini, 

sehingga versi grafis atau GUI dari ClamAV yaitu KlamAV dibuatkan. Untuk 

memulai instalasi antivirus ini, ketikkan perintah berikut pada terminal: 

$ sudo apt-get install klamav 

Perlu diketahui, KlamAV tidak mempunyai fitur On Access Scanner (realtime 

scanner) seperti antivirus yang sering ditemukan di Windows, KlamAV hanya 

bisa melakukan proses scanning pada file atau folder. 

 

2. Menjalankan KlamAV saat pertama kali 

Setelah selesai terinstall, aplikasi ini bisa Anda temukan di menu Applications → 

System Tools → KlamAV. 

Berikut tampilan pertama saat KlamAV dijalankan (gambar CL.1), selanjutnya 

yang harus dilakukan adalah men-setting beberapa hal, dengan demikian klik 

Next untuk melanjutkan. 
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Setting lokasi direktori database dan quarantine KlamAV (gambar CL.2). 

 

Yang perlu diperhatikan sebagai berikut: 

• Signature Database Location : /home/<nama_user_login_Anda>/.klamav/ 

database 

• Quarantine Locaton : /home/<nama_user_login_Anda>/.klamav/quarantine 

Di mana <nama_user_login_Anda>adalah akun user milik Anda. Klik Finish 

untuk menyelesaikan wizard dan download database terbaru dari situs resmi 

Clamav. 

3. Scan File atau Folder 

 

Beri tanda cek pada direktori yang akan diperiksa (gambar CL.3) dan tekan 

tombol Scan (beri tanda cek pada checkbox Scan Folders Recurseively jika ingin 

memeriksa direktori berserta isi di dalamnya). Tunggu proses scan sampai 

selesai. 

Jika Virus Terdeteksi! 
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Untuk melakukan pengetesan ini penulis mengambil sample virus lokal dari situs 

Morphost AV. Berikut tampilan saat virus windows terdeteksi oleh KlamAV 

(gambar CL.4). 

 

Klik tombol Quarantine untuk mengkarantina semua virus yang terdeteksi. Jika 

Anda ingin menghapus file virus ini secara permanen, Anda bisa masuk ke Tab 

Quarantine. Untuk menghapus file virus, pilih semua file virus dan klik tombol 

Delete, sebelumnya klik tombol Refresh untuk memperbaharui daftar file yang 

ter-karantina. Seperti yang tampak pada gambar CL.5 berikut. 

 

 

4. Update Database Antivirus 

Ada dua cara untuk meng-update database antivirus layaknya antivirus yang lain. 

Yaitu dengan cara download file update (update offline) dan dengan update 

manager clamav. 

1) Download File Update 

Cara yang pertama ini berguna untuk end user yang tidak memiliki koneksi 

internet langsung. Untuk melakukan cara ini, Anda ke situs clamav di 
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http://www.clamav.net. Selanjutnya lihat bagian berikut untuk download database 

clamav (gambar CL.6). 

 

Di sana terlihat dua buah database antivirus yaitu main.cvd dan daily.cvd. File 

main.cvd tidak dirilis setiap hari. Jika Anda baru pertama kali menggunakan 

clamav, download kedua file di atas dengan cara klik kanan masing-masing link 

dan pilih menu Save Link As... Perhatikan tanggal rilis sebelum mulai 

mendownloadnya, sehingga Anda bisa tahu mana yang perlu Anda download. 

Untuk menggunakan file update ini, letakan dalam direktori dimana clamav telah 

diseting waktu pertama kali diaktifkan (pada contoh ini terletak di folder 

/home/<nama_user_login_Anda>/.klamav/database); Copy kedua file tersebut. 

2) Update Langsung dari Klamav 

Cara yang kedua ini mempunyai keuntungan, yaitu ukuran file yang didownload 

relatif kecil karena dilakukan update secara berkala. Cara melakukannya adalah 

masuk ke tab Update dan klik tombol Update Now (gambar CL.7), tidak 

diperlukan melakukan setting tambahan. 
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5. Update Antivirus 

Cara yang aman melakukan update antivirus adalah dengan menunggu versi 

terbaru clamav dari update manager Ubuntu. 

 

H. Gkamus – Aplikasi kamus elektronik di Ubuntu 

Gkamus merupakan aplikasi kamus bahasa Inggris – Indonesia atau sebaliknya. 

Aplikasi ini sangat mudah digunakan dan bisa dimodifikasi sesuai keinginan 

Anda karena program Gkamus ini bersifat opensources. Gkamus diciptakan oleh 

orang Indonesia sendiri dengan menggunakan bahasa C & GTK serta tersedia 

sourcenya dalam bentuk .exe, rpm atau deb file. Pada kesempatan kali ini 

penulis akan memberikan cara installan Gkamus dan penggunaannya di Ubuntu. 

 

Instalasi Gkamus 

Gkamus terdapat dalam repositori, untuk cara install-nya buka terminal lalu 

ketikan perintah berikut:  

$ sudo apt-get install gkamus 

Tunggu sampai proses instalasi selesai dan pastikan tidak ada pesan error. Buat 

Anda yang tidak mempunya koneksi internet jangan berkecil hati, Gkamus masih 

bisa di download di http://downloads.sourceforge.net/gkamus/gkamus_0.3-

1_i386.deb  kemudian diinstall dengan cara klik kanan hasil download 

filekemudian pilih Open with GDebi package Instlaler atau buka terminal lalu ketik 

perintah dibawah ini. 

$ sudo dpkg --i deb_file_gkamus 

Setelah proses installasi selesai, Gkamus sudah dapat digunakan dan Anda bias 

menikmati kemudahannya. Untuk melakukan translate dari Bahasa Inggris - 

Bahasa Indonesia cukup tekan F1 (Gambar GK.1) dan untuk melakukan 

translate dari Bahasa Indonesia - Bahasa Inggris cukup tekan F2 (Gambar 

GK.2). 
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I. Wammu, PC Suite di GNU/Linux 

Wammu adalah aplikasi mobile phone manager yang menggunakan gammu 

sebagai basisnya. Jadi bisa dikatakan wammu adalah GUI dari gammu. Wammu 

fungsinya seperti PC suite untuk nokia atau phone tools untuk motorola. Fiturfitur 

yang disupport oleh wammu adalah menerima dan mengirim SMS, phonebook, 

calendar, todo list, notes dan call/receive call (recent). Sebagian besar mobile 

phone sudah disupport oleh wammu. 

 

1. Meng-install Wammu 

Install wammu dapat menggunakan terminal, synaptic packages manager atau 

melalui software center. Yang akan penulis contohkan pada kesempatan ini 

dengan menggunakan synaptic manager. Buka synaptic packages manager dari 

menu System → Administration → synaptic package manager . Setelah terbuka 

ketik “wammu” pada quick search tanpa tanda kutip (gambar WM.1). 

 

 

 

Klik pada kotak sebelah kiri pada package list, maka akan muncul popup window, 

pilih mark for installation (gambar WM.2). 
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Setelah itu klik tombol apply yang ada di toolbar untuk memulai proses instalasi. 

Jika wammu berhasil diinstall maka bisa dicek aplikasi wammu di menu 

Applications → Accessories → Wammu. 

2. Konfigurasi awal Wammu 

Buka aplikasi wammu, jika pertama kali menjalankan wammu maka akan muncul 

window wizard untuk konfigurasi awal (gambar WM.3). Klik Yes untuk 

melanjutkan.  
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Setelah itu ikuti wizzard-nya (gambar WM.4 s/d WM.10), sebagai contoh penulis 

menggunakan hp motorola L7. 

 

Klik Next lalu pilih Automatically search for a phone untuk memilih configuration 

style (gambar WM.5). 
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Klik Next untuk memilih connection type, penulis menggunakan USB cable 

(gambar WM.6). 

 

 

Klik Next, sistem akan mendeteksi hp yang digunakan (gambar WM.7). 
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Selanjutnya akan muncul window yang mendeteksi keberadaan hardware hp 

(gambar WM.8). 

 

 

Klik OK dilanjutkan dengan testing koneksi (gambar WM.9). 
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Klik Next kemudian Finish untuk mengakhiri proses konfigurasi wammu (gambar 

WM.10). Pada kondisi ini wammu siap untuk digunakan. 

 

 

3. Menggunakan Wammu 

Hubungkan handphone yang digunakan ke komputer menggunakan kabel data, 

kemudian jalankan wammu. Setelah wammu terbuka klik pada menu Phone → 

Connect (gambar WM.11). 
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Setelah handphone terhubung dengan wammu maka bisa dilihat info, contact, 

message dan lain-lain. 

 

 

Untuk pertama kali klik pada menu Retrieve. Ditampilkan info contact yang ada di 

handphone penulis (gambar WM.12 diatas). Untuk todo dan calendar silahkan 

eksplorasi sendiri karena handphone penulis tidak support. Untuk membuat 

contact, calendar event, todo dan message. Klik pada menu Create (gambar 

WM.13). 
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Anda dapat juga mem-backup contact dan message. Klik pada menu Backup 

(gambar WM.14). 

 

Untuk keluar dari wammu klik Phone → disconnect kemudian close wammu. 

 

J. Ksnapshot, screen capture di GNU/Linux 

Ksnapshoot merupakan aplikasi desktop capture, istilah mudahnya yaitu 

aplikasi untuk mengambil screenshot area desktop maupun seluruh isi 

komputer Anda yang berbasis grafik. Tool ini sangat berguna sekali untuk 

kebutuhan pelengkap media ajar yang ada pada e-book termasuk e-book 

yang Anda baca sekarang ini. Bahkan juga berguna hanya untuk ajang show-

off tampilan desktop keren Anda. Paket ini bisa Anda temukan di Ubuntu 

Software Center dengan nama paket ksnapshot, atau bisa juga melalui install 

terminal sudo apt-get install ksnapshot. 

1. Mengaktifkan ksnapshot 

Setelah meng-install ksnapsot Anda bisa mengaksesnya di menu Applications → 

Graphics → ksnapshot. Akan terbuka window seperti gambar di bawah KS.1 ini. 
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2. Penggunaan ksnapshot 

1) Capture Layar Desktop secara keseluruhan 

Pada bagian Capture mode pilih Full Screen dan klik New Snapshot, secara 

default ksnapshot langsung men-capture desktop saat start. Pada mode ini 

Snapshot delay diset 0 second dan klik New Snapshot untuk memulai  dan 

klik area pada desktop untuk melakukan capture. 

2) Capture Window yang aktif 

Pada bagian Capture mode pilih Window Under Cursor. Snapshot delay diset 

menjadi 4 seconds, kalau Anda ingin window border tampil beri tanda cek 

pada Include window decorations dan klik New Snapshot. Kemudian letakkan 

pointer mouse pada title bar window yang akan dicapture dan klik sekali. Hasil 

capture akan muncul setelah 4 detik. 

3) Capture Region (wilayah yang diseleksi) 

Pada bagian Capture mode pilih Region, snapshot delay diset 0 second dan 

klik New Snapshot untuk memulai. Sekarang tinggal pilih area yang akan di-

capture (seperti Anda menambahkan kotak di OpenOffice), tekan tombol 

Enter untuk mengambil gambar atau tekan tombol ESC untuk membatalkan. 

4) Caputer Section Window 

Pada bagian Capture mode pilih Section of Window, snapshot delay diset 4 

seconds dan klik tombol New Snapshot untuk memulai dan klik pada area 

window aktif. Fitur ini akan memilih area capture secara spesifik dari window 

aktif; misalnya : listview nautilus, toolbar, panel dan lainnya. 

 

3. Menyimpan Hasil Capture 

1) Sebagai File Gambar 

Setelah Anda men-capture, klik tombol Save As.. dan simpan seperti biasa. 

2) Membuka Langsung dengan Program pengolah gambar 

Setelah proses capture selesai klik tombol Open With dan disana akan 

muncul program yang bisa digunakan untuk membuka file gambar seperti 

Gimp. 

3) Men-copy ke clipboard dan paste pada program lain seperti OpenOffice 

Tinggal klik tombol Copy to Clipboard setelah selesai capture dan file siap 

dipaste keprogram lain. 
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E-Book Versi 1.0 Ubuntu-Indonesia.Com Kontributor Bab V 'Aplikasi Ubuntu' 

1. Nautilus – File Manager Ubuntu Bro Deny26 

2. Gedit, text editor standar Ubuntu Bro blacksaha69 

3. Pemutar Multimedia di Ubuntu Bro Soekarmana 

4. MMC, Multimedia Converter GNU/Linux Bro ninja 

5. Cheese – Aplikasi Webcam GNU/Linux Bro ondedark 

6. K3B – Disc Burner GNU/Linux yang Powerfull Bro Deny26 

7. Clamav – Antivirus untuk GNU/Linux Bro Deny26 

8. Gkamus – Aplikasi kamus elektronik di Ubuntu Bro ninja 

9. Wammu, PC Suite di GNU/Linux Bro lisnux 

10. Ksnapshot, screen capture di GNU/Linux Bro KoenTUX 

 

c. Rangkuman. 

Ubuntu adalah sistem operasi lengkap berbasis Linux, tersedia secara 

bebas dan mempunyai dukungan baik yang berasal dari komunitas maupun 

tenaga ahli profesional. Ubuntu sendiri dikembangkan oleh komunitas 

sukarelawan Ubuntu dan kami mengundang Anda untuk turut serta 

berpartisipasi mengembangkan Ubuntu! 

Komunitas Ubuntu dibentuk berdasarkan gagasan yang terdapat di dalam 

filosofi Ubuntu: bahwa perangkat lunak harus tersedia dengan bebas biaya, 

bahwa aplikasi perangkat lunak tersebut harus dapat digunakan dalam 

bahasa lokal masing-masing dan untuk orang-orang yang mempunyai 

keterbatasan fisik, dan bahwa pengguna harus mempunyai kebebasan untuk 

mengubah perangkat lunak sesuai dengan apa yang mereka butuhkan.Perihal 

kebebasan inilah yang membuat Ubuntu berbeda dari perangkat lunak 

berpemilik (proprietary); bukan hanya peralatan yang Anda butuhkan tersedia 

secara bebas biaya, tetapi Anda juga mempunyai hak untuk memodifikasi 

perangkat lunak Anda sampai perangkat lunak tersebut bekerja sesuai 

dengan yang Anda inginkan 

 

d. Tugas : Membuat Ringkasan Materi  Protokol Pengalamatan 

Sebelum mengerjakan tugas, buatlah kelompok terdiri atas 2-3 orang. Dalam 

kegiatan ini peserta didik akan membuat ringkasan materi Aplikasi Ubuntu 

.Masing-masing kelompok mebuat ringkasan Aplikasi Ubuntu.Kemudian 
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secara bergantian masing-masing kelompok mempresentasikan hasilnya 

didepan kelas. 

1.1. Bacalah uraian materi diatas dengan  teliti dan cermat. 

1.2. Buatlah ringkasan materi untuk Aplikasi Ubuntumenggunakan 

software pengolah presentasi. Topik yang di tulis meliputi 1) 

katagori Aplikasi Ubuntu,2) fungsi Aplikasi Ubuntu,3) implementasi 

Aplikasi Ubuntu 

1.3. Presentasikan hasil ringkasan di depan kelas. 

 

e. Tes Formatif 

1. Sebelum anda menginstal Perangkat Lunak pengolah kata Freeware, apa 

yang harus anda sediakan ... 

a. Perangkat Lunak pengolah kata 

b. Perangkat Lunak pengolah angka 

c. Perangkat Lunak sistem operasi 

d. Perangkat Lunak grafis 

e. Perangkat Lunak Operating Sistem 

 

2. Selain Ms Word, yang termasuk Perangkat Lunak pengolah kata berikut ini 

adalah ... 

a. Text Documen 

b. Power Point 

c. MS Excell 

d. MS Dos 

e. Presentation 

 

3. Bagaimana langkah menginstalasi Aplikasi pengolah kata Freeware ... 

a. Memasukkan CD software aplikasi ke CD ROM kemudian klik tombol 

perintah Del 

b. memasukkan CD software aplikasi ke CD ROM kemudian klik tombol 

perintah Setup 

c. memasukkan CD software aplikasi ke CD ROM kemudian klik tombol 

perintah Next 
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d. memasukkan CD software aplikasi ke CD ROM kemudian klik tombol 

perintah finish 

e. memasukkan CD software aplikasi ke CD ROM kemudian klik tombol 

perintah exit 

 

4. Bagaimana langkah mengedit kalimat yang masih ada kesalahan ketik pada 

sebuah dokumen ... 

a. blok kalimat yang hendak diedit, tombol delete/del pada keyboard. 

b. arahkan kursor pada kata yang salah, hapus huruf yang salah dan diganti 

dengan yang benar 

c. blok kalimat yang salah, lalu dihapus 

d. blok kata yang salah, lalu dihapus 

e. blok kalimat yang salah kemudian tekan tombol backspace 

 

5. Urutan langkah pencetakan sebuah dokumen adalah ... 

a. klik file > klik print 

b. klik edit > tekan Ctrl P 

c. klik file > tekan Ctrl X 

d. klik file > tekan Ctrl P 

e. klik file > klik printer setting 

 

6. Untuk mencetak data pada halaman yang sedang aktif/tampil di layar monitor, 

maka pada kolom page range diset ... 

a. all 

b. current page 

c. page 

d. aligment 

 

7. Urutan langkah untuk mengakses Text Document menggunakan tombol start 

adalah … 

a. Start > Program > StarOffice7 > Text Document 

b. Start > StarOffice7 > Text Document 

c. Open > Start > Program > Open Text Document 

d. Open > Start > Program > StarOffice7 > Text Document 
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e. Start > Program > StarOffice7 > Spreadsheet 

 

8. Menjalankan Program Text Document melalui Dekstop dapat dilakukan 

dengan cara … 

a. Klik ganda ikon Text Dokumen 

b. Klik ganda tombol start 

c. Klik ganda pada my document 

d. Klik ganda my computer 

e. Klik ganda network 

 

9. Program Pengolah kata text document merupakan group dari program … 

a. StarOffice7 

b. Ms Office 

c. Ms Word 

d. Windows 

e. Open Office 

 

10. Lokasi file program pengolah kata text documen secara default tersimpan 

pada folder ... 

a. Program Files 

b. my document 

c. Accessories 

d. Windows 

e. My Data 

 

11. File yang dieksekusi pada saat menjalankan Text Document pada Windows 

adalah .... 

a. StarOffice.exe 

b. StarOffice7.exe 

c. Office.exe 

d. Office7.exe 

e. soffice.exe 
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12. Membuat sebuah dokumen baru untuk mengeksekusi perintah dalam 

pengolah kata Text Document adalah ... 

a. CTRL+N 

b. CTRL+O 

c. CTRL+W 

d. CTRL+S 

e. CTRL+E 

 

13. Langkah-langkah menyimpan dokumen dalam aplikasi Text Document 

adalah ... 

a. klik File > Open 

b. klik File > New 

c. klik File > Save 

d. klik File > page setup 

e. Klik File > reload 

 

14. Menyimpan dokumen dengan nama file tertentu pada aplikasi Text Document 

adalah ... 

a. klik File > Save 

b. klik File > Save As 

c. klik File > Open 

d. klik File > New 

e. klik File > Load 

 

15. Untuk menutup dokumen dengan shortcut menggunakan tombol kombinasi 

keyboard … 

a. ALT+F1 

b. ALT+F2 

c. ALT+F3 

d. ALT+F4 

e. ALT+F5 
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16. Pada Text Document StarOffice7, file yang akan disimpan secara default 

akan berekstensi ... 

a. .doc 

b. .xls 

c. .sof 

d. .sxw 

e. .sxi 

 

17. Tujuan melakukan editing dan formating adalah ... 

a. agar naskah menjadi bagus dan rapi 

b. agar naskah mudah dibuka 

c. agar naskah tidak hilang 

d. memudah di dalam penyimpanan (saving) 

e. memudahkan pencetakan 

 

18. Dalam editing membuat huruf bercetak tebal dapat dilakukan dengan 

menekan tombol/icon ... 

a. italic 

b. bold 

c. underline 

d. font size 

e. align left 

 

19. Untuk mengatur naskah dalam bentuk kolom dapat kita lakukan melalui menu 

... 

a. insert > columns 

b. edit > columns 

c. format > columns 

d. tools > columns 

e. file > columns 

 

20. Untuk mengatur layout dokumen pada aplikasi pengolah kata Text Documen 

melalui ... 

a. format > page 
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b. file > page setup 

c. view > toolbars 

d. tools > options 

e. file > print 

 

21. Untuk membuat header atau footer pada pada aplikasi text documen melalui 

... 

a. file > header atau footer 

b. edit > header atau footer 

c. view > header atau footer 

d. insert > header atau footer 

e. format > header atau footer 

 

22. Langkah-langkah dalam pembuatan tabel melalui menu insert adalah ... 

a. menu utama insert > table 

b. menu utama table > insert 

c. menu utama insert >table > columns 

d. menu utama table > insert > rows 

e. menu utama table > insert > colums  

 

23. Memanggil menu insert table juga bisa dengan menggunakan shortcut ... 

a. ctrl+F9 

b. ctrl+F10 

c. ctrl+F11 

d. ctrl+F12 

e. ctrl+F8 

 

24. Selain dari menu insert membuat tabel juga bisa dengan mengklik ... 

a. insert pada main toolbars 

b. insert pada object bar 

c. insert pada function bar 

d. insert pada drawing bar 

e. insert pada formating toolbars 
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25. Pengaturan/penentuan jumlah baris pada langkah pembuatan tabel dapat 

dilakukan melalui setting ... 

a. columns 

b. auto 

c. rows 

d. auto format 

e. table 

 

26. Pengaturan/penentuan jumlah kolom pada langkah pembuatan tabel dapat 

dilakukan melalui setting ... 

a. rows 

b. auto 

c. auto format 

d. table 

e. columns 

 

27. Kegunaan yang paling utama di dunia usaha/industri dari aplikasi StarOffice 7 

Presentation adalah ... 

a. Sebagai Pemprograman berbasis web server 

b. Mengenalkan Produk / Seminar. 

c. Menjalankan sistem operasi linux 

d. Pembuatan Basis Database 

e. Sebagai Program Spreadsheet / lembar sebar. 

 

28. Langkah yang pertama untuk membuat file baru pada aplikasi StarOffice 7 

Presentation adalah ... 

a. Klik File - New - Spreadsheet 

b. Klik File - new – HTML Document 

c. Klik File – New - Drawing 

d. Klik File – New - Presentation 

e. Klik File – New – Text Document 

 

29.Instruksi untuk membuat Numbering dan Bullets adalah ... 

a. Klik Edit - Numbering/Bullets 
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b. Klik Format - Bullets / Numbering 

c. Klik View - Bullets/Numbering 

d. Klik Slide Show - Numbering/Bullets. 

e.  Klik File - Bullets/Numbering. 

 

30.Untuk merubah / mengedit huruf atau font dengan memilih menu … 

a. Format - Style 

b. Format - Font 

c. Format - Paragraph 

d. Format - Page 

e. Format – Character 

 

31.Untuk mengganti tampilan slide yang berbeda-beda kita harus menentukan 

slide mana yang kita gunakan yaitu dengan perintah … 

a. Insert – Duplicate Slide 

b. Insert - Floating Frame 

c. Insert - Summary Slide 

d. Insert - Duplicate  

e. Insert – Slide 

 

32. Background dari suatu presentation dapat di ambil dari menu… 

a. file 

b. edit 

c. view 

d. insert 

e. format 

 

33.Icon di bawah ini pada starOffice Presentation berfungsi Untuk ... 

 

a. menjalankan presentation        

b. mengcopy slide 

c. mencetak slide 

d. membesarkan slide 
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e. memindahkan slide 

 

34.Langka-langkah untuk mengatur font pada starOffice presentation adalah … 

a. Format > paragraf 

b. Format > character 

c. Insert > fiels 

d. Tools > gallery 

e. Format > Font 

 

35.Agar sebuah presentation di sajikah lebih menarik dan tidak membesankan 

maka perlu di tambahkan .. 

a. animation 

b. graphic 

c. gallery 

d. object 

e. chart 

 

36.Perintah menggunah untuk mencetak lembar presentation adalah … 

a. Ctrl + E 

b. Ctrl + A 

c. Ctrl + L 

d. Ctrl + R 

e. Ctrl + P 

 

37.Untuk mengatur efek transisi sebuah slide adalah ... 

a. Slide show – manual transition 

b. Slide show – slide transition 

c. Slide show – effects transition 

d. Toolbar automatic transition 

e. Slide show – semiautomatic transition 
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38.  Icon disamping adalah untuk ... 

a. Membuat file baru 

b. Membuka file 

c. Menyimpan file 

d. Mencetak ke layar 

e. Mengatur halaman 

 

39.Bagaimana langkah awal menginstall program StarOffice ... 

a. memasukkan CD StarOffice ke CD ROM, kemudian klik tombol perintah 

Del 

b. memasukkan CD StarOffice ke CD ROM,kemudian klik tombol perintah 

Setup 

c. memasukkan CD StarOffice ke CD ROM, kemudian klik tombol perintah 

Next 

d. memasukkan CD StarOffice ke CD ROM, kemudian klik tombol perintah 

finish 

e. Memasukkan CD StarOffice ke CD ROM, kemudian klik tombol cancel 

 

40.Menyimpan file presentasi pada program presentasi StarOffice menggunakan 

ekstensi ... 

a. doc 

b. xls 

c. ppt 

d. sxi 

e. rtf 
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f. Lembar Jawaban Test Formatif (LJ). 
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